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Preface


This document is a contract deliverable with an approval code of 3. As such, it does not require

formal Government approval. This document is delivered for information only, but is subject to

approval as meeting contractual requirements.


Any questions should be addressed to:


Data Management Office

The ECS Project Office

Raytheon Systems Company

1616 McCormick Dr.

Upper Marlboro, MD 20774-5301
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Abstract


This is Volume 6 of a series of lessons containing the training material for Release 4 of the Earth 
Observing System Data and Information System (EOSDIS) Core System (ECS). This lesson 
provides a detailed description of the process required for creating, modifying, and implementing 
production requests and production plans and monitoring the processing of data processing 
requests. 

Keywords: training, instructional design, course objective, production request, production plan, 
data processing request, production, planning, processing. 
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Introduction


Identification 
Training Material Volume 6 is part of Contract Data Requirements List (CDRL) Item 129, whose 
requirements are specified in Data Item Description (DID) 625/OP3 and is a required deliverable 
under the Earth Observing System Data and Information System (EOSDIS) Core System (ECS), 
Contract (NAS5-6000). 

Scope 
Training Material Volume 6 describes the procedures by which the production team prepares 
production plans and monitors production processing. This lesson is designed to provide the 
operations staff with sufficient knowledge and information to satisfy all lesson objectives. 

Purpose 
The purpose of this Student Guide is to provide a detailed course of instruction that forms the 
basis for understanding production planning and processing. Lesson objectives are developed 
and will be used to guide the flow of instruction for this lesson. The lesson objectives will serve 
as the basis for verifying that all lesson topics are contained within this Student Guide and slide 
presentation material. 

Status and Schedule 
This lesson module provides detailed information about training for Release 4. Subsequent 
revisions will be submitted as needed. 

Organization 
This document is organized as follows: 

Introduction: The Introduction presents the document identification, scope, 
purpose, and organization. 

Related Documentation: Related Documentation identifies parent, applicable and 
information documents associated with this document. 

Student Guide: The Student Guide identifies the core elements of this lesson. All 
Lesson Objectives and associated topics are included. 

Slide Presentation: Slide Presentation is reserved for all slides used by the instructor 
during the presentation of this lesson. 

1 625-CD-006-002




This page intentionally left blank. 

2 625-CD-006-002




Related Documentation


Parent Document 
The parent document is the document from which this ECS Training Material’s scope and 
content are derived. 

423-41-01	 Goddard Space Flight Center, EOSDIS Core System (ECS) Statement 
of Work 

Applicable Documents 
The following documents are referenced within this ECS Training Material, or are directly 
applicable, or contain policies or other directive matters that are binding upon the content of this 
document: 

423-41-02	 Goddard Space Flight Center, Functional and Performance 
Requirements Specification for the Earth Observing System Data and 
Information System (EOSDIS) Core System (ECS) 

420-05-03	 Goddard Space Flight Center, Earth Observing System (EOS) 
Performance Assurance Requirements for the EOSDIS Core System 
(ECS) 

Information Documents 
Information Documents Referenced 
The following documents are referenced herein and amplify or clarify the information presented 
in this document. These documents are not binding on the content of the ECS Training Material. 

609-CD-003 Operations Tools Manual for the ECS Project 

611-CD-004 Mission Operation Procedures for the ECS Project 

535-TIP-CPT-001	 Goddard Space Flight Center, Mission Operations and Data Systems 
Directorate (MO&DSD) Technical Information Program Networks 
Technical Training Facility, Contractor-Provided Training 
Specification 

Informa tion Doc uments  Not Referenced 

The following documents, although not referenced herein and/or not directly applicable, do 
amplify or clarify the information presented in this document. These documents are not binding 
on the content of the ECS Training Material. 

220-TP-001	 Operations Scenarios - ECS Release B.0 Impacts, Technical Paper for 
the ECS Project 

305-CD-020	 Release B SDPS/CSMS System Design Specification Overview for the 
ECS Project 
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305-CD-021	 Release B SDPS Client Subsystem Design Specification for the ECS 
Project 

305-CD-022	 Release B SDPS Interoperability Subsystem Design Specification for 
the ECS Project 

305-CD-023	 Release B SDPS Data Management Subsystem Design Specification 
for the ECS Project 

305-CD-024	 Release B SDPS Data Server Subsystem Design Specification for the 
ECS Project 

305-CD-025	 Release B SDPS Ingest Subsystem Design Specification for the ECS 
Project 

305-CD-026	 Release B SDPS Planning Subsystem Design Specification for the 
ECS Project 

305-CD-027	 Release B SDPS Data Processing Subsystem Design Specification for 
the ECS Project 

305-CD-028	 Release B CSMS Communications Subsystem Design Specification 
for the ECS Project 

305-CD-029	 Release B CSMS System Management Subsystem Design 
Specification for the ECS Project 

305-CD-030 Release B GSFC DAAC Design Specification for the ECS Project 

305-CD-031 Release B Langley DAAC Design Specification for the ECS Project 

305-CD-033 Release B EDC DAAC Design Specification for the ECS Project 

305-CD-034 Release B ASF DAAC Design Specification for the ECS Project 

305-CD-035 Release B NSIDC DAAC Design Specification for the ECS Project 

305-CD-036 Release B JPL PO.DAAC Design Specification for the ECS Project 

305-CD-037 Release B ORNL DAAC Design Specification for the ECS Project 

305-CD-038	 Release B System Monitoring and Coordination Center Design 
Specification for the ECS Project 

305-CD-039	 Release B Data Dictionary Subsystem Design Specification for the 
ECS Project 

601-CD-001 Maintenance and Operations Management Plan for the ECS Project 

604-CD-001 Operations Concept for the ECS Project: Part 1-- ECS Overview 

604-CD-002 Operations Concept for the ECS Project: Part 2B -- ECS Release B 

605-CD-002 Release B SDPS/CSMS Operations Scenarios for the ECS Project 

607-CD-001 ECS Maintenance and Operations Position Descriptions 
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500-1002	 Goddard Space Flight Center, Network and Mission Operations 
Support (NMOS) Certification Program, 1/90 
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Production Planning and Processing Overview


Lesson Overview 
This lesson will provide you with the complete process by which the production team prepares 
production plans and monitors production processing. The processes described in the lesson 
apply primarily to production planners and production monitors. The procedures involved in 
production planning and processing include such tasks as preparing production requests, 
preparing production plans and monitoring data processing. 

Lesson Objectives 
Overall Objective - The overall objective of the Production Planning and Processing lesson is 
for Maintenance and Operations (M&O) personnel to develop proficiency in the procedures that 
apply to production planning and production processing operations for the Earth Observing 
System (EOS) Data and Information System (EOSDIS) Core System (ECS). 

Condition - The student will be given oral or written information and requirements for 
performing production planning and processing activities, access to the planning and production 
processing systems, a copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the 
ECS Project, and a copy of 611-CD-004-003, Mission Operation Procedures for the ECS 
Project. 

Standard - The student will perform production planning and processing activities in accordance 
with the prescribed procedures without error. 

Specific Objective 1 -The student will describe the general functions and processes included in 
the Planning Subsystem and the Data Processing Subsystem (in the context of ECS operations). 

Condition - The student will be given written or oral questions concerning the general functions 
and processes included in the Planning and Data Processing Subsystems. 

Standard - The student will state without error the general functions and processes included in 
the Planning and Data Processing Subsystems in accordance with the applicable procedure. 

Specific Objective 2 -The student will perform the steps involved in launching the production 
request editor. 

Condition - The student will be given a statement of the requirements for launching the 
production request editor, access to the planning system (through a workstation or X terminal), a 
copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy 
of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in launching the 
production request editor in accordance with the applicable procedure. 
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Specific Objective 3 -The student will perform the steps involved in creating a new production 
request. 

Condition - The student will be given a statement of the requirements for preparing a new 
production request, access to the planning system (through a workstation or X terminal), a copy 
of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in preparing a new 
production request in accordance with the applicable procedure. 

Specific Objective 4 -The student will perform the steps involved in modifying a production 
request. 

Condition - The student will be given a statement of the requirements for modifying a 
production request, access to the planning system (through a workstation or X terminal), a copy 
of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in modifying a production 
request in accordance with the applicable procedure. 

Specific Objective 5 - The student will perform the steps involved in deleting a production 
request. 

Condition - The student will be given a statement of the requirements for deleting a production 
request, access to the planning system (through a workstation or X terminal), a copy of 
609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in deleting a production 
request in accordance with the applicable procedure. 

Specific Objective 6 -The student will perform the steps involved in reviewing data processing 
requests. 

Condition - The student will be given a statement of the requirements for reviewing data 
processing requests, access to the planning system (through a workstation or X terminal), a copy 
of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in reviewing data 
processing requests in accordance with the applicable procedure. 

Specific Objective 7 -The student will perform the steps involved in deleting a data processing 
request. 

Condition - The student will be given a statement of the requirements for deleting a data 
processing request, access to the planning system (through a workstation or X terminal), a copy 
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of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in deleting a data 
processing request in accordance with the applicable procedure. 

Specific Objective 8 -The student will perform the steps involved in submitting or withdrawing 
a subscription using the subscription editor. 

Condition - The student will be given a statement of the requirements for submitting or 
withdrawing a subscription using the subscription editor, access to the planning system (through 
a workstation or X terminal), a copy of 609-CD-003-002, Version 2.0 Operations Tools Manual 
for the ECS Project, and a copy of 611-CD-004-003, Mission Operation Procedures for the ECS 
Project. 

Standard - The student will perform without error the steps involved in submitting or 
withdrawing a subscription using the subscription editor in accordance with the applicable 
procedure. 

Specific Objective 9 - The student will perform the steps involved in launching planning 
workbench-related GUIs. 

Condition - The student will be given a statement of the requirements for launching planning 
workbench-related GUIs, access to the planning system (through a workstation or X terminal), a 
copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy 
of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in launching planning 
workbench-related GUIs in accordance with the applicable procedure. 

Specific Objective 10 -The student will perform the steps involved in defining a production 
strategy. 

Condition - The student will be given a statement of the requirements for defining a production 
strategy, access to the planning system (through a workstation or X terminal), a copy of 
609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in defining a production 
strategy in accordance with the applicable procedure. 

Specific Objective 11 - The student will perform the steps involved in creating a new production 
plan. 

Condition - The student will be given a statement of the requirements for preparing a new 
production plan, access to the planning system (through a workstation or X terminal), a copy of 
609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 
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Standard - The student will perform without error the steps involved in preparing a new 
production plan in accordance with the applicable procedure. 

Specific Objective 12 -The student will perform the steps involved in reviewing a production 
plan timeline. 

Condition - The student will be given a statement of the requirements for reviewing a production 
plan timeline, access to the planning system (through a workstation or X terminal), a copy of 
609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in reviewing a production 
plan timeline in accordance with the applicable procedure. 

Specific Objective 13 - The student will perform the steps involved in troubleshooting 
production planning problems. 

Condition - The student will be given a statement of the requirements for troubleshooting 
production planning problems, access to the Data Processing Subsystem (through a workstation 
or X terminal), a copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS 
Project, and a copy of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in troubleshooting 
production planning problems in accordance with the applicable procedure. 

Specific Objective 14 -The student will perform the steps involved in launching production 
processing applications. 

Condition - The student will be given a statement of the requirements for launching production 
processing applications, access to the Data Processing Subsystem (through a workstation or 
X terminal), a copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS 
Project, and a copy of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in launching production 
processing applications in accordance with the applicable procedure. 

Specific Objective 15 -The student will perform the steps involved in configuring AutoSys 
runtime options. 

Condition - The student will be given a statement of the requirements for configuring AutoSys 
runtime options, access to the data processing system (through a workstation or X terminal), a 
copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy 
of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in configuring AutoSys 
runtime options in accordance with the applicable procedure. 

Specific Objective 16 -The student will perform the steps involved in reviewing hardware status 
(including changing hardware status views) using AutoSys. 
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Condition - The student will be given a statement of the requirements for reviewing hardware 
status (including changing hardware status views) using AutoSys, access to the data processing 
system (through a workstation or X terminal), a copy of 609-CD-003-002, Version 2.0 
Operations Tools Manual for the ECS Project, and a copy of 611-CD-004-003, Mission 
Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in reviewing hardware 
status (including changing hardware status views) using AutoSys in accordance with the 
applicable procedure. 

Specific Objective 17 -The student will perform the steps involved in reviewing data processing 
request (DPR) dependencies. 

Condition - The student will be given a statement of the requirements for reviewing DPR 
dependencies, access to the data processing system (through a workstation or X terminal), a copy 
of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in reviewing DPR 
dependencies in accordance with the applicable procedure. 

Specific Objective 18 - The student will perform the steps involved in reviewing the DPR 
production timeline. 

Condition - The student will be given a statement of the requirements for reviewing the DPR 
production timeline, access to the data processing system (through a workstation or X terminal), 
a copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a 
copy of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in reviewing the DPR 
production timeline in accordance with the applicable procedure. 

Specific Objective 19 - The student will perform the steps involved in reviewing and 
configuring AutoSys alarms. 

Condition - The student will be given a statement of the requirements for reviewing and 
configuring AutoSys alarms, access to the data processing system (through a workstation or 
X terminal), a copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS 
Project, and a copy of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in reviewing and 
configuring AutoSys alarms in accordance with the applicable procedure. 

Specific Objective 20 -The student will perform the steps involved in specifying job selection 
criteria and reviewing job activities using AutoSys. 

Condition - The student will be given a statement of the requirements for specifying job 
selection criteria and reviewing job activities using AutoSys, access to the data processing 
system (through a workstation or X terminal), a copy of 609-CD-003-002, Version 2.0 
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Operations Tools Manual for the ECS Project, and a copy of 611-CD-004-003, Mission 
Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in specifying job selection 
criteria and reviewing job activities using AutoSys in accordance with the applicable procedure. 

Condition - The student will be given a statement of the requirements for modifying job priority 
using AutoSys, access to the data processing system (through a workstation or X terminal), a 
copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy 
of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in modifying job priority 
using AutoSys in accordance with the applicable procedure. 

Specific Objective 22 -The student will perform the steps involved in modifying job status 
using AutoSys. 

Condition - The student will be given a statement of the requirements for modifying job status 
using AutoSys, access to the data processing system (through a workstation or X terminal), a 
copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy 
of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in modifying job status 
using AutoSys in accordance with the applicable procedure. 

Specific Objective 23 -The student will perform the steps involved in reviewing activity logs 
and job dependency logs. 

Condition - The student will be given a statement of the requirements for reviewing activity logs 
and job dependency logs, access to the data processing system (through a workstation or 
X terminal), a copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS 
Project, and a copy of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in reviewing activity logs 
and job dependency logs in accordance with the applicable procedure. 

Specific Objective 24 -The student will perform the steps involved in defining and running 
monitors/browsers. 

Condition - The student will be given a statement of the requirements for defining and running 
monitors/browsers, access to the data processing system (through a workstation or X terminal), a 
copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy 
of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in defining and running 
monitors/browsers in accordance with the applicable procedure. 

Specific Objective 25 -The student will perform the steps involved in reviewing the database 
maintenance time. 
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Condition - The student will be given a statement of the requirements for reviewing the database 
maintenance time, access to the data processing system (through a workstation or X terminal), a 
copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy 
of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in reviewing the database 
maintenance time in accordance with the applicable procedure. 

Specific Objective 26 - The student will perform the steps involved in troubleshooting 
processing problems. 

Condition - The student will be given a statement of the requirements for troubleshooting 
processing problems, access to the data processing system (through a workstation or X terminal), 
a copy of 609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a 
copy of 611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in troubleshooting 
processing problems in accordance with the applicable procedure. 

Specific Objective 27 -The student will perform the steps involved in launching the Quality 
Assurance (QA) Monitor GUI. 

Condition - The student will be given a statement of the requirements for QA Monitor GUI, 
access to the data processing system (through a workstation or X terminal), a copy of 
609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in QA Monitor GUI in 
accordance with the applicable procedure. 

Specific Objective 28 - The student will perform the steps involved in updating quality 
assurance (QA) metadata of a science product granule. 

Condition - The student will be given a statement of the requirements for updating QA 
metadata, access to the data processing system (through a workstation or X terminal), a copy of 
609-CD-003-002, Version 2.0 Operations Tools Manual for the ECS Project, and a copy of 
611-CD-004-003, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform without error the steps involved in updating QA metadata 
in accordance with the applicable procedure. 

Specific Objective 29 -The student will perform the steps involved in regenerating granules in 
response to a loss of files from the archive. 

Condition - The student will be given a statement of the requirements for regenerating granules 
in response to a loss of files from the archive, access to the planning and data processing systems 
(through a workstation or X terminal), a copy of 609-CD-003-002, Version 2.0 Operations Tools 
Manual for the ECS Project, and a copy of 611-CD-004-003, Mission Operation Procedures for 
the ECS Project. 
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Standard - The student will perform without error the steps involved in regenerating granules in 
response to a loss of files from the archive in accordance with the applicable procedure. 

Importance 
This lesson applies to students who will be members of the ECS production team (especially 
production planners and production monitors). The lesson will provide them with the knowledge 
and skills needed when performing their assigned tasks. Those tasks include (among other 
things) preparing production requests, preparing production plans and monitoring DPR 
production. The lesson describes why and how the activities are performed. Consequently, the 
students will become aware of what tasks they will be performing on the job and how to 
accomplish those tasks. 
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Production Planning and Processing


ECS Context 
ECS production planning and processing processes are accomplished at the Distributed Active 
Archive Centers (DAACs). The people involved in production planning and processing 
activities are Production Planners and Production Monitors. 

•	 The Production Planner performs planning functions; especially, notifying the 
Planning Subsystem (PLS) of the science processing jobs that are to be processed and 
when they are to be processed. 

•	 The Production Monitor keeps track of operations in the Data Processing Subsystem, 
especially the execution of science data processing jobs (creation of data products). 

The ECS Context Diagram (Figure 1) shows the relationships among the Planning Subsystem, 
Data Processing Subsystem, Data Server Subsystem, and the other subsystems within the 
Science Data Processing component of ECS.  It is apparent that the interfaces the Planning and 
Data Processing Subsystems have with each other and that each has with the Data Server 
Subsystem (which manages access to the data archive) are critically important. Of course the 
context diagram shows a generalized (high-level) view of ECS. The Planning Subsystem and 
Data Processing Subsystem Architecture diagrams (Figures 2 and 3 respectively) focus on the 
individual subsystems and their relationships with other subsystems. 

The Planning Subsystem (Figure 2) provides a mechanism for accomplishing the following 
general functions: 

• Defining DAAC production resources.

• Scheduling production resources for non-production-related activities.

• Defining data processing jobs to be performed at the DAAC.

• Generating efficient plans for scheduling defined data processing jobs.

• Coordinating production with the Data Server Subsystem and Data Processing


Subsystem to achieve a highly automated production system. 
The Data Processing Subsystem PRONG computer software configuration item (CSCI) shown in 
Figure 3 is involved in the following general functions: 

• Managing the allocation of data processing jobs to the site’s data processing 
resources. 

• Managing, queuing, and executing data processing jobs to produce data products. 
• Supporting preliminary processing of ancillary data sets. 
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Providing a Quality Assurance (QA) environment for checking the quality of data 
products. 

Figure 1. ECS Cont ext Diagram 
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Planning Subsystem
The Planning Subsystem (Figure 2) is the ECS Science Data Processing subsystem that the
Production Planner uses when developing production plans.  roduction Planner has access
to the Planning Subsystem primarily through the Production Request Editor and the Planning
Workbench.  The Production Request Editor (PRE) is used for creating or modifying production
requests (PRs); the Planning Workbench is used for scheduling PRs.

The Planning Subsystem is composed of just one computer software configuration item (CSCI);
i.e., PLANG.  

• Resource Planning Workbench.
 Resource Definition GUI (EcPlRpRe) - Graphical user interface (GUI) for

defining/editing the resources at the site.
 Resource Planning GUI (EcPlRpSi) - GUI for creating/approving/committing

resource reservations for non-production-related events and preparing a site
resource schedule.

 Resource Planning Timeline GUI (EcPlRpTl) - Graphical interface for
displaying the resource schedule.

• Production Request Editor (EcPlPREditor).

D

The P

The subsystem has the following major components as shown in Figure 2:



	 GUI for submitting production requests that describe the data products to be 
produced; uses product generation executive (PGE) descriptions to generate the 
data processing requests (DPRs) necessary to fulfill the production requests. 

• Production Planning Workbench. 
 Planning Workbench GUI (EcPlWb) - GUI for preparing and activating a site 

production schedule. 
 Production Strategies GUI (EcPlProdStrat) - GUI for defining production 

strategies (assign priorities for DPRs based on such characteristics as the type of 
production request, who is requesting processing, and the type of PGE to be 
run). 

	 Production Planning Timeline (EcPlTl) - Graphical interface for displaying 
production schedules, including resource reservations. 

• Subscription Manager (EcPlSubMgr). 
	 Server that manages receipt of subscription notifications (e.g., availability of 

input data needed for DPRs). 
• Subscription Editor (EcPlSubsEdit). 

 Character-based user interface that may be used to either submit or withdraw 
subscriptions for notification of system events (e.g., insertion of data into the 
archive). 

	 Subscriptions may be submitted on behalf of a general user or on behalf of the 
Planning Subsystem. 

• Sybase Structured Query Language (SQL) Server. 
 Commercial off-the-shelf (COTS) software application that handles insertion of 

data for planning and processing activities into the Planning and Data 
Processing Subsystems’ (PDPS) shared database. 

In addition to the preceding major components the Planning Subsystem includes the following 
components associated with both the resource planning applications and the production planning 
workbench: 

• Message Handler (EcPlMsh). 
	 GUI that displays various types of messages including warning messages and 

information messages. 
•	 System Name Server (EcPlSns). 

 Handles interprocess communication. 
•	 Resource Model (EcPlRpRm, EcPlRm). 

 Underlying resource data coordinators for the planning software. 

The Message Handler, System Name Server, and Resource Model are associated with both the 
resource planning workbench and the production planning workbench applications: 

Data Processing Subsystem 
The Data Processing Subsystem is the ECS Science Data Processing subsystem that the 
Production Monitor uses when monitoring data processing. The Production Monitor has access 
to the Data Processing Subsystem primarily through AutoSys/AutoXpert and the Quality 
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Assurance Monitor (QA Monitor). AutoSys is used for monitoring the processing of DPRs. The 
QA Monitor is used primarily for updating QA metadata flags. 

The Data Processing Subsystem is composed of the following three computer software 
configuration items (CSCIs): 

• PRONG. 
 Provides the services required to manage and monitor the Science Data 

Processing environment, which executes Science Software items (PGEs) and 
produces data products. 

• Algorithm Integration & Test Tools (AITTL). 
 Set of tools used for test and integration of new science software, new versions 

of science software, and user methods into the Science Data Processing 
operational environment. 

• Science Data Processing (SDP) Toolkit. 
	 Provides a set of software libraries, which are used to integrate Science 

Software into the ECS environment. 

The PRONG CSCI is the focus of this section. PRONG (shown in Figure 3) has the following 
major components: 

• AutoSys/AutoXpert. 
 COTS job scheduling software application used to accomplish the execution of 

jobs that support PGE execution in an automated fashion. 
 Provides the ability to create job boxes (a series of related jobs). 
 Manages job dependencies (the input of some processing jobs is the output of 

other jobs). 
 Provides graphical depictions of scheduled jobs, completed jobs, and jobs being 

processed. 
 Includes GUIs that allow human intervention in the AutoSys job stream. 
 Provides various mechanisms for monitoring and altering the job stream. 

• Job Management (EcDpPrJobMgmt). 
 Controls the execution of the PGE and its support processes (i.e., Data 

Management, Execution Management, and PGE Management) that are executed 
from AutoSys. 

	 Maintains a queue of jobs that are waiting for science data and upon receiving 
notification of data availability, initiates the execution. 

• Resource Management. 
 Used for the allocation of resources (i.e., disk space, memory, and Central 

Processing Unit (CPU) resources) for executing PGEs. 
 After a PGE completes its execution, the CPU and memory that were allocated 

are made available for the execution of other PGEs. 
 Files on the production disk are removed on a need-only basis. 

•	 Data Management (EcDpPrDM). 
 Manages the flow of science data to and from science processing resources. 
 Provides additional functions to manage the retention of data on science 

processing resources to support many PGE executions. 
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• PGE Management (EcDpPrRunPGE). 
 Controls and monitors the execution of PGE and the growth of the output 

products. 
 Measures the actual resources used by the PGE. 
 Reports to AutoSys if any abnormal/unexpected events occur, e.g., unexpected 

resource utilization. 
•	 Execution Management (EcDpPrEM). 

 Initiates PGE execution (via AutoSys). 
 Supports the preparation activities prior to the execution of each PGE and 

activities subsequent to the execution of each PGE. 
• Data Preprocessing (EcDpPrAm1AncilliaryDPREP and EcDpPrReplaceEphemeris) 

	 Converts level zero (L0) attitude and ephemeris ancillary data into SDP Toolkit 
native binary format, using a statistical approach. 

• Quality Assurance Monitor (QAMonitor). 
	 Simple interface allowing DAAC operators to perform QA functions (especially 

updating QA metadata) on output data. 
• Deletion Server. 

 Notifies Science Data Server to remove interim granules via the data 
management process once they are no longer needed. 

	 Interim product is removed after the last PGE in the chain has used the interim 
product and a pre set time has expired after its last use. 

•	 Sybase SQL Server. 
 COTS product that acts as an SQL server for the PDPS database. 
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Production Requests


Science Softwar e and Pr oducti on Requests 
Science software is one of the keys to production planning and processing: 

• Performs the actual data processing to create desired products. 
• Is developed at Science Computing Facilities (SCFs) external to ECS. 
• Is embodied in Product Generation Executives (PGEs) when the software is 

integrated into the ECS production processing environment. 
 PGEs are science software code (e.g., executable programs or shell scripts) that 

contain the instructions for processing data to create the desired products. 

The production request (PR) is another key to production planning and processing. The 
Production Planner defines ECS science data processing in terms of PRs. 

• A PR is an order for data to be produced by the Data Processing Subsystem. 
• A single PR may specify several jobs (using the same PGE) that are to be run over a 

period of time or a single job producing a single set of data. 
• PRs may apply to the processing of new data (standard PRs or standing orders) or the 

reprocessing of existing data (reprocessing PRs). 
• Each PR identifies a specific PGE for generating a particular type of product. 

 Some PGEs are dependent on others; i.e., some PGEs require input data that are 
the output of other PGEs. 

 The planning software will recognize and reject a PR when the PR specifies a 
PGE that requires data from another PGE that has not yet been specified in a 
PR. 

The Planning Subsystem performs the following functions: 

• Uses each PR to generate either one or a series of Data Processing Requests (DPRs). 
 Each DPR corresponds to one execution of a single PGE. 
 Each DPR contains the information that is needed by the SDP processing 

function, including PGE-related information. 
• Checks the availability of the data required for the DPR, either from the data server (if 

the data have been previously ingested) or from internal predictions (if the data are 
expected to arrive in the future). 

• Determines what data will be included in the DPR output so the system can make 
predictions concerning the availability of data for subsequent PGEs. 

Figure 4 shows the relationships among the PGEs, PRs, and DPRs as they are accessed through 
the Production Request Editor GUI. 
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Types of Processing 
ECS either accommodates or will accommodate the following three general types of data 
processing: 

• Routine Processing 
• Reprocessing 
• Ad-Hoc Reprocessing 
• On-Demand Processing 

Routine processing is pre-defined software production processing that is periodic and keyed to 
data arrival. For example, every day a Production Planner includes in the daily schedule a DPR 
for generating a particular Level 1A product from the most recent Level 0 data from the 
applicable satellite instrument. 

Reprocessing typically involves using a new, improved PGE to process data that had previously 
been processed with an older version of the PGE. In such cases reprocessing would be a large­
scale operation, especially if several years worth of data were to be reprocessed. Consequently, 
the Production Planner is likely to schedule reprocessing in manageable quantities so the 
processing resources can accommodate routine and on-demand processing in addition to the 
reprocessing. 
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In addition, ad-hoc reprocessing could be necessary at any time. For example, if a product fails a 
quality assurance (QA) check, the same PGE could be run again on the same data set in the hope 
of creating an acceptable product. Similarly, if processing of a PGE fails for some reason, it 
might be possible to rerun the PGE and hopefully achieve a successful outcome. 

On-demand processing is ad-hoc processing initiated by either the Planning Subsystem or an 
end-user (as opposed to the Production Planner). For example, an ASTER researcher may need a 
particular Level 2 product that has not yet been generated and would submit an on-demand 
request to have the product generated from a Level 1B product stored in the archive. 

In the future such on-demand processing requests (OPRs) will be entered from a Client 
Subsystem tool, passed through the Distributed Information Manager (Data Management 
Subsystem) and the Data Server to the Planning Subsystem. Currently there is a work-around to 
the automated process which requires the requester to contact DAAC personnel to make the 
request. So far ASTER researchers are the only identified external users of automated on­
demand processing. 

Another future feature is automated cross-DAAC planning. It is a process that will be 
undertaken when products produced at one DAAC require inputs being produced at another 
DAAC. The predicted production time of remote input products will be used in creating local 
production plans. The primary mechanism for cross-DAAC planning will be the use of Predicted 
Data Availability Schedules (PDAS), created when a plan is created. A DAAC’s PDAS will be 
made available to remote DAACs via the Data Server. 

Producti on Rul es 
Each PGE is subject to one or more production rules, which specify requirements for processing 
the PGE. Production rules determine the conditions under which a PGE may be run. The 
conditions include the types of parameters for which the Production Planner must supply values 
when creating a production request. For example, the Production Planner may have to enter a 
time range (or a range of spacecraft orbits) for the PGE’s input data. 

PGE developers provide ECS with documentation concerning the PGEs they develop. The 
information includes the production rules that apply to each PGE. An example of the 
documentation provided by PGE developers is the MODIS Science Data Processing Software 
Version 2.0 System Description Document (SDST-104). 

When a PGE undergoes Science Software Integration and Test (SSI&T) at the DAAC, 
information concerning the production rule(s) applicable to the PGE is included in the PGE 
metadata Object Description Language (ODL) file. Information concerning the PGE’s input and 
output granules is entered in ESDT metadata ODL files during SSI&T. Other ODL files may be 
required for implementing certain production rules. For example, a tile metadata ODL file is 
required for the implementation of tiling and an orbit model ODL file is needed for orbit-based 
processing. 

•	 The ODL files are read by SSI&T software. The data describing the PGE is stored in 
the PDPS database. 
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• When the PGE is executed in the production environment, the information in the 
PDPS database is retrieved to schedule the PGE for execution. 

• The information tells PDPS when the PGE should be scheduled, what data needs to 
be present to run the PGE, and what processing resources are needed. 

Production rules contribute to a very flexible processing environment. However, the flexibility is 
achieved at the expense of adding to the complexity of the production planning and SSI&T 
processes (especially the latter). 

The following statements are some simplified examples of the production rules that are 
scheduled to be made available in Release 4: 

• Basic Temporal - Temporal (time) range of inputs matches the temporal range of 
outputs. 

• Advanced Temporal - Temporal range of inputs is offset from the expected temporal 
range of inputs and outputs. 

• Alternate Inputs - PGE is run with different inputs based on the availability or 
quality of various alternate input data sets. 

• Optional Inputs - PGE is run with specified optional inputs if available; otherwise, 
PGE is run without them. 

• Tiling  - Input data is chosen on the basis of Instrument Team-defined tiles 
(geographic areas). 

• In termittent Activation - Every nth DPR is activated; all other DPRs are skipped. 
• Metadata-Based Conditional Activation - DPR is run only if metadata value(s) 

meet(s) certain criteria. 
• Metadata-Based Query - Input granule selection is based on metadata value. 
• Data Day - Input data selection is based on Data Day. 
• Orbital Processing - Selection of input times is based on orbit information. 
• PGE Exit Conditions - An error message is provided or PGE activation is prevented 

depending on the value of a PGE exit code. 

Basic Temporal Production Rule 

The most basic type of production rule specifies the time range for each input of the relevant 
Earth Science Data Type (ESDT) required by the PGE. For example, the run of a PGE which 
produces a five-minute MOD10_L2 [MODIS Level 2 Snow Cover (500m)] data granule requires 
as input the MOD02HKM [MODIS Level 1B Calibrated Radiances (500m)], MOD03 [MODIS 
Geolocation], and MOD35_L2 [MODIS Level 2 Cloud Mask and Spectral Test Results] granules 
that include the same specific five-minute time period as the MOD10_L2 granule to be produced. 

For each PGE that uses the basic temporal rule, the SSI&T team enters the following types of 
temporal-rule information (in addition to other types of information) in the PGE metadata ODL 
file during the SSI&T process: 

• PGE Schedule Type - Time (as opposed to “Orbit” or “Tile”). 
• Processing Boundary - Time boundary on which the PGE runs. Valid values are as 

follows: 
− START_OF_HOUR. 
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− START_OF_6HOUR. 
− START_OF_DAY. 
− START_OF_WEEK. 
− START_OF_ONE_THIRD_MONTH. 
− START_OF_MONTH. 
− START_OF_YEAR. 
− START_DATE. 
− START_OF_ORBIT. 

• Processing Period - Interval between PGE runs (e.g., “DAYS=1”). Valid types are 
as follows: 

− SECS. 
− MINS. 
− HOURS. 
− DAYS. 
− WEEKS. 
− THIRDS. 
− MONTHS. 
− YEARS. 
− ORBITS. 

For each input ESDT that comes from an external source (rather than being generated by PGEs at 
the DAAC) the SSI&T team enters following types of temporal-rule information (in addition to 
other types of information) in the ESDT metadata ODL file: 

• Processing Boundary - Time boundary on which the data are collected. 
• Processing Period - Interval of data collection (e.g., every hour, every two hours, 

every day). 

A detailed example of the Basic Temporal Production Rule is shown in Figure 5 and is described 
as follows: 

• Involves a PGE which creates a daily (24-hour) output data set that corresponds to a 
calendar day. 

• Input data for the ESDT is ingested and archived every two hours. 
• The following statements were included in the PGE metadata ODL file during 

SSI&T: 
− SCHEDULE_TYPE = “Time” 
− PROCESSING_BOUNDARY = “START_OF_DAY” 
− PROCESSING_PERIOD = “DAYS=1” 

• During SSI&T the following statements were included in the ESDT metadata ODL 
file for the input ESDT: 

− PROCESSING_BOUNDARY = “START_OF_DAY” 
− PROCESSING_PERIOD = “HOURS=2” 

• The Production Planner creates the following two PRs: 
− First (PR #1) for the time between 06/03/99 00:00 and 06/06/99 24:00. 
− Second (PR #2) for the time between 06/07/99 00:00 and 06/16/99 24:00. 

27 625-CD-006-002




• When the first PR is entered, the Planning Subsystem produces DPRs for each period 
of time covered by the PR. 

− Creates a DPR (DPR 1.1) to process the first period (06/03/99 00:00 through 
06/03/99 24:00). 

− Continues producing DPRs (DPR 1.2 through DPR 1.4) until it reaches the end 
of the period that contains the end time of the PR. 

Figure 5. Example of DPR Creation Using the Basic Temporal Production Rule 

•	 When PR #2 is entered, the same process takes place, producing DPR 2.1 through 
DPR 2.10. 

Advanced Temporal Production Rule 

The input data requested for a PGE may include granules that are outside the processing period 
for the PGE run. The Advanced Temporal Production Rule provides the capability for retrieving 
input data beyond the time limits of the processing period. Using the Advanced Temporal 
Production Rule, the input data date/time requirements may be offset from either the start or the 
end of the PGE processing period (or both) to acquire the necessary granules of a specified 
ESDT. If the offset’s delta (variation from the processing period) is negative, the input date/time 
is moved backward in time. A positive delta moves the date/time forward in time. Different 
deltas may be applied to each input ESDT. 

For each PGE that uses the Advanced Temporal Production Rule, the same types of information 
that are entered for the Basic Temporal Production Rule must be specified in the PGE metadata 
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ODL file during the SSI&T process. That information includes the PGE Schedule Type, 
Processing Boundary, and Processing Period. In addition, the following types of information 
must be included: 

• Begin Period Offset - Number of seconds to add (+) or subtract (-) from the start 
collection time when requesting data. 

• End Period Offset - Number of seconds to add or subtract from the end collection 
time when requesting data. 

The following detailed example of the Advanced Temporal Production Rule is a modification of 
the Basic Temporal Production Rule shown in Figure 5 involving the addition of a two-hour 
(7200-second) offset at the beginning of the period. 

• PGE creates a daily (24-hour) data set.

• Input data for the ESDT is ingested and archived every two hours.

• The following statements were included in the PGE metadata ODL file during


SSI&T: 
− SCHEDULE_TYPE = “Time” 
− PROCESSING_BOUNDARY = “START_OF_DAY” 
− PROCESSING_PERIOD = “DAYS=1” 
− BEGIN_PERIOD_OFFSET = -7200 
− END_PERIOD_OFFSET = 0 

• During SSI&T the following statements were included in the ESDT metadata ODL 
file for the input ESDT: 

− PROCESSING_BOUNDARY = “START_OF_DAY” 
− PROCESSING_PERIOD = “HOURS=2” 

• The Production Planner creates the following two PRs: 
− First (PR #1) for the time between 06/03/99 00:00 and 06/06/99 24:00. 
− Second (PR #2) for the time between 06/07/99 00:00 and 06/16/99 24:00. 

• When the first PR is entered, the Planning Subsystem produces DPRs for each period 
of time covered by the PR. 

− Creates a DPR (DPR 1.1) to process the first period (06/03/99 00:00 through 
06/03/99 24:00); however, when PLS requests the input data for processing the 
PGE, it will include a request for data for 06/02/99 22:00 through 24:00 (the 
7200 seconds preceding the beginning of the processing period). 

− Continues producing DPRs (DPR 1.2 through DPR 1.4) including an input data 
offset of two hours until it reaches the end of the period that contains the end 
time of the PR. 

•	 When PR #2 is entered, the same process takes place, producing DPR 2.1 through 
DPR 2.10. 

Alternate Inputs Production Rule 

The Alternate Inputs Production Rule applies to the type of PGE that can use any one of several 
inputs for one of its input data sets. For example, a particular PGE might require model wind 
data as an input and would be capable of accepting wind data from a Data Assimilation Office 
(DAO) model, a National Centers for Environmental Prediction (NCEP) model or, as a last 
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resort, could use climatology. Variants of the rule allow alternates to be grouped so that more 
than one of the alternates may be needed (e.g., use any 2 of 3 ESDTs in the group). 

During SSI&T a hierarchy of alternative input granules/files is specified in the PGE metadata 
ODL file. One input is considered the “primary” input. The others are identified as “alternate” 
inputs. Each input has an associated time-out period. If the input does not become available 
within the time-out period, processing will wait for the next alternate through its time-out period 
and so on. If the primary input or a higher-priority alternate becomes available during the 
waiting period for a lower-priority alternate, the PGE is activated with the available higher­
priority input. 

The SSI&T team enters the following information in the PGE metadata ODL file for each Data 
Type (PCF Entry) that is or has alternate inputs: 

• Input _Type - Either “Primary” (fi rst choice) or “Alternate” (all other choices). 
• Number Needed - Number of the alternate data sets (from the group of alternatives) 

required by the PGE. 
− Typically one, but can be more. 

• Object - Alternate_Input. 
• Category - Name of list of alternates. 

− Same for every alternate in the list. 
• Order  - Number indicating the alternate’s place in the hierarchy [i.e., 1 (first), 2 

(second), etc.] 
• Timer  - Number of days/hours/seconds to wait for alternate (e.g., “HOURS=6”). 
• WaitFor  - “Y” or “N” indicating whether the PGE should continue without waiting 

for this alternate. 
− Should be “N” for all but the last alternate in the list. 

• Temporal - Indicates whether the alternate data type has a temporal component (i.e., 
“Y” or “N”). 

− “N” i ndicates “use the most currently produced.” 
• End Object - Alternate_Input 

An example of PGE metadata ODL file entries for Alternate Inputs is shown in Table 1. The 
Production Planner can make some modifications to the alternate input specifications (e.g., timer 
settings) when creating a production request using the Production Request Editor. 
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Table 1. Extract of PGE Metadata ODL File Template Showing Alternate Inputs 
(1 of 2) 

>OBJECT = PCF_ENTRY


> CLASS = 16


> LOGICAL_ID = 1500


> PCF_FILE_TYPE = 1


> DATA_TYPE_NAME = "MOD10L2G" [MODIS Level 2G Snow Cover]

> DATA_TYPE_VERSION = "1" [ESDT versioning in release B.0]

> DATA_TYPE_REQUIREMENT = 1


>  SCIENCE_GROUP = ""

> OBJECT = FILETYPE


> CLASS = 1


> FILETYPE_NAME = "Single File Granule"

>  END_OBJECT = FILETYPE


> INPUT_TYPE = "Primary"

> NUMBER_NEEDED = 1


>  OBJECT = ALTERNATE_INPUT


> CLASS = 1


> CATEGORY = "Snow Ice" [User defined]

> ORDER = 1 [This data type is sought first]

>  RUNTIME_PARM_ID = 1509 [Run-time parameter holds LID of alternate]

> TIMER = "HOURS=6"

> WAITFOR = "N" [Force time-out on wait]

> TEMPORAL = "N" [Use most currently produced]

>  END_OBJECT = ALTERNATE_INPUT


>END_OBJECT = PCF_ENTRY


>


>OBJECT = PCF_ENTRY


> CLASS = 17


> LOGICAL_ID = 1501


> PCF_FILE_TYPE = 1


> DATA_TYPE_NAME = "MOD10A1" [MODIS Level 3 Daily Gridded Snow Cover data set]

> DATA_TYPE_VERSION = "1"

> DATA_TYPE_REQUIREMENT = 1


>  SCIENCE_GROUP = ""

> OBJECT = FILETYPE


> CLASS = 2


> FILETYPE_NAME = "Single File Granule"

>  END_OBJECT = FILETYPE


> INPUT_TYPE = "Alternate"

>  OBJECT = ALTERNATE_INPUT


> CLASS = 2
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Table 1. Extract of PGE Metadata ODL File Template Showing Alternate Inputs 
(2 of 2) 

> ORY = "Snow Ice" er defined] 
> RDER = 2  data type is sought last] 
>  RUNTIME_PARM_ID = 1509  LID of alternate] 
> URS=6" s] 
> FOR = "N" 
> RAL = "N" 
>  END_OBJECT = ALTERNATE_INPUT 
>END_OBJECT = PCF_ENTRY 
> 
>OBJECT = PCF_ENTRY 
> 
> GICAL_ID = 1502 
> _FILE_TYPE = 1 
> A_TYPE_NAME = "MIANTASC" errestrial Atmosphere and Surface Climatology] 
> A_TYPE_VERSION = "1" 
> A_TYPE_REQUIREMENT = 1 
>  SCIENCE_GROUP = "" 
> BJECT = FILETYPE 
> 
> ILETYPE_NAME = "Single File Granule" 
>  END_OBJECT = FILETYPE 
> _TYPE = "Alternate" 
>  OBJECT = ALTERNATE_INPUT 
> 
> ORY = "Snow Ice" er defined] 
> RDER = 3  data type is sought last] 
>  RUNTIME_PARM_ID = 1509  LID of alternate] 
>  this one] 
> R = "Y" way] 
> RAL = "N" 
>  END_OBJECT = ALTERNATE_INPUT 
>END_OBJECT = PCF_ENTRY 

CATEG [Us
O [This

[Run-time parameter holds
TIMER = "HO [Wait 6 additional hour
WAIT
TEMPO

CLASS = 18 
LO
PCF
DAT [MISR T
DAT
DAT

O
CLASS = 3 
F

INPUT

CLASS = 3 
CATEG [Us
O [This

[Run-time parameter holds
[Don't wait forTIMER = "" 

WAITFO [Start any
TEMPO

The example of the Alternate Inputs Production Rule listed in Table 1 is illustrated in Figure 6 
and can be described as follows: 

•	 The PGE has one required input data set and a second data set, which can be any one 
of three alternates. 
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Required Dataset PGE-1 Output Dataset

Primary Dataset

Ideal Dataset - wait
up  to 6 hours after
requ ired Datasets
available

Firs t Alternate
< or  >

Use after 6 hours if
pr imary alternate
no t avai lable

Second Alternate

< or >

Use after to tal  of 
12 hou rs if  neither
pr imary dataset nor 
first  alternate available

Figure 6.  

• Of the three alternates, the first (“primary dataset” ) is the preferred data set and the
last choice is the least desirable.

• Unless the Production Planner designates different choices for Primary Dataset (first
choice), First Alternate and/or Secondary Alternate or resets the timer for each when
creating a production request, the PGE will use inputs as follows:

− Primary Dataset (first choice) timer is set for six hours.
− Primary Alternate timer is set for six hours.
− Secondary Alternate timer is set at null value.

• After the production plan that includes a DPR for the PGE has been activated and the
required input becomes available, an attempt is made to acquire the primary data set.

− If the first choice is unavailable, the Planning Subsystem holds the DPR and
starts the first timer (six hours).

− If the first choice becomes available within the six-hour period, the DPR is
started as soon as possible.

• If the first timer expires and the primary data set is still unavailable, an attempt is
made to use the first alternate.

− If the first alternate is unavailable, the second timer (six hours) is started.
− If either the primary data set or the first alternate becomes available at any time

during the second six-hour period, the DPR is started as soon as possible using
whichever data set became available first.

− If the second timer expires (a total of twelve hours after the required input
became available), an attempt is made to use the second alternate.

Example of Alternate Inputs Production Rule



• Most PGEs are expected to have a last alternate that is always available (e.g., 
climatology). 

− If the last alternate is not available, the DPR is held indefinitely waiting for one 
of the alternates to become available. 

Optional Inputs Production Rule 

The Optional Inputs Production Rule (Figure 7) applies to the type of PGE that can be run either 
with or without optional input(s) in addition to the required input(s). The PGE would not be 
activated until the expiration of the time-out period(s) for the optional input(s). If there are 
multiple optional inputs, the time-out periods count down at the same time. The PGE would be 
activated under either of the following conditions: 

• Activated with the optional input(s) upon the availability of optional input(s) during 
the time-out period(s). 

• Activated without the optional input(s) at the expiration of the time-out period(s) for 
the optional input(s). 

For example, a particular MISR PGE might use TASC (Terrestrial Atmosphere and Surface 
Climatology) data as a required input and would use either MOD10A1 (MODIS Level 3 Daily 
Gridded Snow Cover) data or MOD10L2G (MODIS Level 2G Snow Cover) data if either were 
available within a two-hour period of time. The PGE would run with just TASC data if neither 
set of optional data became available within the specified two-hour time-out period. 

The SSI&T team would enter the following information in the PGE metadata ODL file for each 
Data Type (PCF Entry) that is an Optional Input: 

• Input _Type - Optional.

• Object - Optional_Input.

• Category - Name of the list of optional inputs.

• Order  - Number indicating the option’s place in the hierarchy (i.e., first, second,


etc.). 
• Timer  - Number of days/hours/seconds to wait for the optional input (e.g., 

“HOURS=2”). 
• Temporal - Indicates whether or not the optional data type has a temporal component 

(i.e., “Y” or “N”). 
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Required Dataset PGE-1 Output  Dataset 

Optional Dataset 

Wait u p to 2 hours afte r 
requi red da taset(s) 
available, then run 
without optio nal data 

Figure 7. Example of Optional Inputs Production Rule 

• End Object - Optional_Input. 

Tiling Production Rule 

The Tiling Production Rule is applied to a type of PGE that is set up to run for a series of pre­
defined areas (tiles) on the earth’s surface. Among the requirements for implementing the Tiling 
Production Rule, is the necessity for the PGE developers to create tile definition files to describe 
all of the tiles. The Production Planner specifies the relevant Tile ID (which becomes a run-time 
parameter) when creating a production request. The Planning Subsystem uses the definitions to 
query the Data Server for input data granules relevant to the tile specified in the production 
request. 

For each PGE that uses the Tiling Production Rule, the following types of information must be 
included in the PGE metadata ODL file during the SSI&T process: 

• PGE Schedule Type - Tile.

• Tile Scheme - Name of the tile scheme defined in the tile metadata ODL file.


The following types of information must be included in the tile metadata ODL file: 

• Tile Scheme - Name of the tile scheme. 
• Entries for every tile, including data in the following categories: 

− Tile ID - Unique identifier used to refer to the tile. 
− Tile Descr iption - Description of the tile. 
− Coordinates - Coordinates of the four (or more) corners of the tile. 

An example of how the Tiling Production Rule is implemented is shown in Figure 8. 

• A tile definition file is part of the package delivered with the PGE for SSI&T. 
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PGE-1 Output Dataset

Ti le 1 Dataset

Ti le 2 Dataset

Ti le 3 Dataset

Figure 8.  

• During normal operations the Production Planner creates a PR to run the PGE on a
particular tile.   

− A DPR is generated for the tile.
− The Planning Subsystem (PLS) uses the tile definitions to query the Data Server

Subsystem (DSS) to identify all input data granules covering the specified tile
(i.e., Tile 2 in Figure 8).

− It is likely that many of the input granules will have data outside as well as
inside each tile.

− The universal references (URs) for the input granules and the specific tile
definition are passed to the Data Processing Subsystem (DPS) as part of each
DPR.

− As each DPR runs, the DPS acquires the inputs from the DSS, the PGE runs,
and using only the data in the tile, creates an output data granule for its tile.

Intermittent Activation Production Rule

The conditions for executing most PGEs are well defined.   most common activation
condition is the availability of all input data sets.  Similarly, the frequency of execution is usually
well defined (e.g., run once for every granule or run monthly averages once a month).  However,
some PGEs have additional or different constraints on when they are run.

A PGE can be set up to run on every nth instance of input data.  
run on a daily product may need to be run only every fifth day to provide a spot check.  
this does not refer to the common case of running a weekly averaging PGE only once each week,
which would be handled by the Basic Temporal rule and the time ranges specified for the input
and output ESDTs.  ather, this is a special case where a PGE can be run every day (or hour,

Example of Tiling

(The Production Planner specifies the Tile ID when creating the PR.)

The

For example, a QA PGE that is
Note that

R



thweek, etc.), but for some reason (such as a QA check) it is desired to run the PGE only every n 
day. 

To implement the Intermittent Activation Production Rule the Production Planner supplies the 
following information (via the Production Request Editor) when creating a production request: 

• Number to Skip - Number of DPRs to be skipped (not executed). 
• Number to Keep - After skipping the specified number of DPRs, how many are to be 

kept. 
− The number to keep is usually one but could be any number. 

• Skip Fir st (button on the Production Request Editor) - Selected to skip the first DPR. 
− Not selected if the first DPR is to be run. 

The Planning Subsystem uses the preceding information to establish a pattern of execution. The 
pattern is effective for the single PR in which the “number to skip” and the “number to keep” are 
specified; it is not maintained between PRs. 

The following example of the Intermittent Activation Production Rule is shown in Figure 9: 

• The Production Planner prepares a production request for a 14-day period, generating 
14 DPRs. 

• The Production Planner made the following selections on the Production Request 
Editor: 

− Entered “4” in the Number to Skip field. 
− Entered “1” in the Number to Keep field. 
− Did not select the Skip Fir st button. 

• Consequently, the following results will be obtained: 
− First DPR will run. 
− Four DPRs (second through fifth) will be skipped. 
− Sixth DPR will run. 
− Four DPRs (seventh through tenth) will be skipped. 
− Eleventh DPR will run. 
− Remaining three DPRs (twelfth through fourteenth) will be skipped. 
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Run PGE on same data 
set every five days 

DAY 1: 

Dataset 1 QA PGE Output Dataset 

DAY 6: 

Dataset 1 QA PGE Output Dataset 

DAY 11: 

Dataset 1 QA PGE Output Dataset 

Figure 9. Example of the Intermittent Activation Production Rule 

Metadata-Based Conditional Activation Production Rule 

In some cases it is appropriate to base the determination of whether a given DPR should be run 
on a check of the inventory attributes and product-specific attributes (PSAs) of one or more of its 
input data sets. For example, a PGE could be set up so that a Quality Assurance (QA) flag must 
be set to an acceptable level/state within the metadata of an input data set or the PGE should not 
be run. 

For each PGE that uses metadata-based conditional activation, the following types of information 
must be included in the PGE metadata ODL file during the SSI&T process: 

• Object - Metadata_Checks.

• Parm_Name - Name of the metadata parameter (e.g., AutomaticQualityFlag) to be


checked. 
• Operator - Logical operator (i.e., ==, !=, <, <=, >, >=) on the parameter value. 
• Value - Value to be checked against (e.g., “passed”). 

Checks and queries may be specified for more than one ESDT input and on more than one 
inventory attribute and PSA. Multiple default values for metadata checks and queries are 
implemented as a logical “AND” capability. (There is currently no “OR” capability.) Although 
default values for metadata checks are entered initially during SSI&T, the Production Planner 
can modify the values using the Production Request Editor when a production request is entered. 

During SSI&T the following types of information must be included in the ESDT metadata ODL 
file for each input with a metadata check: 
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• Object - Metadata_Definition.

• Parm_Name - Name of the metadata parameter (e.g., AutomaticQualityFlag) to be


checked. 
• Container Name - Name of the container or group that includes the parameter value. 
• Type - Type of parameter (e.g., integer, float, string). 

The following example of metadata-based conditional activation is illustrated in Figure 10: 

• The following statements were included in the PGE metadata ODL file during 
SSI&T: 

− OBJECT = METADATA_CHECKS 
− CLASS = 1 
− PARM_NAME = "AutomaticQualityFlag" 
− OPERATOR = "==" 
− VALUE = "passed" 
− END_OBJECT = METADATA_CHECKS 

Input Dataset PGE-1 Output  Dataset 

Run PGE if QA flag 
set to acceptable 
value 

Figure 10. Metadata-Based Conditional Activation 

• The Production Planner creates a production request for a PGE that uses one input 
data set. 

• The input needs to have its metadata checked prior to activation of the DPR. 
• In order for the DPR to be activated the input must meet the following condition: 

− AutomaticQualityFlag = passed. 
•	 As previously stated, if it were decided that the AutomaticQualityFlag should be set 

to some other value, the value used for comparison could be changed when the 
production request was entered. 

Metadata-Based Query Production Rule 

Metadata values can be used to refine the list of inputs acquired for the run of a PGE. For 
example, a PGE could be set up so that only inputs with metadata set to “day” (rather than 
“night”) can be used. Note that metadata-based query is concerned with the selection of 
appropriate input data for a run of the PGE while metadata-based activation focuses on whether 
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or not the PGE should be run. In addition, metadata-based query can be used in conjunction with 
metadata-based activation. 

Both of the metadata-based rules have an optional parameter called Database_Query, which 
causes the query to be performed on a value retrieved from the PDPS database rather than on the 
value for the inventory attribute or PSA. However, by default the inventory attribute or PSA is 
used. 

For each PGE that uses metadata-based query, the following types of information must be 
included in the PGE metadata ODL file during the SSI&T process: 

• Object - Metadata_Query.

• Parm_Name - Name of the metadata parameter (e.g., AutomaticQualityFlag) to be


queried. 
• Operator - Logical operator (e.g., ==) on the parameter value. 
• Value - Value for comparison with the parameter value returned from the database 

query. 
• Database Query - Value to be obtained from the PDPS database. Valid values are as 

follows: 
− ORBIT NUMBER. 
− PATH NUMBER. 
− TILE ID. 
− START DATA DAY. 
− END DATA DAY. 
− [none]. 

The same types of information that are provided in a metadata-check ESDT metadata ODL file 
must be included in the ESDT metadata ODL file for each input subject to a metadata query. 

The following example of metadata-based conditional activation is illustrated in Figure 11: 

• The following statements were included in the PGE metadata ODL file during 
SSI&T: 

− OBJECT = METADATA_QUERY 
− CLASS = 1 
− PARM_NAME = "SensorShortName" 
− OPERATOR = "==" 
− VALUE = "DF" 
− DATABASE_QUERY = "" 
− END_OBJECT = METADATA_QUERY 
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Input Dataset Output  Dataset 

Get inputs with 
Sensor Sho rtName 
set to “D F” only 

Figure 11. Metadata-Based Query 

• The Production Planner creates a production request for the PGE. 
• Each input needs to have its metadata queried to determine whether it can be used in 

processing. 
− In order for an input to be used, SensorShortName must be set to DF. 

Data Day Production Rule 

The Data Day Production Rule (Figure 12) involves a type of metadata-based query. The 
metadata parameter to be queried is Data Day, which is internally tracked within ECS and is 
defined by the dynamic run-time parameters known to the PDPS database as “start dataday” and 
“end dataday.” When a Production Planner creates a production request that invokes the Data 
Day Production Rule, the current “start dataday” and “end dataday” parameters are passed to the 
PGE as run-time parameters, which are then used in a metadata-based query to identify granules 
that meet the search criterion (Data Day). Activation of the PGE is based either on the 
availability of all granules for the Data Day or alternatively on the minimum number of granules 
specified when the PGE was registered during the SSI&T process. The timing of the query 
would be predetermined so the execution would proceed if the “number of granules” condition 

PGE-1 

were met. 

Input Dataset PGE-1 

Get input s where 
metadata is set t o 
correct data day only 

Output Dataset 

Pass PGE the Start 
and End Data Day 
values 

Figure 12. Data Day Production 
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The following production rule information is entered in the PGE metadata ODL file at PGE 
registration during the SSI&T process: 

• PGE Schedule Type - Time. 
• A process control file (PCF) entry is created for run-time parameters specifying Start 

Data Day and End Data Day. 
• A metadata query object is created for inputs that are to be requested by Data Day as 

shown in the following example: 
− OBJECT = METADATA_QUERY 
− PARM_NAME = “StartDataDay” 
− OPERATOR = “>=“ 
− VALUE = “0” 
− DATABASE_QUERY = “START DATA DAY” 
− END OBJECT = METADATA_QUERY 
− OBJECT = METADATA_QUERY 
− PARM_NAME = “EndDataDay” 
− OPERATOR = “<=“ 
− VALUE = “0” 
− DATABASE_QUERY = “END DATA DAY” 
− END OBJECT = METADATA_QUERY 

In addition the PGE metadata ODL file needs a process control file (PCF) entry for the run-time 
parameters that will specify Start Data Day and End Data Day values. The following parameter 
allows PDPS to populate the run-time parameters with the Start Data Day or End Data Day: 

•	 PGE_PARAMETER_DYNAMIC_VALUE = “START DATA DAY” [or “END 
DATA DAY” as applicable] 

The following information needs to be filled out in the ESDT metadata file for each input 
acquired by Data Day: 

• Object - Metadata_Definition

• Parm_Name - Name of Data Day parameter

• Container_Name - AdditionalAttributes [because Data Day is in a product-specific


attribute (PSA)] 
• Type - string 
• End Object - Metadata_Definition 

For example, the MODIS Ocean PGEs, which require the Data Day Production Rule, will make 
use of the dynamic run-time parameters known to the PDPS database as “start dataday” and “end 
dataday.” 

• PDPS incorporates an algorithm provided by the MODIS Oceans Group for 
determining each Ocean Data Day, and tracks the Data Days for production. 

• Delta offset times on both sides of the processing period are specified using the 
Advanced Temporal Production Rule when the PGEs are registered. 

• For each run of the Ocean PGEs, PDPS stages the correct amount of data on either 
side of the Greenwich Mean Time (GMT) day for both day and night mode 
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executions, using the “start dataday”  and “end dataday”  as limits for a Metadata 
Query on the Data Day product-specific attribute (PSA) in the Ocean L3 products. 

• Both daily and multiple-day Ocean PGEs require the Data Day Production Rule. 
• At run time PDPS returns the values of the “start dataday”  and “end dataday”  in the 

run-time parameters defined with associated logical IDs in the instantiated PCF. 
• For daily PGEs the “start dataday”  and “end dataday”  will be equivalent. 

Orbital Processing Production Rule 

During SSI&T PGE processing can be set up to be activated on the basis of spacecraft orbit 
(rather than a temporal range) as shown in Figure 13. The orbit numbers and corresponding 
temporal ranges are maintained in an internal table. The temporal range of the input and output 
data is determined by look-up table. The PGE is not activated unless all granules for an orbit are 
available. The internal orbit number table is updated frequently (approximately every ten days). 

EDOS L0 Data Set 
L1A Dataset

1 or more 
PGE-1 

EDOS L0 Data Set 

L1A st art/stop times 

Run PGE when an 
orbi t’s worth o f data 
is available 

Figure 13. Orbit al Processing 

The Production Planner specifies the orbit number range when creating each production request 
for an orbit-based PGE. 

The following information is included in the PGE metadata ODL file: 

• Schedule_Type - Orbit.

• Processing_Boundary - Start_Of_Orbit.

• Processing_Period - Number of orbits [“Orbits=X” (where X is an integer value)].


In addition to the PGE metadata ODL file and applicable ESDT metadata ODL file(s), the 
following files are necessary for the implementation of orbital processing: 

• Orbit Model ODL file.

• Path Model ODL file (if path mapping is desired).


The following information is provided in the orbit model ODL file: 

• Platform  - Platform of spacecraft. 
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• Orbit_Start - Start time of orbit.

• Orbit_Number - Number of orbit.

• Path_Number  - Number of the path (0-233) that matches the specified orbit number.


PGE Exit Conditions 

The use of PGE exit conditions in managing production is somewhat different from the 
preceding types of production rules because it occurs after a PGE has run. However, the exit 
condition of one PGE may determine whether a subsequent PGE will be activated. 

The key to implementing the use of PGE exit conditions in production is the PGE exit code. A 
PGE that runs to successful completion returns an exit code of 0 (zero). Any other exit code 
indicates some kind of error condition. PGE developers may specify exit messages for exit codes 
203 - 222; all others are system-defined. 

The following two cases describe the use of exit codes in production: 

• Exit Condition Definition. 
− Specifies messages for various PGE exit codes. 

• Exit Condition-Based Activation. 
− Determines whether or not to activate a PGE based on the value of an exit code. 

Two related PGEs, PGE#2 and PGE#4, are used to illustrate the preceding cases. PGE#2 
provides an example of exit code definition. PGE#4 is an example of exit condition-based 
activation. 

The PGE metadata ODL file for PGE#2 specifies messages for the PGE exit codes shown in 
Table 2. 

Table 2. Exit Messages Specif ied in PGE#2 
EXIT_CODE EXIT_MESSAGE 

203 CCD Focal Plane Temperature Warning on AN Camera 

204 CCD Focal Plane Temperature Warning on DF Camera 

221 Camera Head Temperature Warning 

222 Optics Temperature Warning 

The PGE metadata ODL file for PGE#4 specifies the following exit condition dependency: 

•	 The activation of PGE#4 depends on PGE#2 having an exit code that does not equal 
203. 

If PGE#2 exits with code of 203, PGE#4 will be prevented from running. 
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Producti on Pl anni ng Consi derations 
During normal operations it is expected that the Production Planner will not have to add PRs to 
the PDPS database very frequently. The frequency of this activity is, to some extent, determined 
by the SCF responsible for the science software. 

• The PR is a template request to generate a particular data product and results in a 
production run of the associated SCF-provided PGE. 

 PR specifies a range (temporal, orbit, or tile) over which the data products are to 
be produced or the PGEs are to be scheduled. 

⋅ PR might request that the data product be produced for only a single day’s 
data. 

⋅	 PR might request that data products be produced for every opportunity of 
input data for several months, resulting in several hundred jobs being planned 
and run as the input data become available. 

	 Early in a mission the SCF may prefer to request processing for a short time 
period only (e.g., a week or less). 

⋅	 At that time the SCF is gaining an understanding of the on-orbit behavior of 
the instrument, the resulting data, and the interaction of the science processing 
software with real data. 

⋅	 SCF reviews the quality of the products and notifies the Production Planner of 
the need for any changes to the PR (e.g., discontinue the PR, change time 
ranges, or modify input parameters). 

	 When the SCF has developed a good understanding of the instrument’s 
behavior, the team may be comfortable requesting processing for months at a 
time. 

 DAAC operations may have operational reasons for wanting to issue processing 
requests for a more limited time period. 

• The Production Planner has to balance the various considerations when determining 
whether or not to create or update a PR. 

Planning decisions are made on the basis of locally defined planning strategies for supporting the 
SCFs’ data processing needs. The production planning tools are intended to be flexible enough 
in their design to support the particular planning and scheduling cycles of the operations 
organization at each DAAC. 

Before planning production the Production Planner must coordinate with the Resource Planner to 
resolve all resource allocation issues. The Resource Planner notifies the Production Planner of 
the resources available for use in processing. Furthermore, the Production Planner may well 
have direct access to the Resource Plan. 

The Production Planner prepares monthly and weekly production plans. In addition, the 
Production Planner develops a daily production schedule from the most current weekly plan. 
However, the first step in the planning process is creating production requests using the 
Production Request Editor. 
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Launching the Production Request Editor


Launching the Production Request Editor 
The following software applications are associated with the Production Request Editor: 

• Production Request Editor. 
• Subscription Editor. 
• Subscription Manager. 

It is expected that eventually the ECS desktop will be configured to allow access to those 
Production Planning and Processing applications that have user interfaces. The icon for the 
Production Request Editor is shown in Figure 14. In the interim, access to the Production 
Planning and Processing tools must be gained through the use of UNIX commands. 

Figure 14. Production Request Editor GUI Icon 

In any case, launching Production Request Editor applications starts with the assumption that the 
applicable servers are running and the Production Planner has logged in to the ECS system. 

Launching Production Request Editor Applications Using UNIX Commands 

NOTE: Commands in Steps 1 through 9 are typed at a UNIX system prompt. 
1	 At the UNIX command line prompt type xhost hostname then press the Return/Enter 

key on the keyboard. 
• hostname refers to the host on which GUIs are to be launched during the current 

operating session. Multiple hostnames can be specified on the same line. 
• The use of xhost + is discouraged because of a potential security problem. 

2 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
• Use either the X terminal/workstation IP address or the machine-name for the 

clientname. 
• When using secure shell, the DISPLAY variable is set just once, before logging in to 

remote hosts. If it were to be reset after logging in to a remote host, the security 
features would be compromised. 

3 Open another UNIX (terminal) window. 
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4	 Start the log-in to the Planning/Management Workstation by typing /tools/bin/ssh 
hostname (e.g., e0pls03, g0pls01, l0pls02, or n0pls02) in the new window then press the 
Return/Enter key. 
• If you receive the message, Host key not found from the list of known hosts. Are 

you sure you want to continue connecting (yes/no)? type yes (“y”  alone will not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 5. 

• If you have not previously set up a secure shell passphrase; go to Step 6. 
5	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 7. 

6 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

7 Type setenv ECS_HOME /usr/ecs/ then press the Return/Enter key. 
• When logging in as a system user (e.g., cmshared), the ECS_HOME variable may be 

set automatically so it may not be necessary to perform this step. 
8 Type cd /usr/ecs/MODE/CUSTOM/utilitie s then press Return/Enter. 

• Change directory to the directory containing the production planning startup scripts 
(e.g., EcPlPRE_IFStart). 

• The MODE will most likely be one of the following operating modes: 
 OPS (for normal operation). 
 TS1 (for Science Software Integration and Test (SSI&T)). 
 TS2 (new version checkout). 

• Note that the separate subdirectories under /usr/ecs apply to (describe) different 
operating modes. 

9 Type EcPlPRE_IFStart MODE  then press Return/Enter to launch the Production 
Request Editor GUI. 
• The Production Request Editor graphical user interface (GUI) introductory window 

(Figure 15) is displayed. 
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Figure 15. Production Request Editor Introductory GUI 
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Creating/Updating/Deleting a Production Request


Creating a New Pr oducti on Request 
The new Production Request process begins when the Production Planner starts the Production 
Request Editor graphical user interface (GUI) from a UNIX prompt. The Production Planner 
enters the Request Definition, PGE parameters, duration, production rule related information, 
and comments for the new Production Request. 

Before creating the new PR the Production Planner must be prepared to provide the following 
information: 

• Name of the PR. 

• Priority of the PR. 

• PGE to be used in processing the PR. 

• Start Date. 

• Start Time. 

• End Date. 

• End Time. 

• Production rules that affect the PGE and applicable values to be entered (if any). 

• Comments (if applicable). 

The procedure for creating a new production request starts with the assumption that all applicable 
servers and the Production Request Editor GUI are currently running and the Production 
Request Editor Introductory GUI (Figure 15) is being displayed. 

Creating a New Production Request 

1 Select the Production Request Editor by clicking (single click) on the PR Edit tab. 
• The PR Edit GUI page (Figure 16) is displayed. 

2	 Click and hold the PR Type option button to display a menu of types of production 
requests, move the mouse cursor to the desired selection (highlighting it), then release the 
mouse button. 
•	 The following production request types are listed: 

− Routine. 
− On-Demand [not currently available for selection]. 
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Figure 16. PR Edit GUI 
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− Reprocessing. 
− Ad-hoc Reprocessing. 

NOTE:• The PR Name and Origination Date fields will be filled automatically when the 
Production Request is saved at the end of the procedure. (You do not need to fill 
in these fields.) 

3• Type the identification of the person creating the production request in the Originator 
field. 

•	 Either UserID or actual name of a person may be used, depending on DAAC policy 
(if applicable). 

4 Type the priority for the PR in the Priority field. 
• Remember that the job Priority field specifies the priority of the job with 1 (one) as 

the highest priority and 99 the lowest priority. 
5 Click on the PGE... button. 

• The PGE Selection GUI (Figure 17) is displayed. 
6 Select the desired PGE from the list by clicking on the appropriate row in the table. 

• The PGE list is scrollable. (If there are items on the list in addition to those currently 
visible in the window, the additional items can be viewed by clicking on the arrows 
associated with the scrollbars.) 

7• Click on the OK button. 
• The PR Edit GUI page (Figure 16) is displayed. 
• The following fields are automatically fille d in: 

− Satellite  Name. 

− Instrument Name. 

− PGE Name. 

− PGE Version. 

− Profile ID. 
8• Click on the PGE Parameters… button. 

• The PGE Parameter Mappings GUI page (Figure 18) is displayed. 
• The PGE Parameter Mappings GUI has a table that lists the following information: 

− Parameter Name. 

− Logical Id. 

− Default Value. 
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Figure 17. PGE Select ion GU I 
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Figure 18. PGE Parameter Mappings GUI 
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− Overri de Value. 
− Descr iption. 

•	 The PGE parameters (if any) listed in the table are the parameters relevant to the 
particular PGE. (Different PGEs may have different parameters.) The parameters 
and their default values are defined during the Science Software Integration and Test 
(SSI&T) process. They are included with the PGE information stored in the PDPS 
database. The Production Request Editor retrieves the parameter information from 
the database. 

9 If any PGE parameter(s) should be changed, first select (highlight) a parameter to be 
changed by clicking on the corresponding row in the list of parameters. 
• The parameter row is highlighted. 
• If you do not change the parameters, the values in the Default column will be used. 
• The SCF will provide notification if PGE parameters other than the default values 

should be used. 
• The PGE parameter mappings list is scrollable. 

10 If any PGE parameter needs to be changed, type the desired value in the Parameter 
Mapping field then press the Return/Enter key on the keyboard. 
• The value in the Overri de Value column is updated. 
• If any other parameter is to be changed, highlight it and type the desired value in the 

Parameter Mapping field then press the Return/Enter key. 
11 Click on the OK button at the bottom left of the PGE Selection window to approve the 

changes and dismiss the window. 
• The Production Request - PR Edit GUI (Figure 16) is displayed. 

12 If the PGE is subject to a metadata-based production rule and the value(s) to be checked 
need(s) to be changed, click on the Metadata Checks… button. 
• If the Metadata Checks… button has been selected, perform Steps 13 through 17 as 

applicable; otherwise go to Step 18. 
• The MetadataChecks GUI page (Figure 19) is displayed. 
• The MetadataChecks GUI has an Input DataType window that lists input data 

types. 
•	 In addition, the MetadataChecks GUI has a metadata checks (MetaDataField-

Operator-Value-Type) window in which there is a table that lists the following 
information concerning each metadata check: 

− MetaDataField. 

56 625-CD-006-002




Figure 19. MetadataChecks GU I 
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− Operator. 
− Value. 
− Type. 

•	 Initial values for metadata checks are entered during SSI&T; however, it is possible to 
modify the values using the MetadataChecks GUI when creating a production 
request. 

13 If it is necessary to change any value(s) for metadata checks, first select (highlight) an 
input data type with a value to be changed by clicking on the corresponding row in the 
Input DataType window. 
• The input data type row is highlighted. 
• The metadata check information for the highlighted input data type is displayed in the 

MetaDataField-Operator-Value-Type window. 
14 Select (highlight) a metadata field with a comparison value to be changed by clicking on 

the corresponding row in the MetaDataField-Operator-Value-Type window. 
• The metadata field row is highlighted in the MetaDataField-Operator-Value-Type 

window. 
• The identity of the metadata field is displayed in the MetaDataField window. 

15 Type the new value for the metadata check in the Value field. 
16 Click on the appropriate button from the following selections: 

• OK - to approve the new value and dismiss the MetadataChecks GUI. 
− The Production Request - PR Edit GUI (Figure 16) is displayed. 
− Go to Step 18. 

• Apply - to approve the new value without dismissing the MetadataChecks GUI. 
− Go to Step 17. 

• Cancel - to return to the Production Request - PR Edit GUI without saving the new 
value. 

− The Production Request - PR Edit GUI (Figure 16) is displayed. 
− Go to Step 18. 

17	 If any additional value(s) to be checked need to be changed, repeat Steps 13 through 16 as 
necessary. 

18 If the PGE is subject to the Alternate Inputs Production Rule and the timer settings or the 
order of alternate inputs need to be changed, click on the Alternate Input  Values… 
button. 
• If the Alternate Input  Values…  button has been selected, perform Steps 19 through 

24 as applicable; otherwise go to Step 25. 
• The AlternateInputValues GUI page (Figure 20) is displayed. 
• The AlternateInputValues GUI has an Al ternateListName window that lists the 

applicable alternate inputs. 
• In addition, the AlternateInputValues GUI has an alternate input (Order-

DataType-LogicalID-Timer) window in which there is a table that lists the 
following information concerning each alternate input: 

− Order. 
− DataType. 
− LogicalID. 
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− Timer. 
•	 The initial set-up for alternate inputs is entered during SSI&T; however, it is possible 

to modify the set-up using the AlternateInputValues GUI when creating a 
production request. 

19	 If it is necessary to change timer settings or the order of alternate inputs, first select 
(highlight) an alternate input to be changed by clicking on the corresponding row in the 
Al ternateListName window. 
• The alternate input row is highlighted. 
• Information concerning the highlighted alternate input is displayed in the Order-

DataType-LogicalID-Timer window. 
20	 Select (highlight) an alternate input with timer settings or the order of alternate inputs to 

be changed by clicking on the corresponding row in the Order-DataType-LogicalID-
Timer  window. 
• The alternate input row is highlighted in the Order-DataType-LogicalID-Timer 

window. 
• The data type of the alternate input is displayed in the DataType field. 

21	 If it is necessary to change the order of alternate inputs, click on the up/down arrow 
buttons adjacent to the Order-DataType-LogicalID-Timer window as necessary until 
the highlighted alternate input has the proper order listed in the Order  column of the 
window.

• If necessary, repeat Steps 20 and 21 to change the order of additional alternate inputs.
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Figure 20. AlternateInputValues GUI 
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22	 If the timer setting for an alternate input is to be modified, verify that the alternate input 
with the timer setting to be changed has been highlighted then type the new timer setting 
in the Timer  fields. 
•	 Another method of changing timer settings (other than typing the numbers) is to click 

in each of the timer fields in turn and click on the up/down buttons adjacent to the 
Timer  fields until the correct time is indicated. 

23	 Click on the appropriate button from the following selections: 
• OK - to approve the new alternate input setting(s) and dismiss the 

AlternateInputValues GUI. 
− The Production Request - PR Edit GUI (Figure 16) is displayed. 
− Go to Step 25. 

• Apply - to approve the new alternate input setting(s) without dismissing the 
AlternateInputValues GUI. 

− Go to Step 24. 
• Cancel - to return to the Production Request - PR Edit GUI without saving the new 

alternate input setting(s). 
− The Production Request - PR Edit GUI (Figure 16) is displayed. 
− Go to Step 25. 

24 If any additional alternate input setting(s) need to be changed, repeat Steps 19 through 22 
as necessary. 

25 Click on either the Collection Time or Insertion Time button (as applicable) if data are 
to be processed on the basis of time (rather than orbit or tile). 
• Normally the Collection Time (time when the data were collected by the instrument 

on the satellite) is used for specifying what data are to be processed. 
•	 The Insertion Time option is available primarily for ASTER processing to allow the 

generation of DPRs for all data contained on an ASTER tape received from the 
ASTER Ground Data System (GDS). 

26	 Click either on the UTC Time (Coordinated Universal Time) button, on the Orbit 
button, or in the Tile Id  field depending on whether data to be processed is specified by 
time, orbit or tile. 
• If UTC Time is selected, perform Steps 27 and 28. 
• If Tile Id  is selected go to Step 29. 
• If Orbit  is selected go to Step 30. 

27	 Type the desired data start date and time (in MM/DD/YYYY hh:mm:ss format) in the 
Begin fields. 
• As data are typed in each field the cursor automatically advances to the next field. 
• Another method of entering date and time (other than typing the numbers) is to click 

in each of the date/time fields in turn and click on the up/down buttons adjacent to the 
date/time fields until the correct date/time is indicated. 

28 Type the desired data end date and time (in MM/DD/YYYY hh:mm:ss format) in the End 
fields. 
• Go to Step 32. 

29 If the Tiling Production Rule applies, type the tile identification in the Tile Id  field. 
• Go to Step 32. 
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30 If the Orbital Processing Production Rule applies, type the number of the first orbit of 
data to be processed in the From field. 

31 If the Orbital Processing Production Rule applies, type the number of the last orbit of data 
to be processed in the To field. 

32	 If the Intermittent Activation Production Rule applies, type the number of DPRs to skip 
in the Skip field. 
• If the Intermittent Activation Production Rule applies, perform Steps 33 and 34. 
• If the Intermittent Activation Production Rule does not apply, go to Step 35. 

33 Type the number of DPRs to keep in the Keep field. 
34 If the first DPR is to be skipped, click on the SkipFir st button. 
35 Type any relevant comments in the Comments field. 
36 Select Save As from the File pull-down menu (File → Save As). 

• The File Selection window (Figure 21) is displayed. 
37 Type a file name for the production request in the Selection field. 
38 Click on the OK button to save the production request. 

• The production request is saved and the corresponding DPR(s) is/are generated. 
• The PR Name and Origination Date fields are automatically updated. 

39 Select File → New to clear the entries on the Production Request Editor GUI. 
• Return to Step 2 to create another new PR. 

40 To exit from the Production Request Editor GUI select File → Exit from the pull-down 
menu. 
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Figure 21. Production Request Editor File Selection Window 

It is also possible to create a new PR by editing or modifying an existing PR and renaming it. 
This is particularly quick and useful if there are only minor differences between the existing PR 
and the new one. 

Edi ting or  Modi fyi ng a Pr oducti on Request 
This section explains how to edit or modify a Production Request. 

Before you make any changes to a PR, you must know what needs to be changed. You can 
change any of the following attributes of the PR (depending on the production rules that apply to 
the PGE): 

• Name of the PR (creates a new PR). 
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• PR type.

• Priority of the PR.

• PGE to be used in processing the PR.

• PGE (run-time) parameters to be used.

• Metadata check values.

• Alternate input order and/or timer setting.

• Start Date.

• Start Time.

• End Date.

• End Time.

• Orbit.

• Tile ID.

• Intermittent DPRs to keep/skip.

• Comments if applicable.


To edit/modify a new Production Request, execute the procedure steps that follow. Perform only 
those steps of the procedure that are applicable to the changes you want to make. You do not 
have to go through all of the fields in the PR to successfully modify it. However, you must save 
the modified PR (Steps 38 - 40) to make the changes effective. 

The procedure for editing/modifying a production request starts with the assumption that all 
applicable servers and the Production Request Editor GUI are currently running and the 
Production Request Editor Introductory GUI (Figure 15) is being displayed. 

Editing/Modifying a Production Request 

1	 Select the Production Request Editor by clicking (single click) on the PR Edit tab. 
• The PR Edit GUI page (Figure 16) is displayed. 

2	 Select File → Open from the pull-down menu to display a list of Production Requests 
from which to select the PR to be edited/modified. 
• The File Selection window (Figure 21) is displayed. 

3	 Select (highlight) the PR to be edited/modified by clicking on the corresponding PR 
name in the list of PRs. 
• The selected PR is displayed in the Selection field. 

4 Click on the OK button. 
5 If the type of production request shown on the PR Type option button is not the desired 

type, click and hold the PR Type option button to display a menu of types of production 
requests, move the mouse cursor to the desired selection (highlighting it), then release the 
mouse button. 
• The following production request types are available: 

− Routine. 
− On-Demand [not currently available for selection]. 
− Reprocessing. 
− Ad-hoc Reprocessing. 
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NOTE:	 The PR Name and Origination Date fields will be filled automatically when the 
Production Request is saved at the end of the procedure. (You do not need to fill 
in these fields.) 

6	 If the identification of the person editing/modifying the production request is not already 
displayed in the Originator  field, type it there. 

•	 Either UserID or actual name of a person may be used, depending on DAAC policy 
(if applicable). 

7 If the PR’s priority is to be changed, type the new priority in the Priority field. 
• Remember that the job Priority field specifies the priority of the job with 1 (one) as 

the highest priority and 99 the lowest priority. 
8	 If the PGE is to be changed, click on the PGE... button. 

• The PGE Selection GUI (Figure 17) is displayed. 
• Perform Steps 9 and 10 to designate the new PGE. 

9 Select the desired PGE by clicking on the appropriate row in the table. 
10	 Click on the OK button. 

• The Production Request - PR Edit GUI page (Figure 16) is displayed. 
• The following fields are automatically fille d: 

 Satellite  Name. 
 Instrument Name. 
 PGE Name. 
 PGE Version. 
− Profile ID. 

11	 If any PGE parameter(s) should be changed, click on the PGE Parameters... button. 
• The PGE Parameter Mappings GUI (Figure 18) is displayed. 
• The SCF will provide notification if PGE parameters other than the default values 

should be used. 
• Perform Steps 12 through 14 to designate the new PGE parameter(s). 

12	 Select (highlight) a parameter to be changed by clicking on the corresponding row in the 
list of parameters. 
• The parameter row is highlighted. 
• If you do not change the parameters, the values in the Default column will be used. 

13 Type the desired value in the Parameter Mapping field then press the Return/Enter 
key on the keyboard. 
• The value in the Overri de Value column is updated. 
• If any other parameter is to be changed, highlight it and type the desired value in the 

Parameter Mapping field then press the Return/Enter key. 
14 Click on the OK button at the bottom left of the PGE Selection window to approve the 

changes and dismiss the window. 
• The Production Request - PR Edit GUI (Figure 16) is displayed. 

15 If any metadata check value needs to be changed, click on the Metadata Checks… 
button. 
• The MetadataChecks GUI page (Figure 19) is displayed. 
• Perform Steps 16 through 20 to change the metadata check value(s). 
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16	 Select (highlight) an input data type with a value to be changed by clicking on the 
corresponding row in the Input DataType window. 
• The input data type row is highlighted. 
• The metadata check information for the highlighted input data type is displayed in the 

MetaDataField-Operator-Value-Type window. 
17	 Select (highlight) a metadata field with a comparison value to be changed by clicking on 

the corresponding row in the MetaDataField-Operator-Value-Type window. 
• The metadata field row is highlighted in the MetaDataField-Operator-Value-Type 

window. 
• The identity of the metadata field is displayed in the MetaDataField window. 

18 Type the new value for the metadata check in the Value field. 
19 Click on the appropriate button from the following selections: 

• OK - to approve the new value and dismiss the MetadataChecks GUI. 
− The Production Request - PR Edit GUI (Figure 16) is displayed. 

• Apply - to approve the new value without dismissing the MetadataChecks GUI. 
• Cancel - to return to the Production Request - PR Edit GUI without saving the new 

value. 
− The Production Request - PR Edit GUI (Figure 16) is displayed. 

20 Repeat Steps 18 through 19 as necessary to change any additional value(s) to be checked. 
21 If any alternate input timer settings or the order of alternate inputs should be changed, 

click on the Alternate Input  Values… button.

• The AlternateInputValues GUI page (Figure 20) is displayed.

• Perform Steps 22 through 27 as applicable to change alternate input timer settings or


the order of alternate inputs. 
22	 Select (highlight) an alternate input to be changed by clicking on the corresponding row 

in the Al ternateListName window. 
• The alternate input row is highlighted. 
• Information concerning the highlighted alternate input is displayed in the Order-

DataType-LogicalID-Timer window. 
23	 Select (highlight) an alternate input with timer settings or the order of alternate inputs to 

be changed by clicking on the corresponding row in the Order-DataType-LogicalID-
Timer  window. 
• The alternate input row is highlighted in the Order-DataType-LogicalID-Timer 

window. 
• The data type of the alternate input is displayed in the DataType field. 

24	 To change the order of alternate inputs click on the up/down arrow buttons adjacent to the 
Order-DataType-LogicalID-Timer window as necessary until the highlighted alternate 
input has the proper order listed in the Order  column of the window. 
• Repeat Steps 23 and 24 as necessary to change the order of additional alternate inputs. 

25	 To modify the timer setting for an alternate input verify that the alternate input with the 
timer setting to be changed has been highlighted then type the new timer setting in the 
Timer  fields. 
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26 Click on the appropriate button from the following selections: 
• OK - to approve the new alternate input setting(s) and dismiss the 

AlternateInputValues GUI. 
− The Production Request - PR Edit GUI (Figure 16) is displayed. 

• Apply - to approve the new alternate input setting(s) without dismissing the 
AlternateInputValues GUI. 

• Cancel - to return to the Production Request - PR Edit GUI without saving the new 
alternate input setting(s). 

− The Production Request - PR Edit GUI (Figure 16) is displayed. 
27 Repeat Steps 22 through 26 as necessary to change any additional alternate input 

setting(s). 
28	 If UTC Time is to be changed, first click on either the Collection Time or Insertion 

Time button (as applicable). 
• Normally the Collection Time (time when the data were collected by the instrument 

on the satellite) is used for specifying what data are to be processed. 
• The Insertion Time option is available primarily for ASTER processing to allow the 

generation of DPRs for all data contained on an ASTER tape received from the 
ASTER Ground Data System (GDS). 

29 If UTC Time is to be changed, type the desired data start date and time (in 
MM/DD/YYYY hh:mm:ss format) in the Begin fields. 

30 If UTC Time is to be changed, type the desired data end date and time (in 
MM/DD/YYYY hh:mm:ss format) in the End fields. 

31 If the Tile ID is to be changed, type the tile identification in the Tile Id  field. 
32 If the start of the Orbit range is to be changed, type the number of the first orbit of data to 

be processed in the [Orb it] From field. 
33 If the end of the Orbit range is to be changed, type the number of the last orbit of data to 

be processed in the [Orb it] To field. 
34 If the number of DPRs to be skipped is to be changed, type the number of DPRs to skip 

in the Skip field. 
35 If the number of DPRs to be kept is to be changed, type the number of DPRs to keep in 

the Keep field. 
36 If the state of the SkipFir st button is to be changed, click on the SkipFir st button. 
37 Type any relevant comments in the Comments field. 
38 Select Save As from the File pull-down menu (File → Save As). 

• The File Selection window (Figure 21) is displayed. 
39 Type a file name for the production request in the Selection field. 
40 Click on the OK button to save the production request. 

• The Production Request is saved and the corresponding DPR(s) is/are generated. 
• The PR Name and Origination Date fields are automatically updated. 

41 Select File → New to clear the entries on the Production Request Editor GUI. 
• Return to Step 1 to modify another new PR. 

42 Select File → Exit to quit the Production Request Editor GUI. 
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Deleting a Pr oducti on Request 
To delete a Production Request, execute the procedural steps that follow. The procedure starts 
with the assumption that all applicable servers are currently running and the Production 
Request Editor Introductory GUI (Figure 15) is being displayed. 

Deleting a Production Request 

1 Select the list of Production Requests by clicking on the PR List tab. 
• The PR List GUI page (Figure 22) is displayed. 
• A list of Production Requests is displayed. 

2 Click on the Production Request to be deleted. 
• The Production Request to be deleted is highlighted. 

3 Select Edit→Delete. 
• A dialog box is displayed requesting confirmation of the decision to delete the 

Production Request. 
4 Select OK to delete the Production Request. 

• A confirmation notice is displayed after completion of deletion. 
5 Select File → Exit to quit the Production Request Editor GUI. 
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Figure 22. PR List GUI 
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Reviewing/Deleting Data Processing Requests


Data Processing Requests 
Data Processing Requests (DPRs) are generated automatically by the Planning Subsystem. 

•	 DPR is generated automatically from… 
 a PR (which specifies a PGE). 
 information on the PGE acquired during the Science Software Integration and 

Test (SSI&T) process. 
• DPRs are complex, reflecting the complexity of the PGEs. 
•	 DPRs contain information that is used by the Data Processing Subsystem and the 

AutoSys production scheduling software. 

The Production Planner can review DPRs. 

• DPRs may provide useful information. 
•	 DPR fields cannot be edited by Operations personnel. 

 Modifications to DPR information would have undesirable side-effects. 

Displaying DPR Information 
The Production Request Editor can display DPR information in two ways: 

• DPR List. 
• Data concerning an individual DPR. 

The following characteristics pertain to the DPR List: 

•	 The DPR list is filtered, so that only DPRs associated with a particular PR are 
displayed. 

•	 Each line of the DPR List display represents a DPR, i.e., a job that will be run when 
all data and resource needs have been satisfied. 

•	 For each DPR the list includes the DPR identification, relevant PGE, name of the 
corresponding PR, data start date and time, etc. 

71 625-CD-006-002




The Production Planner can select a particular DPR and obtain data on that DPR, including the 
following characteristics: 

• PGE parameters 
	 displayed in the same format as the PGE Parameter Mappings GUI 

(Figure 18) used in creating a PR. 
• PGE File Mappings (UR File Mappings) 

 displays the input and output files for a particular DPR on the UR File 
Mappings GUI (Figure 23) 

 GUI displays one line of information for each file that may be used by or be 
produced by the PGE, including the following data: 

⋅ Logical ID - The identification (ID) or tag used within the PGE to access the 
file. 

⋅ Granule ID - The reference used to identify the granule uniquely. 
⋅ Start/Stop Time - The start and stop date and time for the data contained in 

this file. 
⋅ Availability - Data and time when the data file is expected to be accessible for 

use in processing. 
⋅ UR (Universal Reference) - The uniform reference for each object associated 

with Science Data Processing (SDP) that allows each SDP service to 
understand and support the object. 

The procedure for reviewing data processing requests starts with the assumption that all 
applicable servers and the Production Request Editor GUI are currently running and the 
Production Request Editor Introductory GUI (Figure 15) is being displayed. 

Reviewing Data Processing Requests 

Select the Data Processing Request List by clicking on the DPR List tab. 
• The DPR List GUI page (Figure 24) is displayed. 
•	 The table shown on the GUI provides the following information on the DPRs: 

 DPR Id - identification (name) of the DPR. 
 PGE Id - identification of the PGE specified in the DPR. 
 PR Name - name of the PR that led to the creation of the DPR. 
 Data Start T ime - DPR’s start date and time. 
 Data Stop Time - DPR’s stop date and time. 
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Figure 23. UR File Mappings GUI 
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Figure 24. DPR List GUI 
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2	 To list the DPRs associated with a particular Production Request, first click on the option 
button associated with the Production Request field. 
• An option menu of Production Requests is displayed. 

3 Highlight the desired PR in the option menu then click on the Filter  button. 
• The DPRs for the specified PR only are shown in the DPR List. 
•	 An alternative method of filtering PRs is to type the name of the PR in the 

Production Request field then click on the Filter  button. 
4	 Identify a DPR to be reviewed from those shown in the list of Data Processing Requests, 

then click on the DPR View tab. 
• The DPR View GUI (Figure 25) is displayed. 

5 Select File → Open from the pull-down menu. 
• The DPR File Selection window (Figure 26) is displayed. 
• The Data Processing Requests associated with the selected PR are listed. 

6	 Select (highlight) the DPR to be reviewed by clicking on the corresponding DPR name in 
the list of DPRs. 

7 Click on the OK button. 
•	 The DPR View GUI shows the following information concerning the selected DPR: 

 DPR Name. 
 PR Name. 
 Origination Date 
 Originator 
 PGE Id. 
 Data Start T ime. 
 Data Stop Time. 
 Predicted Start Date. 
 Predicted Start T ime. 
 Actual Start Date. 
 Actual Start T ime. 
 Priority. 
 Status. 
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Figure 25. DPR View GUI•
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Figure 26. DPR File Selection Window 

8 To obtain information concerning the PGE parameters (of the PGE associated with the 
DPR), click on the PGE Parameters... button. 
• The PGE Parameters GUI (same format as Figure 18 except there is no Parameter 

Mapping field) is displayed. 
9	 When finished reviewing the PGE parameters, click on the OK button to return to the 

DPR View GUI. 
• The DPR View GUI (Figure 25) is displayed. 

10 Click on the PGE File Mappings... button. 
• The UR File Mappings GUI (Figure 23) is displayed. 
• The UR File Mappings GUI displays one line of information for each file that may 

be used by or be produced by the PGE associated with the selected DPR: 
 Logical Id. 
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 Granule Id 
 Start T ime (date and time). 
 Stop Time (date and time). 
 Availability  (date and time). 
 UR (universal reference). 

• The PGE’s input data and output data are displayed in separate areas. 
11	 When finished reviewing the UR File Mappings, click on the OK button to return to the 

DPR View GUI. 
• The DPR View GUI is displayed. 

12 Review the Data Start T ime and Data Stop Time. 
13 Review the Request Data and Status area of the GUI. 

•	 The DPR View GUI displays the following information concerning the selected DPR: 
 Predicted Start Date and Time. 
 Actual Start Date and Time. 
 Priority. 
 Status. 

• Predicted Start Date/Time and Actual Start Date/Time are displayed only if the 
Production Request has been scheduled. 

14 When finished reviewing information concerning the DPR, repeat Steps 1 through 13 to 
review additional DPRs. 

15 Select File → Exit to quit the Production Request Editor GUI. 
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Deleting a Data Processing Request 
To delete a DPR, execute the procedure steps that follow. The procedure starts with the 
assumption that all applicable servers are currently running and the Production Request Editor 
Introductory GUI (Figure 15) is being displayed. 

Deleting a Data Processing Request 

Select the DPR List by clicking on the DPR List tab. 
• The DPR List GUI page (Figure 24) is displayed. 
Click on the Production Request option button. 
• A list of Processing Requests is displayed.

Click on the Production Request with which the DPR to be deleted is associated.

• The Production Request is displayed in the Production Request field. 
Click on the Filter  button. 
• A list of the DPRs associated with the selected Production Request is displayed. 
Click on the DPR to be deleted. 
• The DPR to be deleted is highlighted. 
Select Edit→Delete. 
• A dialog box is displayed requesting confirmation of the decision to delete the DPR. 
Select OK to delete the DPR. 
• A confirmation notice is displayed after completion of deletion. 
Select File → Exit to quit the Production Request Editor GUI. 
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Submitting or Withdrawing a Subscription


Submi tti ng or  Withdr awing a Subscr iption Usi ng the Subscr iption 
Editor 
The Subscription Editor is a character-based user interface that may be used to either submit or 
withdraw subscriptions for notification of data arrival (i.e., insertion of data into the archive) or 
other subscribable system events. 

•	 Subscriptions may be submitted on behalf of a general user or on behalf of the 
Planning Subsystem (i.e., the PLS Subscription Manager). 

•	 An advantage of the character-based Subscription Editor over the Subscription GUI is 
the ability to submit subscriptions without being a registered user of ECS. 

Submitting or withdrawing a subscription using the Subscription Editor starts with the 
assumption that the applicable servers are running and the Production Planner has logged in to 
the ECS system. 

Submit ting or Withdrawing a Subscr iption Using the Subscr iption Editor 

NOTE: Commands in Steps 1 through 8 are typed at a UNIX system prompt. 
1 At the UNIX command line prompt type xhost hostname then press the Return/Enter 

key on the keyboard. 
•	 hostname refers to the host on which GUIs are to be launched during the current 

operating session. Multiple hostnames can be specified on the same line. 
• The use of xhost + is discouraged because of a potential security problem. 

2 Open another UNIX (terminal) window. 
3 Start the log-in to the Planning/Management Workstation by typing /tools/bin/ssh 

hostname (e.g., e0pls03, g0pls01, l0pls02, or n0pls02) in the new window then press the 
Return/Enter key. 
•	 If you receive the message, Host key not found from the list of known hosts. Are 

you sure you want to continue connecting (yes/no)? type yes (“y”  alone will not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 4. 

• If you have not previously set up a secure shell passphrase; go to Step 5. 
4	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 6. 

5 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

6 Type setenv ECS_HOME /usr/ecs/ then press the Return/Enter key. 
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• When logging in as a system user (e.g,, cmshared), the ECS_HOME variable may be 
set automatically so it may not be necessary to perform this step. 

7 Type cd /usr/ecs/MODE/CUSTOM/utilitie s then press Return/Enter. 
•	 Change directory to the directory containing the production planning startup scripts 

(e.g., EcPlSubsEditStart). 
8	 Type EcPlSubsEditStart MODE ApplicationID  then press Return/Enter to launch 

the Subscription Editor. 
• The following message is displayed: 

−	 This program may be used to submit  subscr iptions for 
notification of data arrivals, on behalf of a general 
user, or on behalf of the PDPS production system (i.e. 
the PLS Subscr iption Manager) 
Would you like to view the complete list of ESDTs known to PDPS? (y/n): 

9 Type either y or n (as appropriate) then press Return/Enter. 
• Either lower-case or upper-case letters may be typed. 
• If y was typed, a message similar to the following message is displayed: 

−	 AP#0 Subscr iption Flag: 1 
DAP#0 Subscr iption Flag: 1 
FAILPGE#0 Subscr iption Flag: 1 
MOD00#0 Subscr iption Flag: 0 
MOD01#0 Subscr iption Flag: 0 
MOD021KM#0 Subscr iption Flag: 0 
MOD02LUT#0 Subscr iption Flag: 0 
MOD03#0 Subscr iption Flag: 0 
MOD03LUT#0 Subscr iption Flag: 0 
MOD29#0 Subscr iption Flag: 0 
PGEEXE#0 Subscr iption Flag: 1 
PH#0 Subscr iption Flag: 1 
SSAPC#0 Subscr iption Flag: 1 
Is recipient PLS Subscription Manager (Y/N): 

• If n was typed, the following message is displayed: 
− Is recipient PLS Subscription Manager (Y/N): 

10 Type either y or n (as appropriate) then press Return/Enter. 
•	 If y was typed, the following message is displayed: 

− Enter ESDT data type name (as appears in the PDPS database): 
• If y was typed, skip Steps 11 and 12, and go to Step 13. 
• If n was typed, the following message is displayed: 

− Enter user id: 
11	 In response to the “Enter user id” message type the appropriate UserID then press 

Return/Enter. 
• The following message is displayed: 

− Enter email address (for subscription notification): 
12	 In response to the “Enter email address…” message type the appropriate e-mail address 

then press Return/Enter. 

82 625-CD-006-002




• The following message is displayed: 
− Enter ESDT data type name (as appears in the PDPS database): 

13 Type the ESDT data type name (e.g., FAILPGE#0) then press Return/Enter. 
• The following message is displayed: 

− Overri de the provider [SYSTEM] defined for th is ESDT (Y/N) 
14 Type either Y or N (as appropriate) then press Return/Enter. 

• The following message is displayed: 
− Submit (S)/Wit hdraw(W) : 

15 Type either S or W (as appropriate) then press Return/Enter. 
• If S was typed, the following message is displayed: 

−	 Specify the Internal Service Name 
Enter 'd'  for default In sert Event service 

• If W was typed, the following message is displayed: 
− Specify the Internal Service Name 

16 Type either internal service name or d (as appropriate) then press Return/Enter. 
• A message similar to the following message is displayed: 

−	 Client Path: /.:/subsys/ecs/TS2/EcIoAdServer 
client: server binding is 03b894b0-c7e6-11d1-a691­
9b9d7b23aa77@ncacn_ip_tcp:155. 
157.123.35[58765] 
Client Path: /.:/subsys/ecs/TS2/EcIoAdServer 
client: server binding is 03b894b0-c7e6-11d1-a691­
9b9d7b23aa77@ncacn_ip_tcp:155. 
157.123.35[58764] 
Client Path: /.:/subsys/ecs/TS2/EcSbSubServer 
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Launching Planning Workbench-Related GUIs


Launching Planning Workbench-Related GUIs 
The following software applications are associated with the Planning Workbench: 

• Subscription Manager. 
• System Name Server. 
• Message Handler. 
• Resource Model. 
• Planning Workbench. 
• Production Timeline. 
• Production Strategies. 

Eventually the ECS desktop will be configured to allow access to GUIs related to the Planning 
Workbench using the icon shown in Figure 27. In the interim, access to the Planning Workbench 
GUIs must be gained through the use of UNIX commands. 

Figure 27. Planning Workbench Icon 

In any case, launching Planning Workbench-related GUIs starts with the assumption that the 
applicable servers are running and the Production Planner has logged in to the ECS system. 

Launching Planning Workbench-Related GUIs 

NOTE: Commands in Steps 1 through 9 are typed at a UNIX system prompt. 
1	 At the UNIX command line prompt type xhost hostname then press the Return/Enter 

key on the keyboard. 
• hostname refers to the host on which GUIs are to be launched during the current 

operating session. Multiple hostnames can be specified on the same line. 
• The use of xhost + is discouraged because of a potential security problem. 

2 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
• Use either the X terminal/workstation IP address or the machine-name for the 

clientname. 
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•	 When using secure shell, the DISPLAY variable is set just once, before logging in to 
remote hosts. If it were to be reset after logging in to a remote host, the security 
features would be compromised. 

3 Open another UNIX (terminal) window. 
4	 Start the log-in to the Planning/Management Workstation by typing /tools/bin/ssh 

hostname (e.g., e0pls03, g0pls01, l0pls02, or n0pls02) in the new window then press the 
Return/Enter key. 
• If you receive the message, Host key not found from the list of known hosts. Are 

you sure you want to continue connecting (yes/no)? type yes (“y”  alone will not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 5. 

• If you have not previously set up a secure shell passphrase; go to Step 6. 
5	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 7. 

6 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

7 Type setenv ECS_HOME /usr/ecs/  then press the Return/Enter key. 
• When logging in as a system user (e.g,, cmshared), the ECS_HOME variable may be 

set automatically so it may not be necessary to perform this step. 
8 Type cd /usr/ecs/MODE/CUSTOM/utilitie s then press Return/Enter. 

• Change directory to the directory containing the production planning startup scripts 
(e.g., EcPlPRE_IFStart). 

• The MODE will most likely be one of the following operating modes: 
 OPS (for normal operation). 
 TS1 (for SSI&T). 
 TS2 (new version checkout). 

•	 Note that the separate subdirectories under /usr/ecs apply to (describe) different 
operating modes. 

9	 Type EcPlAllStar t  MODE ApplicationID then press Return/Enter to launch the 
Message Handler, System Name Server, Resource Model, Planning Workbench GUI, 
and Production Planning Timeline GUI. 
• The Message Handler GUI (Figure 28) is displayed. 
• Eventually, the Planning Workbench GUI (Figure 29) is displayed. Then the 

Production Planning Timeline GUI (Figure 30) is displayed. 
− The Production Planning Timeline GUI usually occupies the entire screen 

when it is initially displayed. 
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Figure 28. Message H andler GU I 
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Figure 29. Planning Workbench GUI 
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Figure 30. Production Planning Timeline GUI 

•	 The Message Handler GUI displays messages of the following types: 
 Engineering. 
 Information. 
 Warning. 
 Internal. 

• The System Name Server (SNS) handles interprocess communication. 
•	 The Resource Model is an underlying resource data coordinator for the planning 

software. 
•	 The ApplicationID is any number from 1 to 5. It identifies the message service in use 

so messages can be directed to the proper message handler GUI. Consequently, it is a 
good idea to use the same ApplicationID (also called MSGSRV_ID) consistently 
during a planning session. 
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10	 Either click on the “minimize” icon in the upper right corner of the Production Planning 
Timeline GUI or adjust the window size and the view of the timeline as necessary using 
the mouse. 

•	 Grab a corner of the timeline window with the cursor and resize the window as 
desired. 

11 Open another UNIX window (if desired). 
• It may be desirable to open the new UNIX window on another desktop if available. 

12 Perform Steps 3 through 11 in the new UNIX window (if applicable). 
13 Type EcPlProdStratStart MODE ApplicationID then press Return/Enter to launch 

the Production Strategies GUI. 
• The Production Strategies GUI (Figure 31) is displayed. 
•	 It is possible to start the Production Strategies GUI without first starting the 

Planning Workbench applications by skipping Steps 9 through 12. 

Figure 31. Production Strategies GUI 
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Creating a New Production Plan

Production Plan
The Production Planner uses the Planning Workbench when creating a plan for production data
processing at the DAAC.  means by which the Production
Planner selects specific PRs whose DPRs are to be run.  
the start and completion times of the jobs based upon historical experience in running these
PGEs.  Through the planning tool, when the generated plan is “activated,” the information
included in the plan is transferred to the Data Processing Subsystem and loaded into the Platinum
AutoSys tool where production processing is managed.   32 shows the general flow of
production requests/data processing requests from the Production Request Editor through the
Planning Workbench to the AutoSys production management tool.
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Figure 32.  

The Planning Workbench provides the 
The planning tool provides a forecast of

Figure

Planning Workbench Flow



The planning process involves the Production Planner preparing monthly and weekly production 
plans as well as a daily production schedule from the most current weekly plan. Although 
production planning varies from DAAC to DAAC, the following guidelines are generally 
applicable: 

•	 Monthly plans 
 developed for the coming month and one or two months in advance. 
 produced, reviewed, updated, published and distributed approximately two 

weeks before the beginning of the month. 
 plan for the coming month is used to establish a baseline against which 

production targets can be measured. 
• Weekly plans 

 produced, reviewed, updated, published and distributed approximately five days 
before the beginning of the coming week. 

	 used to produce a baseline for comparison of planned vs. actual production 
results. 

•	 Daily plan or schedule 
 produced each day for the next processing day. 
 developed from the current weekly plan, adjusted to reflect the actual processing 

accomplished and the actual resources available at the time the daily schedule is 
generated. 

During normal processing, when reasonably accurate predictions of the processing time for the 
PGEs are available, the processing schedule should result in a reasonably accurate prediction of 
when data products will be generated. However, during abnormal situations (e.g., equipment 
failure), what is actually accomplished could depart significantly from the plan. In such 
situations, the Production Planner may choose to develop new plans to reflect current events. 
This process is known as “replanning.” 

Production Strategy 
A Production Strategy is a high-level plan that the Production Planner prepares to notify the 
Planning Workbench of the rules for priorities and preferences in the processing of DPRs. 
Production Strategies work on two levels. First, the Production Planner can update lists of DPR 
attributes so that each value an attribute can have is tied to a particular priority. For example, the 
DPR attribute “PR Type” has three values that may have their default priority of 2 changed as 
follows (on a scale of 1 to 10): 

• Routine 6 
• On-Demand 10 
• Reprocessing 4 

Next, the operator can change the weight that each attribute's priority is given. For example, 
weights (from 1 to 100) might be assigned to the DPR attributes as follows: 

• PR Type 45 
• User Type 15 
• PGE Type 20 
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A weight is also given to the priority specified when the user (Production Planner) created the 
Production Request as shown in the following example: 

• User Selected 20 

The total weights assigned to PR Type, User Type, PGE Type and User Selected must equal 100. 
Using this data the Planning Workbench calculates a priority for each DPR in a Production Plan. 
Figure 33 provides an illustration of how priority is calculated for a DPR. 

Finally, there are deltas that can be added to the calculated priority based on two types of 
conditions. Specifically, a Production Planner may choose to increase the priority of all jobs that 
produce data needed by other DAACs (the Inter-DAAC Delta) or that have been waiting in the 
Production Queue for more than a day (the Late Start Delta). 

Defining a Production Strategy 

The Production Planner uses the Production Strategies GUI to develop Production Strategies. 
The procedure that follows describes how to define or modify a Production Strategy. 

The procedure for defining a production strategy starts with the assumption that all applicable 
servers are currently running and the Production Strategies GUI (Figure 31) is being displayed. 

Defining a Production Strategy 

1 If defining a new production strategy, select File → New from the pull-down menu. 
• The fields of the Production Strategies GUI (Figure 31) are reset. 

2	 If modifying an existing production strategy, first click on the option button associated 
with the Production Strategies field, then highlight (in the option menu) the name of the 
production strategy to be modified. 
•	 Data pertaining to the selected production strategy are displayed in the applicable 

fields of the Production Strategies GUI (Figure 31). 
•	 Alternatively, it is possible to select File → Open from the pull-down menu, select 

the desired production strategy from the list on the Open window, and click on the 
Ok button to open the production strategy. 
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DPR id:
   MOD09:L2G_060199_14_1234
User Type:
   Scientist
PGE:
   MOD09:L2G
Routine request
Tile 14
Cluster id: 4
User-selected Weight: 7

Prio rity  = 6 * .45 + 
  3 * .20 +
  8 * .15 +
  7 * .20
= 5.9  = 6

The oper ator can
change
any w eight  or pr ior ity on
any s trategy li st.

The oper ator can also 
change  the weight s 
given to each list  accor ding
to the DAACs current 
production pr ior it ies

On Demand   10
Routine   6
Reprocessing    4
Default    5

Weight .45

PR TYPE

MODIS 01    5
MOD09:L2G     3
MOD09:L3     6
MODIS 02    5
Default    5

Weight .20

PGE

Operator   5
DAAC Manager 7
Researcher   10
Scientis t            8
Default  5

Weight .15

USER TYPE

Weight .20

User-Selected

Figure 33.  

3 If changing the default priority for PR Type, click in the Default field below the PR
Type button and type the desired default value.
• The range for the default is from 1 to 10.

4 If changing the default priority for User Type, click in the Default field below the User
Type button and type the desired default value.

5 If changing the default priority for PGE Type, click in the Default field below the PGE
Type button and type the desired default value.

6 If defining or modifying a priority for a type of production request, first click on the PR
Type button.
• The different types of production requests are displayed in the Type List field at the

bottom left of the GUI.
7 If defining a priority for a type of production request not currently listed in the PR Type

Value-Prior ity list, click on that PR type in the Type List field.
• The PR type is highlighted.
• It is possible to highlight multiple PR types (by clicking on each one in turn) if they

are all going to be assigned the same priority.
8 If redefining or deleting a priority for a type of production request already listed in the

PR Type Value-Priority list, click on that PR type in the Value-Prior ity list.

Example of Calculating Priority for a DPR



• The PR type is highlighted. 
•	 It is possible to highlight multiple PR types (by clicking on each one in turn while 

holding down either the Shift key or the Ctrl  key) if the same action is going to be 
taken with respect to all of them. 

9	 If defining or modifying (not deleting) a priority, click on the up/down arrow buttons to 
the right of the Priority fie ld until the desired priority value is displayed in the Priority 
field. 
•	 An alternative method of entering the priority is to type the desired priority value in 

the Priority field. 
• The acceptable range for the priority is from 1 to 10. 

10 Click on the appropriate button from the following selections: 
•	 Add - to approve a priority for an additional PR type and display the selected PR type 

and priority in the PR Type Value-Priority list at the left center of the GUI. 
•	 Modify - to approve a revised priority for the selected PR type and display the PR 

type and modified priority in the PR Type Value-Priority list. 
• Delete - to delete the priority for the selected PR type and remove the PR type and 

priority from the PR Type Value-Priority list. 
11 Repeat Steps 6 through 10 as necessary until all PR Type priorities (as shown in the PR 

Type Value-Prior ity field) are correct. 
12 If defining or modifying a priority for a type of user, first click on the User Type button. 

•	 The different types of users are displayed in the Type List field at the bottom left of 
the GUI. 

13	 If defining a priority for a type of user not currently listed in the User Type 
Value-Prior ity list, click on that user type in the Type List field. 
• The user type is highlighted. 
• It is possible to highlight multiple user types (by clicking on each one in turn). 

14	 If redefining or deleting a priority for a user type already listed in the User Type 
Value-Prior ity list, click on that user type in the Value-Prior ity list. 
• The user type is highlighted. 
•	 It is possible to highlight multiple user types (by clicking on each one in turn while 

holding down either the Shift key or the Ctrl  key). 
15	 If defining or modifying (not deleting) a priority, click on the up/down arrow buttons to 

the right of the Priority fie ld until the desired priority value is displayed in the Priority 
field. 
•	 An alternative method of entering the priority is to type the desired priority value in 

the Priority field. 
• The acceptable range for the priority is from 1 to 10. 

16 Click on the appropriate button from the following selections: 
•	 Add - to approve a priority for an additional user type and display the selected user 

type and priority in the User Type Value-Priori ty list near the center of the GUI. 
•	 Modify - to approve a revised priority for the selected user type and display the user 

type and modified priority in the User Type Value-Priori ty list. 
•	 Delete - to delete the priority for the selected user type and remove the user type and 

priority from the User Type Value-Priori ty list. 
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17 Repeat Steps 12 through 16 as necessary until all user type priorities (as shown in the 
User Type Value-Priori ty field) are correct. 

18 If defining a priority for a type of PGE, first click on the PGE Type button. 
•	 The different types of PGEs are displayed in the Type List field at the bottom left of 

the GUI. 
19	 If defining a priority for a type of PGE not currently listed in the PGE Type 

Value-Prior ity list, click on that PGE type in the Type List field. 
• The PGE type is highlighted. 
• It is possible to highlight multiple PGE types (by clicking on each one in turn). 

20	 If redefining or deleting a priority for a PGE type already listed in the PGE Type 
Value-Prior ity list, click on that PGE type in the Value-Prior ity list. 
• The PGE type is highlighted. 
•	 It is possible to highlight multiple PGE types (by clicking on each one in turn while 

holding down either the Shift key or the Ctrl  key). 
21	 If defining or modifying (not deleting) a priority, click on the up/down arrow buttons to 

the right of the Priority fie ld until the desired priority value is displayed in the Priority 
field. 
•	 An alternative method of entering the priority is to type the desired priority value in 

the Priority field. 
• The acceptable range for the priority is from 1 to 10. 

22 Click on the appropriate button from the following selections: 
•	 Add - to approve a priority for an additional PGE type and display the selected PGE 

type and priority in the PGE Type Value-Prior ity list near the center of the GUI. 
•	 Modify - to approve a revised priority for the selected PGE type and display the PGE 

type and modified priority in the PGE Type Value-Prior ity list. 
• Delete - to delete the priority for the selected PGE type and remove the PGE type and 

priority from the PGE Type Value-Prior ity list. 
23 Repeat Steps 18 through 22 as necessary until all PGE type priorities (as shown in the 

PGE Type Value-Prior ity field) are correct. 
24 Click in the Weight field below the PR Type button and type the desired weight. 

• The acceptable range for weights is from 1 to 100. 
•	 The Total Weight field displays updated totals of all weighting factors as they are 

entered. 
•	 When entering weights for the PR Type, User Type, PGE Type, and User Selected 

factors, relative values can be typed in without regard to whether the values in the 
four categories add up to 100. The Normalize button provides a means of eventually 
ensuring that the total of all four categories equals 100. 

•	 The assigned weight in each category is multiplied by the priority for each type. To 
maintain a high priority (low number, such as one), assign a low weight; to ensure a 
low priority, assign a relatively high weight. 

25 Click in the Weight field below the User Type button and type the desired weight. 
26 Click in the Weight field below the PGE Type button and type the desired weight. 
27 Click in the User Selected Weight field and type the desired weight. 
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• The priority to which the user-selected weight is applied is the priority assigned using 
the Production Request Editor when a production request is created. 

28 Click on the Normalize button. 
•	 The Planning Subsystem adjusts all weighting factors to produce a total weight of 100 

(as displayed in the Total Weight field). 
29	 If it is necessary to change the priority of all jobs that produce data needed by other 

DAACs, click in the Inter DAAC Delta Priority  field and type the desired value. 
• The range for Inter-DAAC Delta Priority is from 1 to 100. 
•	 The lower the number, the higher the priority (1 is a high priority, 100 is a low 

priority). 
30	 If it is necessary to change the priority of jobs that have been waiting in the Production 

Queue for more than a day, click in the Late Start Delta Priority  field and type the 
desired value. 
• The range for the Late Start Delta Priority is from 1 to 100. 

31 Select File → Save As from the pull-down menu. 
• A Save As window similar to the File Selection windows in Figures 21 and 26 is 

displayed. 
32 Type the desired file name for the new production strategy in the Save As field. 
33 Click on the Ok button to accept the file name in the Save As field. 

• The Save As window is dismissed. 
• The production strategy is saved with the specified file name. 

34	 To exit from the Production Strategies GUI select File → Exit from the pull-down 
menu. 

Creating a New Pr oducti on Pl an 
The Production Planner creates a production plan by selecting PRs from two lists of PRs, i.e., the 
list of available “Unscheduled” PRs and the list of “Scheduled” PRs. Using arrow buttons, the 
Production Planner moves the PRs between lists until the “Scheduled” list contains the desired 
set of PRs that define the new plan. 

Before creating a new production plan the Production Planner must be prepared to provide the 
following information: 

• Name of the plan. 
• PRs to be included in the new production plan. 
• Comments (if any). 

The Production Planner uses the Planning Workbench GUI to prepare Production Plans. The 
procedure that follows describes how to create a new Production Plan. The procedure starts with 
the assumption that all applicable servers are currently running and the Planning Workbench 
GUI (Figure 29) is being displayed. 
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Creating a New Production Plan 

1	 If applicable, click on the option button associated with the Strategy field, then highlight 
the desired production strategy in the option menu. 

2	 Move PRs between the Unscheduled and Scheduled lists as necessary by selecting 
(highlighting) the PR to be moved by clicking on the PR in the list from which it is to be 
moved then clicking on the up or down arrow button (as applicable) to move the PR to 
the other list. 
• Highlighted PR disappears from one list and appears on the other. 
• The Unscheduled and Scheduled PR lists are scrollable. 
• In the Scheduled list, items with the prefix “GE_” are resource reservations (also 

called “ground events”). 
− Ground events are resource reservations for non-production-related purposes, 

including such activities as testing, preventive maintenance, or system upgrades. 
− Ground events are scheduled through the resource planning process. 

3 If the priority of any PR in the Scheduled list needs to be changed, perform Steps 4 
through 8; otherwise go to Step 9. 

4 Click on the PR entry in the Scheduled list to highlight it. 
5 Click on the Priori tize button. 

• The Prior ity popup window (Figure 34) is displayed. 
6 Type the new priority in the Production Request(s) pr iority:  field. 
7 Click on the OK button. 
8 Repeat Steps 4 through 7 for any additional PR(s) needing a change of priority. 
9 Type any relevant comments (up to 255 characters) in the Comments field. 
10 Select File → Save As from the pull-down menu. 

• The Save Plan window (Figure 35) is displayed. 
11 Type the desired file name for the new production strategy in the Plan Names field. 

12 Click on the OK button to accept the file name in the Plan Names field. 

• The Save Plan window is dismissed. 
• The production plan is saved with the specified file name. 
• The Planning Workbench GUI (Figure 29) is displayed. 
• The Plan Name is displayed. 
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Figure 34. Planning Workbench Priority Popup Window 

Figure 35. Planning W orkbench Save Plan W indow 
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• The Status displayed is Candidate. 
NOTE:	 The Planning Workbench core dumps when a plan is activated with past ground 

events. 
13 If the new plan is to be activated immediately, click on the Activate button. 

• The new plan is activated. 
•	 The time of plan activation is displayed next to Rollover Time: on the Planning 

Workbench GUI. 
14	 If the production plan is to be used as a baseline plan, perform Steps 15 through 18; 

otherwise, go to Step 19. 

15 Click on the Baseline button. 

16 Select File → Save As from the pull-down menu. 

• The Save Plan window (Figure 35) is displayed. 
17 Type the desired file name for the new production strategy in the Plan Names field. 
18 Click on the OK button to accept the file name in the Plan Names field. 

• The Save Plan window is dismissed. 

• The production plan is saved with the specified file name. 

• The Planning Workbench GUI (Figure 29) is displayed. 

• The Plan Name is displayed. 

• The Status displayed is Baseline. 
19 Repeat Steps 1 through 18 to perform additional production planning activities. 
20	 To quit the Planning Workbench GUI when production planning is complete select 

File → Exit. 
21	 After quitting the Planning Workbench GUI click in the UNIX window used to start the 

Planning Workbench GUI. 
•	 The Message Handler, System Name Server, and Resource Model should be shut 

down to eliminate unneeded processes and allow other operators to gain access to the 
Planning Workbench if necessary. 

22	 Type EcPlSlayAll  MODE ApplicationID then press Return/Enter to shut down the 
Planning Timeline, Message Handler, System Name Server, and Resource Model (and 
the Planning Workbench if it has not already been shut down). 
• The Message Handler GUI (Figure 28) disappears. 
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23	 Type ps -ef | grep MODE then press Return/Enter to obtain a list of active processes 
in the specified mode. 
• A list of active processes in the specified mode is displayed. 
•	 If an error message is received when ps -ef | grep MODE is entered, type 

ps  -auxwww | grep MODE then press Return/Enter. 
24	 Examine the list of processes running in the specified mode to determine whether the 

Message Handler, System Name Server, and Resource Model processes have actually 
been shut down. 
•	 None of the following processes should be active: 

 EcPlWb 
 EcPlTl 
 EcPlMsh 
 EcPlSns 
 EcPlRm 

25	 If any of the specified processes [especially the Message Handler, System Name Server, 
and/or Resource Model process(es)] is/are still active, type 
kill -15 process_id1 [process_id2] [process_id3] […] to terminate the active 
process(es). 

26 Repeat Steps 23 through 25 as necessary. 

Reviewing a Plan Timeline 
It is possible to display a graphic, timeline-oriented depiction of a production plan, as shown in 
Figure 30. The timeline application becomes available when the Production Planning 
Workbench is initiated. The display shows a set of processing equipment, arranged along the left 
side of the GUI, and some period of time as indicated across the top edge of the GUI. 

The execution of DPRs on the processing equipment over a period of time is represented by 
several DPR bars across the GUI for that equipment. In addition, there may be bars that 
represent resource reservations for non-production-related purposes, which are also called 
“ground events.” They are scheduled through the resource planning process. Ground events 
include such activities as testing, preventive maintenance, or system upgrades. 

•	 A bar represents a time period during which a DPR is to be processed or a resource 
reservation has been planned. 

•	 Each bar bears the name of a DPR or a resource reservation. Given the selection of a 
light enough color for the bar and a time span that allows a long enough bar, the name 
of the DPR or resource reservation can be seen on the bar. 

 Placing the cursor on a bar causes the name of the DPR (or resource 
reservation), its description, and its start and end dates/times to appear near the 
bottom of the timeline GUI. 

 Resource reservations are identified by the prefix “GE_”. 

The procedure for reviewing a production plan timeline starts with the assumption that all 
applicable production planning servers are running and the Production Planning Timeline GUI 
(Figure 30) is being displayed. 
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Reviewing a Plan Timeline 

1	 Adjust the Production Planning Timeline window size and the view of the timeline as 
necessary using the mouse. 

•	 Grab a corner of the timeline window with the cursor and resize the window as 
desired. 

• Scroll up or down through the full list of equipment. 

• Scroll left or right to go backward or forward in time. 

2	 If a different plan is to be viewed (other than the one currently being displayed), select 
File → Open Plan from the pull-down menu. 

• The Open Plan window (Figure 36) is displayed. 
• The available plans are listed. 

3	 Select (highlight) the plan to be reviewed by clicking on the corresponding plan name in 
the list of plans. 

4 Click on the OK button. 

• The selected plan is displayed on the Production Planning Timeline. 

5	 If a different time scale (start and end dates and times) is desired, perform Steps 6 
through 8; otherwise, go to Step 9. 

6 Select Time → Change Plan Window from the pull-down menu: 

• The plan window edit  window (Figure 37) is displayed. 
7	 Type date and time for the desired start and end times (in DD MMM YYYY hh:mm:ss 

format) in the Plan Win Start and Plan Win End fields of the plan window edit 
window. 
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Figure 36. Open Plan Window 

Figure 37. Plan Window Edit Window 

8	 When the appropriate date and time have been entered, click on the appropriate button 
from the following selections: 
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• OK - to accept the changes and dismiss the plan window edit  window. 
• Apply - to accept the changes without dismissing the plan window edit  window. 
• Cancel - to cancel the changes and dismiss the plan window edit  window. 

9	 If a different time span is desired, click and hold on the Show option button and select 
(highlight then release the mouse button) the desired time span from the option menu that 
is displayed: 

• 5 min 
• 10 min 
• 30 min 
• 45 min 
• 1 hr 
• 2 hr 
• 4 hr 
• 6 hr 
• 12 hr 
• 24 hr 
• 168 hr 
• other 

10 If no resources are displayed on the GUI or if different resources should be displayed, 
perform Steps 11 through 15; otherwise, go to Step 16. 

11 Select Display → Change resources from the pull-down menu: 
• The Resource edit window (Figure 38) is displayed. 

12	 If adding resource(s) from the Available Resources list to the Viewed Resources list, 
select (highlight) the resource(s) to be added, then click on the Add button to move the 
resource(s) to the Viewed Resources list. 
• Highlighted resource(s) appear(s) on the Viewed Resources list. 

13	 If deleting resource(s) from the Viewed Resources list, select (highlight) the resource(s) 
to be removed, then click on the Del button to remove the resource(s) from the Viewed 
Resources list. 
• Highlighted resource(s) disappear(s) from the Viewed Resources list. 
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Figure 38. Resource Edit Window 

14	 If changing the order in which resources are listed in the Viewed Resources list, select 
(highlight) the resource to be moved, then click on the up or down arrow as necessary to 
reposition the selected resource. 
• Highlighted resource changes position in the Viewed Resources list. 

15	 When the Viewed Resources list contains the desired set of resources, click on the 
appropriate button from the following selections: 
• OK - to accept the changes and dismiss the Resource edit window. 
• Apply - to accept the changes without dismissing the Resource edit window. 
• Cancel - to cancel the changes and dismiss the Resource edit window. 

16	 If different color coding of the timeline is desired, perform Steps 17 through 21; 
otherwise, go to Step 22. 

17 Select Display → Change colors from the pull-down menu: 

• The Color Selections window (Figure 39) is displayed. 
18 Click on the name of one of the DPRs or resource reservations to be recolored. 
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• The DPR or resource reservation is highlighted. 
19	 Click on the desired color (in the color palette) to be applied to the highlighted DPR or 

resource reservation. 
20 Repeat Steps 18 and 19 as necessary. 
21 When the appropriate color changes have been made, click on the appropriate button 

from the following selections: 
• OK - to accept the changes and dismiss the Color Selections window. 
• Apply - to accept the changes without dismissing the Color Selections window. 
• Cancel - to cancel the changes and dismiss the Color Selections window. 

22	 Observe the production scheduling information displayed on the Production Planning 
Timeline GUI. 

23 Repeat the previous steps as necessary. 

24	 If it becomes necessary to exit from the timeline GUI, select Close from the window 
manager pull-down menu (upper left-hand corner of the GUI). 
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Figure 39. Color Selections Window 
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Troubleshooting Production Planning Problems


Troubl e Symptoms 
Troubleshooting is a process of identifying the source of problems on the basis of observed 
trouble symptoms. One common source of problems involves connections with other subsystems 
for the transmission of messages or data. Like many other operational areas in ECS, Planning 
has interfaces with many other subsystems. Consequently, problems with processing can be 
traced to either the Planning Subsystem or one of many other ECS subsystems, including (but 
not necessarily limited to) those in the following list: 

• Data Processing Subsystem (DPS). 
• Data Server Subsystem (DSS). 
• Interoperability Subsystem (IOS). 
• Communications Subsystem (CSS). 

Table 3 describes actions to be taken in response to some common Planning problems. If the 
problem cannot be identified and fixed without help within a reasonable period of time, the 
appropriate response is to call the help desk or submit a trouble ticket in accordance with site 
Problem Management policy. 

Table 3. Troubleshooting Production Planning Problems (1 of 2) 
Symptom Response 

Unable to log in to the Planning 
Subsystem host (e.g., g0pls01). 

Check with the Operations Controller/System Administrator to 
ensure that the host is “up." 

GUI not displayed when the start-up 
script has been properly invoked. 

1. ure that the DISPLAY variable was set properly. 
2. ure that the xhost command was given on the initial login 
host. 
[For detailed instructions refer to the applicable procedure, either 
Launching the P roduction Request E ditor  or Launching 
Planning W orkbench-Related GUIs  (previous sections of this 
lesson).] 

Error message indicating that SNS 
(System Name Server) and/or 
Resource Model is/are in use using 
the selected Application ID. 

1. e another Application ID if working in a different mode from 
the person using the selected Application ID. 
2. king in the same mode as the other user, coordinate use 
of Planning applications with the other user and/or the System 
Administrator. 
[For detailed instructions refer to the procedure for Launching 
Planning W orkbench-Related GUIs  (previous section of this 
lesson).] 

Ens
Ens

Us

If wor
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Table 3. Troubleshooting Production Planning Problems (2 of 2) 
Symptom Response 

Other problems. 1. ure (e.g., using ECS Assistant) that the necessary hosts 
and servers (listed in Table 4) are “up.” 
2. If hosts/servers have gone down, notify the Operations 
Controller/System Administrator to have servers brought back up 
using HP OpenView. 
3. If hosts/servers are all “up,” check the log files (e.g., 
EcPlPREditor.ALOG, EcPlWb.ALOG, EcPlTl.ALOG) in the 
/usr/ecs/MODE/CUSTOM/logs directory for error messages. 
[For detailed instructions refer to the procedure for Checking Log 
Files  (subsequent section of this lesson).] 

Ens

Table 4. Hosts, Servers, C lient s and Ot her Sof tware Relevant to 
Production Planning 

HOST SERVER/CLIENT/OTHER SOFTWARE 

Planning/Management Workstation Production Request Editor (EcPlPREditor) 
Planning Workbench GUI EcPlWb) 
Production Strategies GUI (EcPlProdStrat) 
Production Planning Timeline (EcPlTl) 
Subscription Editor (EcPlSubsEdit) 
Message Handler (EcPlMsh) 
System Name Server (EcPlSns) 
Resource Model (EcPlRm) 

Queuing Server (e.g., x0sps04) Subscription Manager (EcDpPlSubMgr) 
Job Management Server (EcDpPrJobMgmt) 

SDSRV Server (e.g., x0acs03) Science Data Server (EcDsScienceDataServer) 

Interface Server 01 (e.g., x0ins02) Advertising Server (EcIoAdServer) 

Interface Server 02 (e.g., x0ins01) Subscription Server (EcSbSubServer) 

(

Checki ng Log Fi les 
Log files can provide indications of the following types of problems: 

• DCE problems. 
• Database problems. 
• Lack of disk space. 

The procedure for checking log files starts with the assumption that the operator has logged in to 
the ECS system and the Planning Subsystem host. 
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Checking Log Files 

1 Access a terminal window logged in to the appropriate host. 
2 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

• Change directory to the directory containing the production planning log files (e.g., 
EcPlPREditor.ALOG, EcPlWb.ALOG, EcPlTl.ALOG). 

3 Type pg filename then press Return/Enter. 
•	 filename refers to the production planning log file to be reviewed (e.g., 

EcPlPREditor.ALOG, EcPlPREditor_IF.ALOG, EcPlProdStrat.ALOG, 
EcPlWb.ALOG, EcPlTl.ALOG) 

• The first page of the log file is displayed. 
• Although this procedure has been written for the pg command, any UNIX editor or 

visualizing command (e.g., tail , more, vi) can be used to review the log file. 
4 Review the log file to identify problems that have occurred. 
5 Respond to problems as follows: 

• DCE problems. 
−	 Notify the Operations Controller/System Administrator of suspected DCE 

problems. 
•	 Database problems. 

− Verify that relevant database servers are running. 
− Check for lack of (or corruption of) data in the database using either a 

database browser or isql commands. 
− Notify the Database Administrator of suspected database problems. 

• Lack of disk space. 
− Remove unnecessary files. 
− Notify the Operations Controller/System Administrator of recurring disk 

space problems. 
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Launching Production Processing Applications


Launchi ng Pr oducti on Pr ocessi ng Appl icati ons 
The following software applications are associated with Production Processing (excluding 
Science Software Integration and Test (SSI&T) and Science Data Processing Toolkit 
applications): 

• Subscription Manager. 
• Job Management. 
• Data Management. 
• Execution Management. 
• PGE Management. 
• Deletion Server. 
• AutoSys/AutoXpert. 
• QA Monitor. 

Access to the Production Processing tools must be gained through the use of UNIX commands. 

Launching Production Processing applications starts with the assumption that the applicable 
servers are running and the Production Monitor has logged in to the ECS system. 

Launching Production Processing Applications 

NOTE: Commands in Steps 1 through 11 are typed at a UNIX system prompt. 
1	 At the UNIX command line prompt type xhost hostname then press the Return/Enter 

key on the keyboard. 
•	 hostname refers to the host on which GUIs are to be launched during the current 

operating session. Multiple hostnames can be specified on the same line. 
• The use of xhost + is discouraged because of a potential security problem. 

2 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
•	 Use either the X terminal/workstation IP address or the machine-name for the 

clientname. 
•	 When using secure shell, the DISPLAY variable is set just once, before logging in to 

remote hosts. If it were to be reset after logging in to a remote host, the security 
features would be compromised. 

3 Open another UNIX (terminal) window. 
4	 Start the log-in to the Queuing Server host by typing /tools/bin/ssh hostname (e.g., 

e0sps04, g0sps06, l0sps03, or n0sps08) in the new window then press the Return/Enter 
key. 
•	 If you receive the message, Host key not found from the list of known hosts. Are 

you sure you want to continue connecting (yes/no)? type yes (“y”  alone will not 
work). 
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•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 5. 

• If you have not previously set up a secure shell passphrase; go to Step 6. 
5	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 7. 

6	 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

7 Type setenv ECS_HOME /usr/ecs/  then press the Return/Enter key. 
• When logging in as a system user (e.g,, cmshared), the ECS_HOME variable may be 

set automatically so it may not be necessary to perform this step. 
8 Type cd /path then press Return/Enter. 

•	 Change directory to the directory (e.g., /usr/ecs/MODE/COTS/autotreeb/autouser, 
/usr/ecs/MODE/COTS/autotree/autouser, /data1/SHARED/COTS/autotree/autouser) 
containing the set-up files (e.g., FMR.autosys.csh.g0sps06). 

• The particular path to be typed may vary from site to site. 
9 Type source AUTOSYSINSTANCE.autosys.csh.hostname then press Return/Enter. 

•	 An AUTOSYSINSTANCE (also called an AUTOSERV instance) is installed as part 
of the Data Processing Subsystem and is identified by three capital letters. 

−	 For example, an AutoSys instance at the GSFC DAAC might be identified as 
FMR . 

• It is possible to have multiple AutoSys instances installed at a DAAC. 
10 Type cd /usr/ecs/MODE/CUSTOM/utilitie s then press Return/Enter. 

•	 Change directory to the directory containing the AutoSys start script (e.g., 
EcDpPrAutosysStart). 

•	 The MODE will most likely be one of the following operating modes: 
 OPS (for normal operation). 
 TS1 (for SSI&T). 
 TS2 (new version checkout). 

• Note that the separate subdirectories under /usr/ecs apply to (describe) different 
operating modes. 

11 Type EcDpPrAutosysStart MODE AUTOSYSINSTANCE then press Return/Enter. 
• The AutoSys GUI Control Panel (Figure 40) is displayed. 

Figure 40. AutoSys GUI Control Panel 
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Configuring AutoSys Screens/Displays


AutoSys/ AutoXper t Producti on Schedul ing Tool 
The Planning and Data Processing Subsystems provide a batch processing environment to 
support the generation of data products. They manage, queue and execute Data Processing 
Requests (DPR) on the processing resources at a DAAC. The DPRs are submitted from the 
Planning Subsystem. The Planning and Data Processing Subsystems provide the operational 
interfaces needed to monitor the execution of science software PGEs specified in the DPRs. 

The AutoSys/AutoXpert software is a production scheduling tool intended to support the 
operational activities surrounding production processing. It assists with the following activities 
(among others): 

• job monitoring. 
• job scheduling. 
• fault notification. 
• job restart. 
• determining the effects of failure of a DPR. 
• determining the cause and actions to be taken due to the failure of a DPR. 

AutoSys recognizes the following three categories of jobs: 

• Box jobs. 
• Command jobs. 
• File-watcher jobs. 

A box job is a collection of other jobs. It performs no processing action other than providing an 
organizational structure for a group of jobs that should be run within the same time period. Box 
jobs can be nested; i.e., box jobs can be included in other box jobs. Box jobs are particularly 
useful for organizing, managing, and administering large numbers of jobs, which are interrelated 
or have complex logic flows. 

Box jobs are subject to the following rules: 

•	 If no other starting conditions are specified at the job level, a job within a box job 
runs as soon as the starting conditions for the box are satisfied. 

• If there are no job-level starting conditions for some of the jobs in a box, those jobs 
will run in parallel. 

 The jobs will run only once even if multiple start times are specified for some of 
the individual jobs. 

 Consequently, jobs in boxes will not be run several times inadvertently. 
•	 Whenever any job in a box changes state, all jobs in the box are checked to see if they 

are eligible to be run. 

A command job is the type most commonly thought of as a “job.” The “command” can be a 
shell script, the name of an executable program, a file transfer, or any other command that causes 
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execution of a UNIX command on a client machine. When all of the starting conditions for the 
particular job have been met, AutoSys performs the following functions: 

• executes the command (runs the job). 
• captures the exit code at job completion. 
•	 sends the exit event (success or failure) and code back to the relational database 

management system (RDBMS). 

A file-watcher job functions in a manner that is similar to a command job; however, it has a 
special purpose, i.e., to monitor the creation and size of a particular operating system file. When 
the file has reached a specified minimum size and is no longer increasing in size, the file-watcher 
job sends AutoSys an event indicating that the file has arrived. The file-watcher job allows 
AutoSys to know the status of external files that are needed in the processing of command jobs 
or box jobs. 

When determining whether to start a job of any type, AutoSys evaluates the job with respect to 
the following the following starting parameters: 

• Date and time scheduling parameters are met. 
• Starting Conditions specified in the job definition evaluate to “true.” 
• For jobs in a box, the box must be in the RUNNING state. 
• The current status of the job is not ON_HOLD or ON_ICE. 

Every time there is an event that changes the truth of any of the preceding parameters, AutoSys 
finds all jobs that may be affected by the change and determines whether or not to start them. 

In ECS each DPR generated by the Planning Subsystem defines a box job for AutoSys. Every 
DPR/box job is composed of seven command jobs that run in the following order: 

• Allocation (EcDpPrEM) 
• Staging (EcDpPrDM) 
• Pre-processing (EcDpPrEM) 
• Execution (EcDpPrRunPGE) 
• Post-processing (EcDpPrEM) 
• Insertion (EcDpPrDM) 
• Deallocation (EcDpPrEM) 

Each of the last six ECS command jobs is dependent on successful completion of the command 
job that precedes it. For example, staging does not start until allocation has been successfully 
completed. 

Just as the command jobs within a box job are dependent on the successful completion of other 
jobs, a DPR/box job itself may be dependent on the successful completion of some other box 
job(s). Such dependencies usually involve a need for the output of another DPR as input. 

The following rules apply to DPR dependencies: 

•	 Any DPRs which depend on data that are not yet available are kept in a "held" state 
by AutoSys until their data availability subscriptions are fulfilled. 
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•	 The subscription manager software, which is part of the Planning Subsystem, receives 
subscription notifications for the DPRs and informs the DPS to release the AutoSys 
jobs after all data subscriptions for a given DPR are fulfilled. 

•	 The Data Processing Subsystem (as managed by the AutoSys Job Scheduling engine) 
runs the PGEs and associated jobs as the resources required for the tasks become 
available. 

• The procedure continues until all DPRs scheduled for that day have completed. 

The optimum number of jobs for an AutoSys instance is about 3200 jobs (400 DPRs). During 
start-up the Job Management server in the Data Processing Subsystem determines the number of 
jobs in the PDPS database associated with Job Management’s operating mode and compares the 
number with the maximum allowable for the mode. The maximum is specified in the Job 
Management configuration file (i.e., as DpPrAutoSysMaxJobs in EcDpPrJobMgmt.CFG). Job 
Management deletes from AutoSys the successfully completed jobs associated with the 
applicable mode only. Deleting completed jobs makes room for other jobs in the processing 
queue. It is possible to distribute the optimum number of jobs (3200) among the active modes 
according to their level of activity; e.g., 3000 for OPS mode and the remainder divided between 
the SSI&T and test modes (TS1 and TS2). 

The DAAC Production Monitor uses AutoSys/AutoXpert when performing the following 
functions: 

• modifying DPR priorities and inputs as required. 
•	 transferring/deleting/suspending/resuming DPRs as required (e.g., requests, resource 

problems, input data schedule problems, special events, schedules replans, etc.). 
• monitoring and providing processing status upon request. 

The Production Monitor can configure some aspects of AutoSys/AutoXpert, including the 
runtime options. 

Confi gur ing AutoSys/ AutoXper t Runti me Opti ons 
This section explains how to configure AutoSys/AutoXpert runtime options. The Production 
Monitor can define the following runtime options: 

• Refresh Interval. 
	 Determines how often the View Region (the area on the right side of the GUI 

display where data are presented) will be updated. 
•	 Ping Interval. 

 Defines how often the connectivity will be evaluated. 
• Hang Time. 

	 Specifies the length of time jobs will continue to be displayed within a machine 
after they have completed running. 

•	 Inches/Hr. 
 Indicates how much information is displayed on the screen. 

There are default values that apply to the runtime options until the Production Monitor modifies 
them. 
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Table 5 lists the runtime options available for HostScape, TimeScape, and JobScape. Not all 
options are available for all GUI’s. 

Table 5. Runtime Options Table 
Interface Refresh Int erval Hangt ime PING Inches/Hour 

Host Scape X X X 

TimeScape X X 

JobScape X 

The procedure for configuring AutoSys/AutoXpert runtime options assumes that AutoSys has 
been launched and the AutoSys GUI Control Panel (Figure 40) is being displayed. Perform 
only the steps that are applicable to the changes to be made (as specified in Table 5). Note that if 
the Freeze Frame feature is enabled, any changes entered will not take place until Freeze Frame 
has been disabled. 

Configur ing AutoSys Runtime Options 

1 Click on either the HostScape, TimeScape, or JobScape button as applicable. 
• The AutoXpert GUI corresponding to the selected button is displayed (Figures 42­

44). 
2 Select Options → Edit Runtime Options from the pull-down menu. 

• The Runtime Options dialog box is displayed. 
3	 If the refresh interval is to be modified, click on Refresh Interval (Seconds) and either 

type in a value between 1 and 99999 or click on the <| and |> keys as necessary to 
decrease or increase the current numerical value until the desired value is reached. 
• Default value is 30 seconds. 
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Figure 42. AutoXpert HostScape GUI 
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Figure 43. AutoXpert TimeScape GU I 
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Figure 44. AutoXpert JobScape GU 

•	 The Reloading Job Data window reappears as often as specified in the Refresh 
In terval (Seconds) field. 

4	 If the ping interval is to be modified, click on Ping Interval (Seconds) and either type in 
a value between 1 and 99999 or click on the <| and |> keys as necessary to decrease or 
increase the current numerical value until the desired value is reached. 
• Default value is 300 seconds. 
• If 99999 is entered, no ping commands are issued. 

5	 If the hang time is to be modified, click on Hang Time (Minutes) and either type in a 
value between 1 and 99999 or click the <| and |> keys as necessary to decrease or increase 
the current numerical value until the desired value is reached. 
• Default value is 1 minute. 

6	 If the number of inches/hour is to be modified, click on Inches/Hr (inches) and either 
type in a value or click the <| and |> keys as necessary to decrease or increase the current 
numerical value until the desired value is reached. 
• Default value is 2 inches/hr . 

7 When all desired modifications have been entered, click on the OK button. 
• The runtime options are set. 
• The dialog box closes. 

8	 If another of the AutoXpert GUIs needs to have its runtime options configured, repeat 
Steps 2 through 7 for the next GUI. 

9	 To quit any of the AutoXpert GUIs (HostScape, JobScape or TimeScape) select 
File → Exit then click on the OK button. 
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10 To quit AutoSys click on the Exit  button of the AutoSys GUI Control Panel. 

Confi gur ing Har dware Groups 
This section explains how to configure AutoSys hardware groups. The purpose of configuring 
hardware groups is to make it easier to monitor the hardware associated with a particular function 
(e.g., SSI&T, training, or processing in support of a particular instrument) rather than having to 
find those items in the default group, which is “All Machines.” 

The Production Monitor may define a specific set of machines to be monitored as a group. The 
Production Monitor must know which machines are to be included in the group and should 
devise a useful name for the group. 

The Production Monitor must have access to UNIX commands in order to perform the 
procedure. 

Configur ing Hardware Groups 

NOTE: Commands in Steps 1 through 9 are typed at a UNIX system prompt. 
1	 At the UNIX command line prompt type xhost hostname then press the Return/Enter 

key on the keyboard. 
•	 hostname refers to the host on which GUIs are to be launched during the current 

operating session. Multiple hostnames can be specified on the same line. 
• The use of xhost + is discouraged because of a potential security problem. 

2 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
•	 Use either the X terminal/workstation IP address or the machine-name for the 

clientname. 
•	 When using secure shell, the DISPLAY variable is set just once, before logging in to 

remote hosts. If it were to be reset after logging in to a remote host, the security 
features would be compromised. 

3 Open another UNIX (terminal) window. 
4	 Start the log-in to the Queuing Server host by typing /tools/bin/ssh hostname (e.g., 

e0sps04, g0sps06, l0sps03, or n0sps08) in the new window then press the Return/Enter 
key. 

•	 If you receive the message, Host key not found from the list of known hosts. Are 
you sure you want to continue connecting (yes/no)? type yes (“y”  alone will not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 5. 

• If you have not previously set up a secure shell passphrase; go to Step 6. 
5	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 7. 
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6 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

7 Type cd /path then press Return/Enter. 
•	 Change directory to the directory (e.g., /usr/ecs/MODE/COTS/autotreeb/autouser, 

/usr/ecs/MODE/COTS/autotree/autouser, /data1/SHARED/COTS/autotree/autouser) 
containing the set-up files (e.g., FMR.autosys.csh.g0sps06). 

• The particular path to be typed may vary from site to site. 
8 Type source AUTOSYSINSTANCE.autosys.csh.hostname then press Return/Enter. 
9 Type vi xpert.groups.AUTOSYSINSTANCE then press Return/Enter. 

• The configuration file is displayed by the vi text editor. 

•	 Although this procedure has been written for the vi editor, any UNIX editor can be 
used to create the machine group file. 

10 Using vi editor commands create/modify hardware groups as necessary. 
• An example of a hardware group file is shown in Figure 45. 
• The first line of each machine group is in the format groupname: groupname. 
• The name of each machine to be included in the group is on a separate line. 
•	 The following vi editor commands are useful: 

 h (move cursor left) 

 j  (move cursor down) 

 k (move cursor up) 

 l (move cursor right) 

 i (insert text) 

 x (delete a character) 

 u (undo previous change) 

 Esc (switch to command mode) 
11 Press the Esc key. 
12 Type ZZ. 

• New hardware groups are entered and saved in the file. 
• UNIX prompt is displayed. 
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groupname: Training 

g0pls02 

g0sps06 

g0spg01 

groupname: SSI & T 

g0ais01 

g0sps06 

g0spg01 

Figure 45. AutoSys Hardware Group File 

13	 Launch AutoSys as described in the procedure for Launching Production Processing 
Applications. 

• The AutoSys GUI Control Panel (Figure 40) is displayed. 

14 Click on the HostScape button. 

• The HostScape GUI (Figure 42) is displayed. 

15 Select View → Select Machine Group from the pull-down menu. 

• The Machine Group Selection dialog box is presented. 

16 Select (highlight) the machine group to be applied. 

• The machine group is highlighted. 

17 Click on the OK button. 

• The selected machine group is applied. 

• The Machine Group Selection dialog box closes. 
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Reviewing Hardware Status, DPR Dependency,

DPR Production Timeline, Alarms, and Job Activities


Reviewing Hardware Status 
The Production Monitor reviews hardware status using AutoSys. Hardware status is displayed 
by the AutoXpert HostScape GUI. By checking the hardware status the Production Monitor can 
determine the status of processors, the condition of the queue, whether any processors are 
overloaded while others are idle, whether there are any system problems, etc. 

HostScape displays jobs on a machine-by-machine basis, indicating which AutoSys server/client 
machines are up and active, and which jobs are running or have recently run on each machine. 
HostScape allows the Production Monitor to check hardware status in real-time. 

The procedure for reviewing hardware status starts with the assumption that all applicable servers 
are currently running and the AutoSys GUI Control Panel (Figure 40) is being displayed. 

Reviewing Hardware Status 

1 Click on the HostScape button on the AutoSys GUI Control Panel. 
• The HostScape GUI (Figure 42) is displayed. 
• View presented is Normal View. 

2	 Review the Control Region (left side of the display) to identify the color codes for the 
status of the machines. In the View Region (right side of the display) the color code is 
displayed on the border of each machine box. 
• MACHINE UP (active) is green. 
• MACHINE DOWN (inactive and cannot be reached) is red. 
• MACHINE INACTIVE is black. (The color code is not shown in the Control 

Region) 
3 Review the machine type in the View Region (right side of the display). 

•	 The name of the machine is displayed in the upper left-hand corner of each machine 
box. 

• Server machines are in the first (top) row of the display. 
• Event Server name appears below the list of jobs, if applicable. 
• Event Processor name appears below the list of jobs, if applicable. 
• Client machines are in the subsequent rows of the display. 

4	 Review the machine boxes in the View Region to determine the status of individual 
machines. 
• The total number of jobs STARTING or RUNNING. 
• All jobs RUNNING are listed. 
• The View Region is scrollable. 

5 Review the Alarm  indicating buttons of individual machines in the View Region. 
• Alarm button is in the upper right-hand corner of the box. 

125 625-CD-006-002




• Red indicates that an alarm has been generated. 
• Gray (default color) indicates normal operation. 
• If an alarm is present, clicking an alarm button brings up the Alarm Manager 

(described in a subsequent section). 
6 Review the machine connection status in the View Region. 

•	 Solid black line indicates that AutoSys can communicate with the client machine 
Internet daemon. 

•	 Solid red line indicates that AutoSys cannot communicate with the client machine 
Internet daemon; however, the daemon does respond to ping commands. 

•	 Dashed red line indicates that AutoSys cannot communicate with the client machine; 
the machine is probably turned off. 

7	 To exit from HostScape, select File → Exit from the pull-down menu then click on the 
OK button. 
• HostScape quits (is closed). 

Changing the Hardware Status View 

The View Options provide the Production Monitor with the following three methods of viewing 
hardware status: 

• Normal. 
• Global. 
• Zoom. 

In the Normal (default) view three rows of machines with job activities are displayed. In the 
Global view seven rows of machines but no job activities are displayed. In the Zoom view one 
machine is displayed in great detail. The details include job name, description, status, and 
commands. 

The Production Monitor selects the Global view to monitor the entire system and uses the Zoom 
view to focus on a specific machine, especially in case of a malfunction. 

The procedure for changing hardware status views starts with the assumption that AutoSys is 
running in the HostScape mode with the default Normal view displayed. 

Changing Hardware Status Views 

1	 Select a machine in the View Region by clicking on its name, then select 
View → Select View Level → Global View from the pull-down menu. 
• The Global view is displayed. 
• Seven rows of machines are displayed. 
• No job information is displayed. 

2	 Select a specific machine by clicking on its name, then select 
View → Zoom in Machine from the pull-down menu. 
• The Zoom view is displayed. 
• A table listing the following data is displayed: 
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 Job Name. 
 Descr iption. 
 Status. 
 Command. 

3 Select Dismiss. 
• The Global view is displayed. 

4 Select View → Select View Level → Normal View from the pull-down menu. 
• The Normal view is displayed. 
• Three rows of machines are displayed. 
• Limited job information is displayed. 

Reviewing DPR Dependenci es 
The Production Monitor reviews DPR dependencies using AutoSys. DPR dependencies are 
displayed by the AutoXpert JobScape GUI. 

JobScape presents a Pert-like view of job processing from a logical (or job dependency) point of 
view. JobScape depicts all job types; i.e., command jobs, box jobs, and file-watcher jobs. In 
addition, it depicts the nesting of jobs within boxes and the dependencies between jobs. 

JobScape can be used for monitoring job flow in real-time. It allows the Production Monitor to 
identify potential problems, try to prevent them from becoming actual problems, stop problem 
jobs in favor of letting good jobs run, etc. 

AutoSys defines job status in the terms listed in Table 6. The different states are color-coded on 
the JobScape display. However, the codes can be changed. The color codes listed in the table 
are the default values. 

Table 6. Job St ates (1 of 2) 
Status Color Code Meaning 

ACTIVATED white The top-level box that the job is in is now in the “running” state but the job 
itself has not started yet. 

STARTING green The Event Processor has initiated the start procedure with the Remote 
Agent.  in the process of “coming up.” 

RUNNING green The job is running.  a box job, “running” means that the jobs 
within the box may be started (other conditions permitting).  a 
command job or a file-watcher job, “running” means that the process is 
actually running on the remote machine. 

The job is

If the job is
If the job is
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Table 6. Job St ates (1 of 2) 
Status Color Code Meaning 

SUCCESS light blue When the job had completed running, it had an exit code equal to or less 
than the “maximum exit code for success.”  By default, only the exit code 
“0” is interpreted as “success.”  However, a range of values up to the 
“maximum exit code for success” may be reserved for each job to be 
interpreted as success.  If the job is a box job, “success” means that all 
jobs within the box  had exit codes indicating “success” (default) or the 
“exit condition for box success” was “true.” 

FAILURE red When the job had completed running, it had an exit code greater than the 
“maximum exit code for success.”  The default is any non-zero exit code. 
If the job is a box job, “failure” means that at least one job within the box 
had an exit code greater than zero (the default meaning) or the “exit 
condition for box failure” was “true.” 

TERMINATED red The job terminated while in the “running” state. mination may be the 
result of a user sending a “killjob” event, or a job may have been 
terminated because the job itself (or the box it is in) failed. elf 
fails, it has a “failure” status rather than a “terminated” status. 

RESTART orange The job was unable to start due to hardware or application problems and 
has been scheduled to restart. 

QUE_WAIT yellow The job can logically run (i.e., all starting conditions have been met); 
however, there are not enough machine resources available to allow it to 
run. 

ON_ICE dark blue The job is removed from all conditions and logic but is still defined to 
AutoSys.  Operationally it  as though the job had been deactivated. 
The job remains “on_ice” until it receives the “job_off_ice” event. 
Downstream dependent jobs behave as though the “on_ice” job ran 
successfully.  “starting” or “running” cannot be put “on_ice.” 

ON_HOLD dark blue The job is on hold and will not run until it receives the “job_off_hold” 
event. tream jobs will not run until the job is taken off hold. 
that is “starting” or “running” cannot be put “on_hold.” 

INACTIVE dark blue The job has not yet been processed.  the job has never been run 
or its status was intentionally altered to “turn off” its previous completion 
status. 

Ter

If the job its

is

A job that is

Downs A job 

Either

The procedure for reviewing DPR Dependencies starts with the assumption that all applicable 
servers are currently running and the AutoSys GUI Control Panel (Figure 40) is being 
displayed. 

Reviewing DPR Dependencies 

1 Click on the JobScape button on the AutoSys GUI Control Panel. 
• The JobScape GUI (Figure 44) is displayed. 
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2	 Review the Control Region (left side of display) to identify the Tr ue/False dependency 
legend. 
• Tr ue is indicated by a solid arrow, which indicates that job dependencies have been 

met. 
 The solid arrow is the default code for Tr ue; the codes can be changed. 

•	 False is indicated by a dashed arrow, which indicates that job dependencies have not 
been met. 

•	 Dependency arrows indicate only that a job dependency exits for a job. They do not 
define time-related starting conditions, nor do they describe the type of job 
dependency, e.g., “success,” “started,” or “running.” 

3 Review the Job Display to determine the status (color-coded) of DPRs. 
• Default colors representing job statuses are listed in Table 6. 

4 Review the Job Display to determine the types of jobs: 
• Rectangle = Box Job. 
• Ellipse = Command Job. 
• Hexagon = File Watcher Job. 

5	 Select a job (for which descendants are to be determined) by placing the mouse cursor on 
the job and clicking with the left  mouse button. 
• Color of the border around the selected job changes to yellow. 
• Name of the job appears in the Current Job Name area of the Control Region. 

6	 Review the job’s descendants by placing the mouse cursor on the job and clicking and 
holding the right  mouse button. 
•	 Descendants pop-up menu appears. It has the following entries: 

 jobname. 
 Show Children. 
 Show All Descendants. 
 Hide All Descendants. 
 Show Job Arrows. 
 Hide Job Arrows. 
 Show Box Arrows. 
 Hide Box Arrows. 
 Job Definition. 
 View Dependencies. 
 Set Simulation Overrides [grayed out]. 
 Start Job. 
 Kill Job. 
 Force Start Job. 
 On Hold. 
 Off Hold. 
 On Ice. 
 Off Ice. 

• Color of the border around the selected job changes to yellow. 
• Name of the job appears in the Current Job Name area of the Control Region. 
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7	 Select (highlight) Show Child ren from the Descendants pop-up menu (release the right 
mouse button). 
• Job’s first-level Command, File-Watcher, and Box Jobs appear. 
• Repeat Step 5 to select a different job. 

8 Select Show All Descendants from the Descendants pop-up menu. 
• Job’s Command, File-Watcher, and Box Jobs appear for all levels. 

9 Select Hide All Descendants from the Descendants pop-up menu. 
• Default view is displayed. 
• All descendants are hidden. 

10	 To exit from JobScape, select File → Exit from the pull-down menu then click on the 
OK button. 

Reviewing the DPR Production Timeline 
The Production Monitor reviews the DPR Production Timeline using AutoXpert TimeScape. 

TimeScape presents a Gantt-like view of a job processing from a temporal (time-related) point of 
view. TimeScape depicts all job types; i.e., Command Jobs, Box Jobs, and File Watcher Jobs. It 
also depicts the nesting of jobs within boxes and the duration of time it will take for jobs to 
complete. TimeScape is used for monitoring job flow in real-time. 

The procedure for reviewing the DPR production timeline starts with the assumption that all 
applicable servers are currently running and the AutoSys GUI Control Panel (Figure 40) is 
being displayed. 

Reviewing the DPR Production Timeline 

1 Click on the TimeScape button on the AutoSys GUI Control Panel. 
• The TimeScape GUI (Figure 43) is displayed. 
• Current time is displayed in red in the View Region (right side of the display). 

2	 Review the Control Region (left side of display) to identify the Actual/Projected legend 
for making comparisons in the View Region. (Refer to Figure 46.) 
• Projected is a rectangular (blue filled) graphic, to show average job completion time. 
• Actual is a striped (white and blue) ribbon, to show how much of the job has 

completed. 
 If there is a green stripe, the job is running. 
 If there is a black stripe, the job has been completed. 
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Good vs Bad 

Projected 

Actual 

Looks Good!


Projected


Actual


Tr ouble!


Figure 46. Evaluat ing A ctual versus Project ed Job Processing Time 

3	 Review a job’s descendants by placing the mouse cursor on a job and clicking and 
holding the right  mouse button. 
• Descendants pop-up menu appears. 
• An asterisk (*) indicates that a Box Job’s descendants have been hidden. 

4	 Select (highlight) Show Child ren from the Descendants pop-up menu and release the 
mouse button. 
• Job’s first-level Command, File Watcher, and Box Jobs appear. 
• Return to Step 3 to select a different job. 
• Go to Step 5 to change the view. 

5	 Select (using the right mouse button) Show All Descendants from the Descendants pop­
up menu. 
• Job’s Command, File Watcher, and Box Jobs appear with all levels. 

6	 Select (using the right mouse button) Hide All Descendants from the Descendants pop­
up menu. 
• Default view is displayed. 
• All descendants are removed. 

7	 To exit from TimeScape, select File → Exit from the pull-down menu then click on the 
OK  button. 
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Reviewing Alarms 
Alarms indicate problems with job processing. They may involve a failure of job processing, a 
database problem, a communication problem, hardware or software failure or some other error in 
the data processing system. 

The Production Monitor reviews alarms using the AutoSys Alarm Manager. The Alarm 
Manager allows the Production Monitor to perform the following functions: 

• View alarms as they arrive. 
• Provide a response to an alarm. 
• Change alarm status. 

The Production Monitor can configure the Alarm Manager to display certain types of alarms 
only. The Production Monitor may wish to see only certain types of alarms (e.g., job failure 
alarms) or only those alarms that are open (have not yet been acknowledged) or only the alarms 
that have occurred within the last thirty minutes. 

The Production Monitor can select alarms to be displayed based on any or all of the following 
three criteria: 

• Type of alarm 
• Alarm state 
• Time of the alarm 

The procedure for reviewing alarms starts with the assumption that all applicable servers are 
currently running and the AutoSys GUI Control Panel (Figure 40) is being displayed. 

Reviewing Alarms 

1 Click on the Ops Console button on the AutoSys GUI Control Panel. 
• The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 47) is 

displayed. 
2 Click on the Alarm b utton. 

• The Alarm Manager GUI (Figure 48) is displayed. 
•	 Alarms are displayed in reverse order of occurrence; i.e., the most recent alarm 

appears at the top of the list. 
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Figure 47. Job Activity Console (Ops Console) GUI 
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Figure 48. Alarm Manager GUI 

•	 The following information is displayed: 
 Alarm Type. 
 Job Name. 
 Time. 
 State. 
 Comment. 

Click on an alarm in the Alarm List . 
• Alarm is displayed in detail in the Currently Selected Alarm region of the display. 
• Table 7 contains descriptions of AutoSys alarms. 
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Table 7. AutoSys A larms ( 1 of 2) 
ALARM CODE* DESCRIPTION 

AUTO_PING The autoping  command has found a problem in trying to 
communicate with the Remote Agent on a client machine. 

CHASE 514 The chase  command has found a problem with a job that is 
supposedly running. The job and problem are listed. 

DATABASE_COMM 516 The Remote Agent had trouble sending an event to the 
database. The job probably ran successfully. Inspect the 
Remote Agent Log file to determine what happened. 

DB_PROBLEM 523 There is a problem with one of the AutoSys databases. This 
alarm can trigger a user-specified notification procedure. 

DB_ROLLOVER 519 AutoSys has rolled over from Dual Server to Single Server 
Mode. This alarm can trigger a user-specified notification 
procedure. 

DUPLICATE_EVENT 524 Duplicate events have been received in the Event Server. 
Typically, this means that two Event Processors are running, 
although “duplicate events” can also be caused by Event Server 
configuration errors. 

EP_HIGH_AVAIL 522 The Event Processor High Availability system has detected 
some system or network problems. This alarm can trigger a 
user-specified notification procedure. 

EP_ROLLOVER 520 The Shadow Event Processor is taking over processing. This 
alarm can trigger a user-specified notification procedure. 

EP_SHUTDOWN 521 The Event Processor is shutting down. This may be due to a 
normal shutdown (SEND_EVENT) or due to an error condition. 
This alarm can trigger a user-specified notification procedure. 

EVENT_HDLR_ERROR 507 The Event Processor had an error while processing an event. 
The job associated with the event should be inspected to see if 
manual intervention is required. 

EVENT_QUE_ERROR 508 An event could not be marked as processed. This is usually 
due to a problem with the Event Server. 

FORKFAIL 501 The Remote Agent was unable to start the user command 
because it was unable to get a process slot on the machine. 
AutoSys automatically attempts a RESTART when this 
happens. 

INSTANCE_UNAVAILABLE 525 When different AutoSys instances communicate with each 
other, this alarm is generated when a receiving AutoSys 
instance (i.e., its Event Server) cannot be reached. The Event 
Server is probably down. 

JOBFAILURE 503 A job has failed. Its current status is FAILURE. 

JOBNOT_ONICEHOLD 509 To place a job either ON_HOLD or ON_ICE, a JOB_ON_HOLD 
or JOB_ON_ICE event (as applicable) is sent. There are 
certain conditions when the job cannot be placed ON_HOLD or 
ON_ICE (e.g., if it is already running). In such cases the alarm 
is sent alerting the operator that the job could not be put 
ON_HOLD or ON_ICE (as applicable). 
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Table 7. AutoSys A larms ( 2 of 2) 
ALARM CODE* DESCRIPTION 

MAXRUNALARM 510 The job has been running for a time greater than that defined in 
the Maximum Run Alarm (max_run_alarm ) field for the job. 
The job may continue to run; however, a warning alarm is 
generated. 

MAX_RETRYS 505 AutoSys continues attempting to restart a job if there are system 
problems or if the job is configured for application restarts 
(n_retrys ).  There is a limit to the number of times it will attempt 
a restart,  defined in the configuration files (using 
MaxRest artTrys ).  When that limit has been reached, the 
MAX_RETRYS alarm is sent to alert operators that AutoSys has 
given up trying to start the job.  the problem has been fixed 
the job must be started manually. 

MINRUNALARM 502 The job has completed running in a time less than that defined 
in the Minimum Run Alarm (min_run_alarm)  field for the job. 

MISSING_HEARTBEAT 513 A job has not sent a HEARTBEAT within the interval specified 
for the job. ator should inspect the job to determine the 
cause. 

RESOURCE 512 A resource needed for the job was not available. pes of 
resources are: a) number of process slots and (b) file space. 
Specific information about the problem is in the comment 
associated with the alarm. s encounters a resource 
problem, it attempts to restart the job after a suitable delay. 

STARTJOBFAIL 506 AutoSys was unable to start the job.  is generally due to 
communication problems with the remote machine. s 
attempts to restart 

VERSION_MISMATCH 518 Generated by the Remote Agent when calling the routine (e.g., 
Event Processor, chase , clean_f iles, autoping , etc.) has a 
different version number than the Remote Agent. pect the 
Remote Agent Log file for the exact version mismatch. 
proper Remote Agent version should be installed. 
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*The code number is used for viewing the event in the event table in the AutoSys database. 

4	 Click the Response edit box and type in a response, if desired, then press the Tab key on 
the keyboard. 
• Response is updated on the GUI (but not yet recorded). 

5	 Update the Alarm State by clicking on the radio button that appropriately describes the 
Alarm State. 
•	 The following Alarm State radio buttons are available: 

 Open. 
 Acknowledged. 
 Closed. 

• The Alarm State is updated on the GUI (but not yet recorded). 
6 Click on the appropriate button from the following selections: 

•	 OK - to enter all alarm responses and dismiss the Alarm Manager GUI. 
 Job Activity Console (Ops Console) GUI is displayed. 
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•	 Apply - to enter all alarm responses without dismissing the Alarm Manager GUI. 
 Repeat Steps 3 through 6 as necessary to review and update additional alarms. 

• Cancel - to return to the Job Activity Console (Ops Console) GUI without entering 
any alarm responses. 

 Job Activity Console (Ops Console) GUI is displayed. 
7	 To exit from the Job Activity Console (Ops Console) GUI click on the Exit button then 

on the OK button. 

By configuring the AutoSys Alarm Manager the Production Monitor can control which alarms 
are displayed. Alarms can by selected by type, state, or time. 

The procedure for configuring the Alarm Manager starts from the assumption that the Alarm 
Manager is currently running. 

Configur ing Alarm Selection 

Select View → Select Alarms from the pull-down menu of the Alarm Manager GUI. 
• Alarm Selection GUI (Figure 49) is displayed. 
•	 Alarm Selection has the following defaults: 

 All Types for Select by Type. 
 Open and Acknowledge for Select by State. 
 All Times for Select by Time. 

Figure 49. Alarm Select ion GU I 
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2	 To select a single type of alarm, click on the desired alarm in the Select by Type alarm 
list; to select all types of alarms, click on the All Types button. 
• Desired alarm type is selected. 
• If All Types are selected, the All Types button color changes to yellow. 

3	 To select multiple types of alarms: press and hold the Control (Ctrl)  key on the 
keyboard while clicking the desired alarms in the Select by Type alarm list. 
• Multiple alarms are selected. 

4	 To select all alarm states click on the All States button; to select alarms by state click on 
whichever of the Select by State toggle button(s) properly describe(s) the state(s) to be 
selected. 
•	 The following Select by State toggle buttons are available: 

 Open. 
 Acknowledge. 
 Closed. 

• Any or all of the buttons in the preceding list can be selected. 
• The color of selected button(s) change(s) to yellow. 

5 To select all times click on the All Times button. 
6 To select alarms by time perform Steps 7 through 10; otherwise, go to Step 11. 
7 Type the starting date (in MM/DD/YY format) in the From Date field and press the Tab 

key on the keyboard to advance to the next field. 
• Starting date is entered. 
• If All Times have been selected, proceed to Step 9. 

8	 Type the starting time (in hh:mm format) in the From Time field and press the Tab key 
on the keyboard to advance to the next field. 
• Starting time is entered. 

9	 Type the end date (in MM/DD/YY format) in the To Date field, and press the Tab key on 
the keyboard to advance to the next field. 
• End date is entered. 

10 Type the end time (in hh:mm format) in the To Time field. 
• End time is entered. 

11	 When the Alarm Selection GUI contains the desired set of alarm display criteria, click 
on the appropriate button from the following selections: 
•	 OK - to accept all specified alarm selections and dismiss the Alarm Selection GUI. 

 Alarm Manager GUI is displayed. 
•	 Apply - to accept all specified alarm selections without dismissing the Alarm 

Selection GUI. 
	 Repeat Steps 2 through 11 as necessary to specify additional alarm selection 

criteria. 
• Cancel - to dismiss the Alarm Selection GUI without accepting any alarm 

selections. 
 Alarm Manager GUI is displayed. 

12	 If alarm sound is desired, select Options → Sound On from the pull-down menu of the 
Alarm Manager GUI. 
• Sound On toggle button is yellow when the sound is on. 
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13	 If no alarms are to be reviewed, click on the OK button to exit from the Alarm Manager 
GUI. 
• Alarm Manager quits (is closed). 
• Job Activity Console (Ops Console) GUI is displayed. 

Specifying Job Selection Criteria 
The Production Monitor reviews job activities using the AutoSys Job Activity Console as 
described in the section of the lesson that follows this one. The AutoSys Job Selection GUI is 
used for specifying (filtering) the jobs to be reviewed, including setting the criteria for displaying 
jobs by name, status and/or machine. 

The procedure for specifying job selection criteria starts with the assumption that all applicable 
servers are currently running and the AutoSys GUI Control Panel (Figure 40) is being 
displayed. 

Specifying Job Selection Cri teria 

1 Click on the Ops Console button on the AutoSys GUI Control Panel. 
• The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 47) is 

displayed. 
2 Select View → Select Jobs from the pull-down menu. 

• The Job Selection GUI (Figure 50) is displayed. 
•	 Job Selection has the following default values: 

 All Jobs/Job Name for Select by Name. 
 All Statuses for Select by Status. 
 Al l Machines for Select by Machine. 
 Unsorted for Sort O rder. 

3 To select all jobs click on the All Jobs button. 
• When the All Jobs option is selected, the All Jobs button color changes to yellow. 

4	 To select a particular job by name, type the name of the desired job in the Job Name 
field. 
•	 When typing in either the Job Name field or the Box Name field, the corresponding 

toggle button is automatically turned on. (You do not have to click on the button, just 
start typing in the desired field.) 
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Figure 50. Job Selection GUI 

• The asterisk (*) wildcard character can be used for entering a partial job or box name 
(e.g., *.ceres*) 

To select a particular box by name, type the name of the desired box in the Box Name 
field then type in the Box Levels field how many levels of nesting you want to view for 
the box job. 
• In the Box Levels field any valid positive integer can be entered or the word “all.” 

 0 - indicates that only the top-level box specified in the Box Name field is to 
be displayed. 

 1 - indicates that the specified top-level box and all direct descendant boxes 
and enclosed jobs are to be displayed. 

 all - indicates that all jobs in the box are to be displayed. 
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6 To select all job statuses click on the All Statuses button. 
7	 To select jobs by status click on whichever of the following Select by Status toggle 

buttons properly describe(s) the status(es) to be selected: 
• Starting. 
• Running. 
• Success. 
• Failur e. 
• Terminated. 
• Restart. 
• Que Wait. 
• Activated. 
• Inactive. 
• On Hold. 
• On Ice. 

8 To select all machines click on the Al l Machines button. 
• Al l Machines button turns yellow. 

9	 To select jobs by the particular machine click on the name of the desired machine in the 
Select by Machine list. 
•	 To select multiple machines, click and hold on the first machine then drag the cursor 

to the name of the last machine to be selected and release the mouse button. 
• Selected machine(s) is (are) highlighted. 

10 Click on the desired order in the Sort Order  area. 
•	 The following options are available for Sort Order : 

 Start T ime. 
 End Time. 
 Job Name. 
 Job Status. 
 Machine Name. 
 Unsorted. 

11	 When the Job Selection GUI contains the desired set of job selection criteria, click on the 
appropriate button from the following selections: 
•	 OK - to accept all specified job selection criteria and dismiss the Job Selection GUI. 

 Job Activity Console GUI is displayed. 
 Job list based on the specified selection criteria is displayed in the Job List 

region of the Job Activity Console. 
•	 Apply - to accept all specified job selection criteria without dismissing the Job 

Selection GUI. 
	 Repeat Steps 3 through 11 as necessary to specify additional job selection 

criteria. 
• Cancel - to dismiss the Job Selection GUI without accepting any job selection 

criteria. 
 Job Activity Console GUI is displayed 
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Reviewing Job Activities 
The Production Monitor reviews job activities using AutoSys. The Job Activity Console is the 
primary interface that allows the operator to monitor all jobs that have been defined for AutoSys. 
The Job Selection GUI (described in the preceding section) is used for defining the criteria for 
displaying jobs on the Job Activity Console. 

The procedure for reviewing job activities starts with the assumption that all applicable servers 
are currently running and the AutoSys GUI Control Panel (Figure 40) is being displayed. 

Reviewing Job Activities 

1 Click on the Ops Console button on the AutoSys GUI Control Panel. 
•	 The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 47) is 

displayed. 
2	 Generate a list of jobs to be displayed on the Job Activity Console GUI by performing 

the procedure for Specifying Job Selection Cri teria (preceding section of this lesson). 
• Job list based on the specified selection criteria is displayed in the Job List region of 

the Job Activity Console. 
3 Review the Job List region of the Job Activity Console. 

•	 The following job characteristics are displayed in a table: 
 Job Name. 
 Descr iption. 
 Status. 
 Command. 
 Machine. 

4	 Click anywhere on a job row in the Job List region to have detailed information for that 
job displayed in the Currently Selected Job region of the display. 

5	 Review the data in the Currently Selected Job region of the display. 
• The following job details are displayed in the Currently Selected Job region of the 

Job Activity Console: 
 Job name (Currently Selected Job). 
 Machine Time (current time or time at which the frame was frozen). 
 Description. 
 Command. 
 Start T ime (and date). 
 End Time (and date). 
 Run Time. 
 Status. 
 Exit  Code. 
 Next Start. 
 Machine. 
 Queue Name. 
 Priority. 
 Num. of Tries. 
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6 Review the data in the Starting Conditions region of the display. 
•	 The following job starting conditions are displayed: 

 overall starting conditions (including all atomic conditions). 
 Identification of each Atomic Condition. 

⋅ Current State. 
⋅ T/F (true or false). 

•	 The starting conditions can be useful in determining what “upstream” job may be 
preventing the currently selected job from running. 

•	 An Atomic Condition is one of the most basic components of an overall starting 
condition; for example, if SUCCESS(JOB_X) and SUCCESS(JOB_Y) define the 
overall starting condition for a job, there are two atomic conditions, one of which is 
SUCCESS(JOB_X) and the other of which is SUCCESS(JOB_Y). 

•	 The T/F (true/false) flag indicates whether the corresponding atomic condition has 
been satisfied. 

•	 Clicking on one of the Atomic Conditions causes the job associated with that 
condition to become the currently selected job, with its details displayed in the 
Currently Selected Job region of the display. By checking the atomic conditions, it 
is possible to check the path of upstream dependencies to determine which job (if 
any) is preventing a particular job from running. 

	 Figure 51 shows how atomic conditions relate to job dependencies as displayed 
using JobScape. (In this case DPR3 and DPR12 are atomic conditions for 
DPR45.) 

 Note that clicking on one of the atomic conditions listed on the Job Activity 
Console does not actually cause the JobScape GUI to be displayed. 

7 In the Reports list click on the type of report to be reviewed then review the report in the 
Job Report region of the display: 
• The following types of reports can be selected: 

 Summary, which shows the result of the last execution of the job including the 
following types of information: 

⋅ Job Name 
⋅ Last Start 
⋅ Last End 
⋅ Status 
⋅ Run 
⋅ Pri/Xit 
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Figure 51. Atomic Conditions and Upstream Dependencies 

 Event, which lists all events from the last execution of the job including the 
following types of information: 

⋅ Status [Event] 
⋅ Time 
⋅ Ntry [number of tries] 
⋅ EventState [e.g., “Processed”] 
⋅ ProcessTime 
⋅ Machine 

 None. 
•	 The selected report is displayed. The color of the button corresponding to the 

selected report changes to yellow. 
•	 For a better view of a report, it is possible to expand the size of the GUI by grabbing a 

corner of the GUI with the mouse cursor and resizing as desired. 
8	 When all job activities have been adequately reviewed, click on the Exit  button to quit 

the Job Activity Console display. 
•	 AutoSys Job Activity Console Exit GUI is displayed to confirm the decision to quit 

the display. 
•	 Subsequent sections of this lesson describe features that are accessible through the 

Actions and Show regions of the Job Activity Console. 
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• Use and configuration of Alarm  functions were described in previous sections. 
9 Click on the OK button. 

• AutoSys Job Activity Console GUI quits (is closed). 
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Modifying Job Priority


Job Prio rity 
It is sometimes necessary to modify the priority of a job. For example, there may be a hardware 
or software problem that reduces the available resources to the point where some jobs are too 
large to be processed. Or it may become evident that due to the volume of large, high-priority 
jobs, some small, low-priority jobs will never be processed unless they are given higher priority. 

Job priorities are assigned using numbers according to the following rules: 

• 1 (one) has the highest priority.

• Higher-priority jobs (lower numerically) completely block lower-priority jobs.


 Prevents situations where a high-priority, resource-intensive job cannot obtain 
enough resources to run because smaller, lower-priority jobs continually grab 
the small amounts of resources available. 

The Production Monitor uses AutoSys when modifying job priority. The procedure for making 
the modification starts with the assumption that all applicable servers are currently running and 
the AutoSys GUI Control Panel (Figure 40) is being displayed. 

CAUTI ON 
The only field that may be modified on the Job Definition 
Advanced Features GUI is the Que Prior ity field. ECS 
cannot disable these GUI features, because AutoSys/ 
AutoXpert is a commercial off-the-shelf (COTS) product. 

Modifying Job Priority 

1 Click on the Job Definition button. 
• The Job Definition  GUI (Figure 52) is displayed. 

2 Type the name of the job with the priority to be modified in the Job Name field. 
•	 If necessary, you can select the name of the job from the list of all jobs in the database 

by typing the % wi ldcard character in the Job Name field, clicking on the Search 
button, and double-clicking on the appropriate job in the pop-up Selection List 
window. 

3 Click on the Adv Features button. 
• The Job Definition Advanced Features GUI (Figure 53) is displayed. 
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Figure 52. Job Definition GUI 
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Figure 53. Job D efinit ion A dvanced Feat ures GU I 

4	 In the Command Information  area of the Job Definition Advanced Features GUI, 
click in the Que Prior ity field and type in the desired priority value. 

•	 Remember that the only field you may change on the Job Definition Advanced 
Features GUI is the Que Prior ity. 

5 Click on the Save&Dismiss button. 

• The modified Que Prior ity value is saved. 

• The Job Definition GUI (Figure 52) is displayed. 

6 Click on the Exit  button to quit the Job Definition GUI. 
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Modifying Job Status


Job Status 

Sending an Event  to a Job 

At times the Production Monitor may need to modify a particular job in any of the following 
ways: 

• Start the job. 
• Kill the job. 
• Force the job to start. 
• Place the job on hold. 
• Take the job off hold. 
•	 Perform certain Job Management Client functions (described in a subsequent section 

of the lesson). 

Alternatively, the Production Monitor may need to generate one of the following types of 
reports: 

• Jobs Completed. 
• Jobs Waiting. 

The Production Monitor can initiate any of the preceding actions by clicking on the 
corresponding button in the Actions region of the Job Activity Console (Ops Console), 
Figure 47. However, there is an alternative method for accomplishing many of those operations. 
It involves the use of the Send Event GUI (Figure 54), which allows the Production Monitor to 
initiate any of the following actions: 

• Start the job. 
• Kill the job. 
• Force the job to start. 
• Place the job on hold. 
• Take the job off hold. 
• Change the job’s status. 
• Change the job’s priority. 
• Put the job on ice. 
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Figure 54. Send Event GUI 
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• Take the job off ice. 
• Stop the daemon (stop the Event Processor in an emergency). 
• Set a global value. 
• Send a signal concerning the job. 
• Make a comment (for example, why a job start was forced). 

The Production Monitor uses either the Ops Console or the AutoSys Send Event GUI to send an 
event to a job. The procedure starts with the assumption that all applicable servers are currently 
running and the AutoSys GUI Control Panel (Figure 40) is being displayed. 

CAUTI ON 
Once an event has been sent from the Send Event dialog, it 
may not be possible to cancel or modify it. 

Sending an Event to a Job 

1 Click on the Ops Console button on the AutoSys GUI Control Panel. 
•	 The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 47) is 

displayed. 
2	 Generate a list of jobs to be displayed on the Job Activity Console GUI by performing 

the procedure for Specifying Job Selection Cri teria. 
• Job list based on the specified selection criteria is displayed in the Job List region of 

the Job Activity Console. 
3 Review the Job List region of the Job Activity Console to identify the job with the 

status to be modified. 
4 In the Job List region of the Job Activity Console click on the job row corresponding to 

the job with the status to be modified. 
5	 In the Actions region of the Job Activity Console click on the button corresponding to 

the desired action to be taken with respect to the selected job (if there is a corresponding 
button). 
•	 Actions region of the Job Activity Console has the following buttons. 

 Start Job. 
 Kill Job 
 On Hold (Put job on hold). 
 Off Hold (Take job off hold). 
 Force Start Job. 
 Send Event (Send an event (signal) to a job). 
 Jobs Completed (Display a “Jobs Completed” report). 
 Jobs Waiting (Display a “Jobs Waiting” report). 
 Client Tool (Perform Job Management Client functions – described in a 

subsequent section of the lesson). 
•	 If there is no button corresponding to the desired action, modify job status using the 

Send Event GUI (continue with the next step). 
6	 Click on the Send Event button if there is no other button corresponding to the desired 

action in the Actions region of the Job Activity Console GUI. 
• The Send Event  GUI (Figure 54) is displayed. 
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•	 Send Event has the following default values. 
 Start Job for Event Type. 
 Now for Time. 
 Normal for Send Prior ity. 

7 Verify that the correct job is listed in the Job Name field of the Send Event GUI. 
• If not, click on the Cancel button and select the correct job (perform Steps 2 through 

6). 
8 Click on Event Type to select the desired type of job status to be modified. 

•	 Event Type has the following options. 
 Start Job. 
 Job On Hold. 
 Job Off Hold. 
 Comment. 
 Stop Demon. 
 Force Start Job. 
 Job On Ice. 
 Job Off Ice. 
 Kill Job. 
 Change Status. 
 Change Priority. 
 Set Global. 
 Send Signal. 

•	 Remember that a job with status of either “starting” or “running” cannot be put “on 
hold” or “on ice.” 

• Note that the GUI has an option to Cancel Previously Sent Event. 
9	 To enter the desired date and time when the job status is to be modified, either right away 

or at some time in the future, click on either Now or Future. 
• Select Now for immediate execution. (Current date and time are default values.) 
• Select Future for a future date and time. 

10	 If Future was selected in the previous step, perform Steps 10 through 12; otherwise go to 
Step 13. 

11 Type the date (in MM/DD/YY format) for future execution in the Date field. 
12 Type the time (in hh:mm format) for future execution in the Time field. 
13 Click on either A.M.  or P.M. as appropriate. 
14 Type any comments in the Comment field. 

•	 Comment is a free-form field for entering text that should be associated with the 
event in the database. 

 For example, explain why the selected “send event” was initiated. 
15 Review the AUTOSERV In stance field. 

•	 Instance field specifies the instance of AutoSys/AutoXpert to which the event will be 
sent. (You can send events to instances of AutoSys/AutoXpert other than the one you 
are running.) 

•	 The current AutoSys/AutoXpert instance should be displayed by default in the 
AUTOSERV In stance field. 
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•	 If the event specified in the Event Type field should be sent to a different instance of 
AutoSys/AutoXpert, type the name of the other instance in the AUTOSERV 
Instance field. 

16 Review the Global Name and Global Value fields. 
•	 Global Name and Global Value are accessible only if Set Global was selected in the 

Event Type region. 
• If Set Global was specified in the Event Type field, type the appropriate entries in 

the Global Name and Global Value fields. 
17 Review the Signal field. 

•	 Signal is accessible only if Send Signal or Kill Job  was selected in the Event Type 
region. 

•	 If either Send Signal or Kill Job  was specified in the Event Type field, type the 
appropriate signal number(s) in the Signal field. 

 Table 8 is a list of UNIX signals. 
18 Review the Queue Priori ty entry. 

•	 Queue priority can be changed only if Change Priority was selected in the Event 
Type region. 

• If the queue priority is to be changed, type the new priority in the Queue Priori ty 
field. 

19 Review the Status option menu. 
• Status can be changed only if Change Status was selected in the Event Type region. 
•	 Click on the Status button and select (from the pick-list) the job status to which the 

job should be changed. 
•	 Status has the following options. 

 Running. 
 Success. 
 Failur e. 
 Terminated. 
 Starting. 
 Inactive. 

20 Review the Send Prior ity radio buttons. 
• Send priority refers to the priority for sending the event (not the job priority). 
•	 If the send priority is to be changed, click on the button corresponding to the desired 

send priority. 
•	 Send Prior ity has the following options. 

 Normal. 
 High. 

• High priority is reserved for emergencies. 
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Table 8. UNIX Signals 
NAME VALUE DEFAULT EVENT 

HUP 1 Exit Hangup. 
INT 2 Exit Interrupt. 
QUIT 3 Core Quit. 
ILL 4 Core Illegal Instruction. 
TRAP 5 Core Trace/Breakpoint Trap. 
ABRT 6 Core Abort. 
EMT 7 Core Emulation Trap. 
FPE 8 Core Arithmetic Exception. 
KILL 9 Exit Killed. 
BUS 10 Core Bus Error. 
SEGV 11 Core Segmentation Fault. 
SYS 12 Core Bad System Call. 
PIPE 13 Exit Broken Pipe. 
ALRM 14 Exit Alarm Clock. 
TERM 15 Exit Terminated. 
USR1 16 Exit User Signal 1. 
USR2 17 Exit User Signal 2. 
CHLD 18 Ignore Child Status Changed. 
PWR 19 Ignore Power Fail/Restart. 
WINCH 20 Ignore Window Size Change 
URG 21 Ignore Urgent Socket Condition. 
POLL 22 Exit Pollable Event. 
STOP 23 Stop Stopped (signal). 
TSTP 24 Stop Stopped (user). 
CONT 25 Ignore Continued. 
TTIN 26 Stop Stopped (tty input). 
TTOU 27 Stop Stopped (tty output). 
VTALRM 28 Exit Virtual Timer Expired 
PROF 29 Exit Profiling Timer Expired. 
XCPU 30 Core CPU time limit exceeded. 
XFSZ 31 Core File size limit exceeded. 
WAITING 32 Ignore Concurrency signal reserved by threads library 
LWP 33 Ignore Inter-LWP signal reserved by threads library. 
FREEZE 34 Ignore Check point Freeze 
THAW 35 Ignore Check point Thaw 
CANCEL 36 Ignore Cancellation signal reserved by threads library. 
RTMIN * Exit First real time signal 
(RTMIN+1) * Exit Second real time signal 
(RTMAX-1) * Exit Second-to-last real time signal. 
RTMAX * Exit Last real time signal 

*The symbols RTMIN through RTMAX are evaluated dynamically in order to permit future 
configurability. 
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21 Click on the Execute button then click on the Yes button to enable the modified event. 
• Job Activity Console (Ops Console) GUI is displayed. 
•	 Once an event has been sent from the Send Event dialog, it may not be possible to 

cancel or modify it. 

Canceling a Sent  Event 

It may be possible to cancel an event sent to an AutoSys job, especially if the event was 
previously scheduled for sometime in the future. 

The Production Monitor uses the AutoSys Send Event GUI to cancel an event sent to a job. The 
procedure starts with the assumption that all applicable servers are currently running and the Job 
Activity Console GUI (Figure 47) is being displayed. 

Canceling a Sent Event 

1	 Click on the Send Event button in the Actions Region of the Job Activity Console. 
• The Send Event  GUI (Figure 54) is displayed. 

2	 Click on Event Type to select the type of event that was sent to the job and is to be 
canceled. 

3 Click on the Cancel Previously Sent Event radio button. 
4 Verify that the correct job is listed in the Job Name field of the Send Event GUI. 

• Type the job name in the Job Name field if necessary. 
•	 Not necessary for the following types of events: 

− SET_GLOBAL 
− STOP_DEMON 
− ALARM 
− COMMENT 

5 Click on the Execute button then click on the Yes button to enable the modified event. 
• The event is cancelled. 
• Job Activity Console (Ops Console) GUI is displayed. 

Performing Job Management Client Functions 

It is possible to perform the following Job Management Client functions from AutoSys by 
clicking on the Client Tool button in the Actions region of the Job Activity Console 
(Figure 47): 

• Create DPR Job. 
• Release DPR Job. 
• Cancel DPR Job. 
• Change DPR ID. 
• View Job Management DPR Queue. 
• Create Ground Event Job. 
• Cancel Ground Event Job. 
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Clicking on the button invokes the Job Management Client program. Using this interface to the 
ECS PDPS Processing software maintains synchronization with the PDPS database. For 
example, jobs should not be deleted using the AutoSys Job Definition GUI because it does not 
communicate with the PDPS database. 

The Production Monitor starts the process of performing Job Management Client functions from 
the AutoSys Job Activity Console (Ops Console). The procedure starts with the assumption 
that all applicable servers are currently running and the AutoSys Job Activity Console 
(Figure 47) is being displayed. 

Performing Job Management Client Functions 

1 Verify that the job with the status to be modified is listed in the Currently Selected Job 
field of the Job Activity Console (Ops Console) . 
• Click on the job row in the Job List region of the Job Activity Console if necessary. 

 Information concerning the selected job is displayed in the Currently Selected 
Job region of the Job Activity Console (Figure 47). 

2 Click on the Client Tool button in the Actions Region of the Job Activity Console. 
• The Ready to Invoke (Job Management Client) dialog box (Figure 55) is displayed. 

3 Click on the yes button. 
• The dialog box closes. 
• The Job Activation User Interface window (Figure 56) is displayed. 
•	 The following menu options are displayed: 

 0) Exit 
1) Create Dpr Job 
2) Release Dpr Job 
3) Cancel Dpr Job 
4) Change Dpr Id 
5) View Job Management Dpr Queue 
6) Create Ground Event Job 
7) Cancel Ground Event Job 

4 Enter  the number corresponding to the desired function at the enter an option prompt. 
5 Enter  responses to Job Management Client prompts. 
6 Enter 0 at the enter an option prompt to quit the Job Management Client. 

Figure 55. Ready to Invoke (Job Management Client) Dialog Box 
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Figure 56. Job Activation User Interface W indow 
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Reviewing Activity and Job Dependency Logs


Reviewing an Activity Log 
The Production Monitor reviews the activity log to obtain the following types of information: 

• which jobs have been completed. 
• which jobs are currently running. 
• which jobs are in the queue. 

The Production Monitor reviews the activity log using the AutoSys autorep command. The 
autorep command reports information about a job, jobs within boxes, machines, and machine 
status. Figure 57 shows a sample activity log. 

-------------------------------------< Date: 06/14 21:52:04 >-----------------------------

EVENT: CHANGE_STATUS STATUS:  STARTING JOB: stage.DPR_04 

EVENT: CHANGE_STATUS STATUS:  RUNNING JOB: stage.DPR_04 

EVENT: CHANGE_STATUS STATUS:  SUCCESS JOB: stage.DPR_04 

-------------------------------------< Date: 06/14 21:53:04 >-----------------------------

EVENT: CHANGE_STATUS STATUS:  STARTING JOB: prepare.DPR_08 

EVENT: CHANGE_STATUS STATUS:  RUNNING JOB: prepare.DPR_08 

EVENT: CHANGE_STATUS STATUS:  SUCCESS JOB: prepare.DPR_08 

Figure 57. Sample Activity Log 

The procedure starts with the assumption that the Production Monitor has logged in to the 
system. 
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Reviewing an Activity Log 

NOTE: Commands in Steps 1 through 9 are typed at a UNIX system prompt. 
1	 At the UNIX command line prompt type xhost hostname then press the Return/Enter 

key on the keyboard. 
•	 hostname refers to the host on which GUIs are to be launched during the current 

operating session. Multiple hostnames can be specified on the same line. 
• The use of xhost + is discouraged because of a potential security problem. 

2 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
•	 Use either the X terminal/workstation IP address or the machine-name for the 

clientname. 
•	 When using secure shell, the DISPLAY variable is set just once, before logging in to 

remote hosts. If it were to be reset after logging in to a remote host, the security 
features would be compromised. 

3 Open another UNIX (terminal) window. 
4	 Start the log-in to the Queuing Server host by typing /tools/bin/ssh hostname (e.g., 

e0sps04, g0sps06, l0sps03, or n0sps08) in the new window then press the Return/Enter 
key. 
•	 If you receive the message, Host key not found from the list of known hosts. Are 

you sure you want to continue connecting (yes/no)? type yes (“y”  alone will not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 5. 

• If you have not previously set up a secure shell passphrase; go to Step 6. 
5	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 7. 

6	 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

7 Type cd /path then press Return/Enter. 
•	 Change directory to the directory (e.g., /usr/ecs/MODE/COTS/autotreeb/autouser, 

/usr/ecs/MODE/COTS/autotree/autouser, /data1/SHARED/COTS/autotree/autouser) 
containing the set-up files (e.g., FMR.autosys.csh.g0sps06). 

• The particular path to be typed may vary from site to site. 
8 Type source AUTOSYSINSTANCE.autosys.csh.hostname then press Return/Enter. 

• The source command sets the environment variables. 
9	 Type autorep -J ALL unless the command needs to be modified in one of the following 

ways: 
• To specify a particular job, type the job name instead of ALL. 
•	 To obtain a machine report, type -M machine_name after either ALL  or the job 

name. 
• To obtain a summary report, type -s after either ALL  or the job name. 
• To obtain a detailed report, type -d after either ALL  or the job name. 
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• To obtain a query report, type -q after either ALL  or the job name. 
•	 To display the document one page at a time, type either  | pg  or | more  after typing 

the code for whichever of the preceding options are desired. 
•	 To print the document, type | lp after typing the code for whichever of the preceding 

options are desired. 
• To save the report in a file, type > /path/filename after either ALL  or the job name. 

10 Press the Return/Enter key on the keyboard to obtain access to the Activity L og. 
• The Activity L og (Figure 57) is displayed. 
• If | lp was typed on the command line, the Activity L og is printed. 
• If > /path/filename was typed on the command line, the Activity L og is has been 

saved under the specified filename. 
11 Review the Activity L og to determine job states. 

• Completed. 
• Currently running. 
• In the queue. 

Reviewing a Job Dependency Log 
The Production Monitor reviews a job dependency log using the AutoSys job_depends 
command. The job_depends command reports information about the dependencies and 
conditions of jobs. The command can be used for determining the current state of a job, its job 
dependencies, the dependencies and nested hierarchies (for boxes) as specified in the job 
definition, and a forecast of what jobs will run during a given period of time. 

The procedure starts with the assumption that the Production Monitor has logged in to the 
system. 

Reviewing a Job Dependency Log 

1	 Set up AutoSys as described in Steps 1 through 8 of the procedure for Reviewing an 
Activity L og. 

2	 Type job_depends -c -J ALL unless the command needs to be modified in one of the 
following ways: 
• To specify a particular job, type the job name instead of ALL . 
• To obtain the current condition status, type -c before -J. 
• To obtain the dependencies only, type -d before -J. 
• To obtain the time dependencies, type -t before -J. 
•	 To display the document one page at a time, type either  | pg  or | more  after typing 

the code for whichever of the preceding options are desired. 
•	 To print the document, type | lp after typing the code for whichever of the preceding 

options are desired. 
• To save the report in a file, type > /path/filename after either ALL  or the job name. 

3 Press the Return/Enter key on the keyboard to obtain access to the Activity Log. 
• The Job Dependency Log (Figure 58) is displayed. 
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• If | lp was typed on the command line, the Job Dependency Log is printed. 
•	 If > /path/filename was typed on the command line, the Activity L og is has been 

saved under the specified filename. 
4	 Review the Job Dependency Log to determine job status, including the status of atomic 

conditions. 

Job Name Status Date Cond? Start Cond? Dependent Jobs? 

DPR## Activated  No  Yes No 

Condition:  (success(DPR_##) and exit code(execute.DPR_##)<5) 

Atomic Conditi on Current Status T/F 

SUCCESS(SPR_##) SUCCESS T 

EXIT_CODE(execute.DPR_##) SUCCESS  F 

Figure 58. Sample Job Dependency Log 
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Defining and Running Monitors/Browsers


Defining Moni tor s/Browser s 
The current edition of the Version 2.0 Operations Tools Manual for the ECS Project 
(609-CD-003-002) indicates that ECS does not support the AutoSys monitor/browser 
capabilities. However, they are functional and the Production Monitor can use them. 

Although some Production Monitors may wish to monitor all events, it is more likely that they 
will prefer to limit monitoring to alarms and changes of job status (e.g., from “running” to 
“success” or “failure”). They use the browser function (Figure 59) to determine such things as 
the current status of a particular job or which jobs presently have a particular status (e.g., which 
jobs, if any, are on hold). 

Figure 59. Sample B rowser Screen 

The procedure for defining monitors or browsers starts with the assumption that all applicable 
servers are currently running, AutoSys has been launched, and the AutoSys GUI Control Panel 
(Figure 40) is being displayed. 
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Defining Monitors/Browsers 

1 Click on the Monitor/Browser button on the AutoSys GUI Control Panel. 
• The Monitor/Browser GUI (Figure 60) is displayed. 

2 Type a name for the monitor or browser in the Name field near the top of the GUI. 
• Name must be in valid file-name format. 
• If a pre-defined monitor or browser is desired, use the Search button under the Name 

field to call it up. 
3 Click on either the Alarms button or the ALL EVENTS  button for Types of Events. 
4 Click on either ALL Job Status Events or the corresponding toggle button(s) to select 

individual Job Status Events. 
•	 Any or all of the following Job Status Events can be selected: 

 Running. 

 Success. 

 Failur e. 

 Terminated. 

 Starting. 

 ReStarting. 

 On Ice. 

 On Hold. 
5 Click on the corresponding toggle button to select the desired Job Selection Criteria. 

•	 Job selection criteria options are as follows: 
 All Jobs. 
 Box with its Jobs. 
 Single Job. 

6 If Single Job was selected in the previous step, type the job name in the Job Name field. 
7 Click on the corresponding toggle button to select the desired Monitor Options. 

•	 Monitor Options refers to one of the following choices: 
 Sound. 
 Veri fication Required for Al arms. 
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Figure 60. Monitor/Browser GUI 

8	 Click on Yes or No to select the desired Current Run Time and/or Events After Date/ 
Time, which are the Browser Time Criteria. 

9	 If Events After Date/Time was selected in the previous step, type the starting date and 
time (in MM/DD/YY hh:mm formats) in the Events After Date/Time field. 

10 Click on the corresponding toggle button to select the desired Mode. 
•	 The following options are available: 

 Monitor. 
 Browser. 

• If Monitor  is selected, settings are defined for a monitor. 
• If Browser is selected, settings are defined for a report. 

11 Click on the Save button. 
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• The monitor or browser definition is saved to the database. 
• Before running a monitor or browser you must Save the monitor/browser definition 

first. 
12 Click on the Run MonBro button to run the monitor/browser that has just been defined. 
13 Review the monitor/browser results. 
14 Type Ctrl-C to exit from a browser or monitor. 

Runni ng Moni tor s/Browser s 
There are two procedures for running monitors/browsers. Monitors/browsers may be run from 
the Monitor/Browser GUI as described in the preceding procedure or they may be run using 
UNIX commands. In either case, the procedure starts with the assumption that the Production 
Monitor has logged in to the system. 

Running Monitors/Browsers Using UNIX Commands 

1	 Set up AutoSys as described in Steps 1 through 8 of the procedure for Reviewing an 
Activity L og. 

2	 Type monbro -N name &  then press the Return/Enter key on the keyboard to run the 
previously defined monitor/browser. 

•	 The monitor or report (browser) must have been previously defined and saved under 
an appropriate file name using the Monitor/Browser GUI. 

• The report is displayed. 

• Refer to the AutoSys User Manual for all options and displays for all monbro reports. 

3 Review the monitor/browser results. 

4 Type Ctrl-C to exit from a browser or monitor. 
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Changing the Database Maintenance Time


Database Maintenance Time 
Once a day the Event Processor goes into an internal database maintenance cycle. During this 
time, it does not process any events and it waits for the maintenance activities to be completed 
before resuming normal operations. The time of day for start-up of the maintenance cycle is pre­
set to 3:30 AM. The database maintenance cycle takes approximately one minute.  If it is 
necessary to change the time when the maintenance cycle occurs, the Production Monitor can 
reset it, preferably to a time when there is minimal activity. 

The procedure for changing the database maintenance time starts with the assumption that the 
Production Monitor has logged in to the system. 

Changing the Database Maintenance Time 

NOTE: Commands in Steps 1 through 8 are typed at a UNIX system prompt. 
1	 At the UNIX command line prompt type xhost hostname then press the Return/Enter 

key on the keyboard. 
•	 hostname refers to the host on which GUIs are to be launched during the current 

operating session. Multiple hostnames can be specified on the same line. 
• The use of xhost + is discouraged because of a potential security problem. 

2 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
•	 Use either the X terminal/workstation IP address or the machine-name for the 

clientname. 
•	 When using secure shell, the DISPLAY variable is set just once, before logging in to 

remote hosts. If it were to be reset after logging in to a remote host, the security 
features would be compromised. 

3 Open another UNIX (terminal) window. 
4	 Start the log-in to the Queuing Server host by typing /tools/bin/ssh hostname (e.g., 

e0sps04, g0sps06, l0sps03, or n0sps08) in the new window then press the Return/Enter 
key. 
•	 If you receive the message, Host key not found from the list of known hosts. Are 

you sure you want to continue connecting (yes/no)? type yes (“y”  alone will not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 5. 

• If you have not previously set up a secure shell passphrase; go to Step 6. 
5	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 7. 

6	 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 
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7 Type cd /path then press Return/Enter. 
•	 Change directory to the directory (e.g., /usr/ecs/MODE/COTS/autotreeb/autouser, 

/usr/ecs/MODE/COTS/autotree/autouser, /data1/SHARED/COTS/autotree/autouser) 
containing the config.AUTOSYSINSTANCE file. 

• The particular path to be typed may vary from site to site. 
8 Type vi config.AUTOSYSINSTANCE  then press Return/Enter. 

• The configuration file is displayed by the vi text editor. 
9	 Using vi editor commands find DBMaintTime= and replace the existing time with the 

desired time in 24 hour format (hh:mm). 
•	 The time may already have been changed to some value other than 03:30 (e.g., 

DBMaintTime=04:00). 
•	 The following vi editor commands are useful: 

 h (move cursor left) 
 j  (move cursor down) 
 k (move cursor up) 
 l (move cursor right) 
 i (insert text) 
 x (delete a character) 
 u (undo previous change) 
 Esc (switch to command mode) 

10 Press the Esc key. 
11 Type ZZ. 

• New database maintenance time is entered and saved in the configuration file. 
• UNIX prompt is displayed. 
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Troubleshooting Processing Problems


Troubl e Symptoms 
Troubleshooting is a process of identifying the source of problems on the basis of observed 
trouble symptoms. One common source of problems involves connections with other 
subsystems for the transmission of messages or data. Like many other operational areas in ECS, 
processing has interfaces with many other subsystems. Consequently, problems with processing 
can be traced to either the Data Processing Subsystem or one of many other ECS subsystems, 
including (but not necessarily limited to) those in the following list: 

• Planning Subsystem (PLS). 
• Data Server Subsystem (DSS). 
• Interoperability Subsystem (IOS). 
• Communications Subsystem (CSS). 

Table 9 describes actions to be taken in response to some common Processing problems. If the 
problem cannot be identified and fixed without help within a reasonable period of time, the 
appropriate response is to call the help desk or submit a trouble ticket in accordance with site 
Problem Management policy. 

Table 9. Troubleshooting Processing Problems (1 of 2) 
Symptom Response 

Unable to log in to the Queuing 
Server host (e.g., g0sps06). 

Check with the Operations Controller/System Administrator to 
ensure that the host is “up." 

GUI not displayed when the start-up 
script has been properly invoked. 

1. ure that the DISPLAY variable was set properly. 
2. ure that the xhost command was given on the initial login 
host. 
[For detailed instructions refer to the procedure for Launching 
Production Processing Applications  (previous section of this 
lesson).] 

AutoSys job hangs (does not 
complete within the predicted time 
period). 

Refer to the procedure for Handling a Job that is Hanging in 
Aut oSys (subsequent section of this lesson). 

“Allocate” job fails. Refer to the procedure for Handling an Allocation Job P roblem 
(subsequent section of this lesson). 

“Stage” job fails. Refer to the procedure for Handling a S taging Job P roblem 
(subsequent section of this lesson). 

“Preprocess” job fails. Refer to the procedure for Handling a Preprocessing Job 
Problem  (subsequent section of this lesson). 

Ens
Ens
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Table 9. Troubleshooting Processing Problems (2 of 2) 
“Execute” job fails. 1. Ensure (e.g., using ECS Assistant) that the necessary hosts 

and servers (listed in Table 10) are “up.” 
2. If hosts/servers have gone down, notify the Operations 
Controller/System Administrator to have servers brought back up 
using HP OpenView. 
3. If hosts/servers are all “up,” refer the problem to SSI&T 
personnel. 

“Post-process” job fails. Refer to the procedure for Handling a Post processing Job 
Problem  (subsequent section of this lesson). 

“Insert” job fails. Refer to the procedure for Handling an Inser tion Job P roblem 
(subsequent section of this lesson). 

“Deallocate” job fails. 1. Ensure (e.g., using ECS Assistant) that the necessary hosts 
and servers (listed in Table 10) are “up.” 
2. If hosts/servers have gone down, notify the Operations 
Controller/System Administrator to have servers brought back up 
using HP OpenView. 
3. If hosts/servers are all “up,” check the log files (e.g., 
DPR#.ALOG) in the /usr/ecs/MODE/CUSTOM/logs directory for 
error messages. 
[For detailed instructions refer to the procedure for Checking Log 
Files  (subsequent section of this lesson).] 

Other problems. Check the log files (e.g., EcDpPrJobMgmt.ALOG, 
EcDpPrDeletion.ALOG, DPR#.ALOG, DPR#.err) in the 
/usr/ecs/MODE/CUSTOM/logs directory for error messages. 
[For detailed instructions refer to the procedure for Checking Log 
Files  (subsequent section of this lesson).] 

Table 10. Hosts, Servers, C lient s and Ot her Sof tware Relevant to 
ECS Data Processing Phases( 1 of 2) 

HOST 

SERVER/CLIENT/OTHER SOFTWARE 

NOTE:  Servers that are displayed on ECS 
Assistant are shown in boldface ty pe in the table. 

NOTE:  Depending on the installation, software 
may be loaded on hosts other than the examples 
provided. 

PROCESSING PHASE 

A 
L 
L 
O 
C 
A 
T 
E 

S 
T 
A 
G 
E 

P 
R 
E 
P 
R 
O 
C 
E 
S 
S 

E 
X 
E 
C 
U 
T 
E 

P 
O 
S 
T 
P 
R 
O 
C 
E 
S 
S 

I 
N 
S 
E 
R 
T 

D 
E 
A 
L 
L 
O 
C 
A 
T 
E 

Science Processor (e.g., x0spg01) X X X X X X X 

PGE Management (EcDpPrRunPGE) X 

Resource Usage (EcDpPrRusage) X 

PGE X 
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Table 10. Hosts, Servers, C lient s and Ot her Sof tware Relevant to 
ECS Data Processing Phases( 2 of 2) 

HOST 

SERVER/CLIENT/OTHER SOFTWARE 

NOTE:  Servers that are displayed on ECS 
Assistant are shown in boldface ty pe in the table. 

NOTE:  Depending on the installation, software 
may be loaded on hosts other than the examples 
provided. 

PROCESSING PHASE 

A 
L 
L 
O 
C 
A 
T 
E 

S 
T 
A 
G 
E 

P 
R 
E 
P 
R 
O 
C 
E 
S 
S 

E 
X 
E 
C 
U 
T 
E 

P 
O 
S 
T 
P 
R 
O 
C 
E 
S 
S 

I 
N 
S 
E 
R 
T 

D 
E 
A 
L 
L 
O 
C 
A 
T 
E 

Queuing Server (e.g., x0sps04) X X X X X X X 
Job Management  Server ( EcDpPrJobMgmt ) X X X X X X X 
Delet ion Server ( EcDpPrDelet ion) X X X X X X X 
Data Management (EcDpPrDM) X X 
Execution Management (EcDpPrEM) X X X X 
Resource Management (EcDpPrRM) X X X X 
Subscript ion Manager 
(EcDpPlSubMgr ) 

Distribution Server (e.g., x0dis02) X X X 
Distr ibution S erver 
(EcDsDist ribut ionServer) 

X X X 

SDSRV Server (e.g., x0acs05) X X X 
Science Dat a Server 
(EcDsScienceDat aServer) 

X X X 

APC Server (e.g., x0acg01) X X X 
Archive Server 
(EcDsSt ArchiveServer) 

X X X 

FTP Distr ibution S erver 
(EcDsSt FtpDisServer) 

X X X 

Staging Monitor  Server 
(EcDsSt StagingMonit orServer) 

X X X 

Staging Disk Server 
(EcDsSt StagingDiskServer) 

X X X 

Pull Mo nitor Server 
(EcDsSt PullMonit orServer) 

Interface Server 01 (e.g., x0ins02) X X X 
Advert ising Server ( EcIoAdServer) X X X X 

Interface Server 02 (e.g., x0ins01) X X X 
Subscript ion Server 
(EcSbSubServer ) 

X X X 

Event  Server ( EcSbEvent Server) 
Data Dict ionary ( EcDmDict Server) 
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Handl ing a Job that i s Hangi ng i n AutoSys 
If an AutoSys job is hanging, the job symbol in AutoSys JobScape, TimeScape, or HostScape 
GUI will have turned green to indicate that the job is running but it would not have turned either 
red (“ failed”) or light blue (“success”) within the predicted period of time. The following 
conditions can cause an AutoSys job to hang: 

•	 The Science Data Server (SDSRV) may be waiting for a request to Data Distribution 
(DDIST) to distribute files (e.g., the PGE tar file in the allocation job or input data in 
staging) but cannot because Storage Management (STMGT) is down. 

•	 The Science Data Server (SDSRV) may be waiting for a request to Data Distribution 
(DDIST) to distribute files (e.g., the PGE tar file in the allocation phase or input data 
in staging); however, Storage Management (STMGT) cannot ftp the file to the data 
directory on the science processor disk, so DDIST cannot distribute the files. 

• The SDSRV may be “down.” 

The procedure for Handling a Job that is Hanging in AutoSys starts with the assumption that the 
operator has logged in to the ECS system and the Queuing Server host(e.g., g0sps06). 

Handling a Job that is Hanging in AutoSys 

1	 Access a terminal window logged in to the Queuing Server host (e.g., e0sps04, g0sps06, 
l0sps03, n0sps08). 

2 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 
• Change directory to the directory containing the DPR .err files (e.g., 

ACT#syn1#004130123TS1.err). 
3 Type /usr/xpg4/bin/tail -f -n 20 filename then press Return/Enter. 

•	 filename refers to the DPR .err file to be reviewed (e.g., 
ACT#syn1#004130123TS1.err). 

• The last 20 lines of the .err file are displayed and additional data (if any) is displayed 
as it is written to the file. 

4 Review the .err file to identify problems that are occurring or have occurred. 
• Most likely either nothing is being written to the file or the job is in a retry loop. 

5	 If the job is in a retry loop, verify (e.g., using ECS Assistant) that the hosts/server 
processes necessary for the affected job are “up.” 
• The SDSRV may be down. 
•	 The first retry is designed to fail, because the software is retrieving server-side 

information to refresh the client side at this point. 
• Refer to Table 10 to determine which hosts/servers are critical to the job. 

6	 If hosts/servers have gone down, notify the Operations Controller/System Administrator 
to have servers brought back up using HP OpenView. 
•	 Go to the procedure for Force-Starti ng a Job (subsequent section of this lesson) after 

the problem has been corrected. 
7	 If nothing is being written to the .err file, ask the Ingest/Distribution Technician to check 

whether the distribution request has been suspended with errors. 
•	 If the distribution request has been suspended with errors, the Ingest/Distribution 

Technician should take the following actions: 
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− Requests the Operations Controller/System Administrator to bounce the 
STMGT servers. 

− “Resumes” the distribution request. 
− Verifies that the distribution request resumes processing. 

8	 If the distribution request resumes processing after the Ingest/Distribution Technician has 
taken action, go to the procedure for Force-Starti ng a Job (subsequent section of this 
lesson). 

9	 If the distribution request does not resume processing, log in to the Science Processor 
host (e.g., e0spg01, g0spg01, l0spg01, n0spg03) as described in Steps 1 through 5 of the 
procedure for Launching Production Processing Applications (previous section of this 
lesson). 

10	 Type cd  /usr/ecs/MODE/CUSTOM /pdps/processor/data/DpPrRm/processor_disk 
then press Return/Enter. 
•	 processor refers to the Science Processor host (e.g., e0spg01, g0spg01, l0spg01, 

n0spg03). 
•	 The processor_disk directory (e.g., g0spg01_disk) is the target directory where the 

data server puts the inputs needed for processing. 
11	 If the target directory does not exist, notify the Operations Controller/System 

Administrator to have it restored. 
• Go to the procedure for Force-Starti ng a Job (subsequent section of this lesson) after 

the problem has been corrected. 
12 If the target directory does exist, try to ftp a file to the directory on the science processor. 
13 Notify the Operations Controller/System Administrator of the results of the attempt to ftp 

a file to the target directory. 
•	 Go to the procedure for Force-Starti ng a Job (subsequent section of this lesson) after 

the problem has been corrected. 

Force- Start ing a Job 

The procedure for Force-Starting a Job starts with the assumption that AutoSys has been 
launched and either JobScape (Figure 44) or TimeScape (Figure 43) is being displayed. 

Force-Starti ng a Job 

Click and hold on the applicable job symbol in the AutoSys JobScape or TimeScape GUI 
with the right  mouse button 
• Descendants pop-up menu appears. 
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2	 Select (highlight) Force Start Job from the Descendants pop-up menu (release the right 
mouse button). 
•	 The job symbol in AutoSys JobScape or TimeScape GUI should turn green 

(“starting”) within a short period of time. 
3	 If the job symbol in AutoSys JobScape or TimeScape GUI does not turn green 

(“starting”) within a short period of time, return to Step 1. 

Handling an Allocation Job Problem 
If the allocation job fails, the ALOG file on the Data Processing host can be checked to see 
whether the PGEEXE.tar fi le was successfully acquired. If there is an acquire failure, the 
appropriate action is to perform the procedure for Handling an Acquir e Failure (subsequent 
section of this lesson). 

The procedure for checking the Allocation Job ALOG file starts with the assumption that the 
operator has logged in to the ECS system and the Queuing Server host (e.g., g0sps06). 

Checking the Allocation Job ALOG File 

1 Access a terminal window logged in to the Queuing Server host (e.g., g0sps06). 
2 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

• Change directory to the directory containing the data processing log files (e.g., 
ACT#syn1#004130123TS1.ALOG). 

3 Type pg filename then press Return/Enter. 
•	 filename refers to the data processing log file to be reviewed (e.g., 

ACT#syn1#004130123TS1.ALOG). 
• The first page of the log file is displayed. 
• Although this procedure has been written for the pg command, any UNIX editor or 

visualizing command (e.g., vi, view, more, tail) can be used to review the log file. 
4 Review the log file to determine whether the PGEEXE.tar file was successfully acquired. 
5 If the PGEEXE.tar file was successfully acquired, go to the procedure for Force-Starti ng 

a Job (previous section of this lesson). 
6 If there is an acquire failure, perform the procedure for Handling an Acquir e Failure 

(subsequent section of this lesson). 

Handling an Acquire Failure 

Diagnosing an acquire failure involves examining the following system log files and directories 
involved in the process: 

• Science Data Server ALOG File (EcDsScienceDataServer.ALOG file). 
• Archive Server ALOG File (EcDsStArchiveServer.ALOG) 
•	 Staging Area 

− Presence of the relevant fi le 
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− Staging Disk ALOG File (EcDsStStagingDiskServer.ALOG or 
EcDsStStagingMonitorServer.ALOG) 

− Space available in the staging area 

Checking t he Science D ata Server A LOG File 

The procedure for checking the EcDsScienceDataServer.ALOG file starts with the assumption 
that the operator has logged in to the ECS system. 

Checking the Science Data Server ALOG File 

1	 Log in to the SDSRV Server host (e.g., e0acs05, g0acs03, l0acs03, n0acs04) as described 
in Steps 1 through 5 of the procedure for Launching Production Processing 
Applications (previous section of this lesson). 

2 Type cd /usr/ecs/mode/CUSTOM/ logs then press Return/Enter. 
3 Type view EcDsScienceDataServer.ALOG then press Return/Enter. 

• Although this procedure has been written for the view command, any UNIX editor or 
visualizing command (e.g., vi, pg, more, tail) can be used to review the log file. 

4 Review the log file to determine whether the relevant file was successfully acquired. 
•	 The EcDsScienceDataServer.ALOG file should contain entries identifying the file to 

be acquired by the ShortName of the corresponding ESDT. 
•	 The EcDsScienceDataServer.ALOG file should contain entries regarding the acquire 

activity. The following types of messages should be included in the ALOG file: 
Msg: File 1 to be distributed: :SC:MOD03.001:1369:1.HDF-EOS

Priority: 0 Time : 07/29/98 12:35:42

PID : 24279:MsgLink :1684108385 meaningfulname

:DsSrWorkingCollectionDistr ibuteOneDistr ibutFile

Msg: File 2 to be distributed: SCMOD03.0011369.met


•	 If the ShortName does not appear in the ALOG file, with a timestamp corresponding 
to the time of the attempted acquire, SDSRV may not be running, or may not be 
communicating with other servers. 

•	 If the ALOG file does contain entries for that ShortName, and indicates that two files 
(the file and its associated metadata file) are being distributed, SDSRV has completed 
its role in the acquire. 

•	 If the ALOG contains the ShortName, and also contains an error showing that the 
data file time stamp does not match the time stamp required by the acquire, the data 
file needs to be removed from the Science Data Server and reinserted. 

− This is usually done using a script called DsDbCleanGranules. 
5 Type :q!  then press Return/Enter to quit the view application. 
6 If the ShortName does not appear in the ALOG file, with a timestamp corresponding to 

the time of the attempted acquire, ensure (e.g., using ECS Assistant) that the necessary 
hosts and servers (listed in Table 10) are “up.” 
•	 If hosts/servers have gone down, notify the Operations Controller/System 

Administrator to have servers brought back up using HP OpenView. 
•	 Go to the procedure for Force-Starti ng a Job (previous section of this lesson) after 

the problem has been corrected. 
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7	 If the ALOG contains the ShortName, and also contains an error showing that the data 
file time stamp does not match the time stamp required by the acquire, notify the Archive 
Manager to have the data file removed from the Science Data Server and reinserted. 
•	 Go to the procedure for Force-Starti ng a Job (previous section of this lesson) after 

the problem has been corrected. 
8	 If the ALOG file does contain entries for the ShortName and indicates that two files (the 

file and its associated metadata file) are being distributed, continue with the procedure for 
Checking the Archive Server ALOG File. 

Checking t he Archive Server A LOG File 

Acquire success from the Science Data Server is only part of the acquire process. Since any file 
entered into SDSRV is stored in the archive, the Archive Server must be involved during an 
acquire. Consequently, it may be useful to inspect the Archive Server ALOG file 
(EcDsStArchiveServer.ALOG ) to check for error messages associated with the ShortName of 
the file type. 

The procedure for checking the archive server ALOG file starts with the assumption that the 
operator has logged in to the ECS system. 

Checking the Archive Server ALOG File 

1	 Log in to the Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host as 
described in Steps 1 through 5 of the procedure for Launching Production Processing 
Applications (previous section of this lesson). 

2 Type cd  /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 
3 Type view EcDsStArch iveServer.ALOG then press Return/Enter. 

• Although this procedure has been written for the view command, any UNIX editor or 
visualizing command (e.g., vi, pg, more, tail) can be used to review the log file. 

4 Review the log file to determine whether the relevant file was successfully acquired. 
5 Type :q!  then press Return/Enter to quit the view application. 
6 If the relevant file was not successfully acquired, notify the Archive Manager to have the 

data file reacquired for Data Processing. 
•	 Go to the procedure for Force-Starti ng a Job (previous section of this lesson) after 

the problem has been corrected. 
7	 If the relevant file was successfully acquired, continue with the procedure for Checking 

the Staging Disk. 

Checking t he Staging D isk 

During an acquire, fi les are copied to a staging area as an intermediate step before distributing 
them to their destination. As part of diagnosing an acquire failure it is useful to check the staging 
area to ascertain whether the files have completed part of their journey. Both the file and a 
subdirectory containing metadata information should be written to the staging area. 
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The procedure for checking the staging disk starts with the assumption that the operator has 
logged in to the ECS system. 

Checking the Staging Disk 

1	 Log in to the Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host as 
described in Steps 1 through 5 of the procedure for Launching Production Processing 
Applications (previous section of this lesson). 

2 Type cd  /usr/ecs/MODE/CUSTOM /drp/archivehost/data/staging/user# then press 
Return/Enter. 

3 Type ls -lr t  then press Return/Enter. 
4 Review the directory to determine whether the relevant file was successfully staged. 
5 If the relevant file was successfully staged, ensure (e.g., using ECS Assistant) that the 

necessary hosts and servers (listed in Table 10) are “up.” 
•	 If hosts/servers have gone down, notify the Operations Controller/System 

Administrator to have servers brought back up using HP OpenView. 
•	 Go to the procedure for Force-Starti ng a Job (previous section of this lesson) after 

the problem has been corrected. 
6	 If the relevant file was not successfully staged, continue with the procedure for Checking 

the Staging Disk ALOG File to try to determine why it was not successfully staged. 

Checking t he Staging D isk A LOG File 

If the failure occurs in copying the files to the staging area, then the Staging log files 
(EcDsStStagingDiskServer.ALOG or EcDsStStagingMonitorServer.ALOG) may reveal the 
cause. 

The procedure for checking the staging disk ALOG file starts with the assumption that the 
operator has logged in to the ECS system. 

Checking the Staging Disk ALOG File 

1	 Log in to the Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host as 
described in Steps 1 through 5 of the procedure for Launching Production Processing 
Applications (previous section of this lesson). 

2 Type cd  /usr/ecs/MODE/CUSTOM/logs  then press Return/Enter. 
3	 Type view  EcDsStStagingDiskServer .ALOG or 

EcDsStStagingMonitorServer.ALOG then press Return/Enter. 
• Although this procedure has been written for the view command, any UNIX editor or 

visualizing command (e.g., vi, pg, more, tail) can be used to review the log file. 
4 Review the log file to determine whether the relevant file was successfully staged. 
5 Type :q!  then press Return/Enter to quit the view application. 
6 If the relevant file was successfully staged, ensure (e.g., using ECS Assistant) that the 

necessary hosts and servers (listed in Table 10) are “up.” 
•	 If hosts/servers have gone down, notify the Operations Controller/System 

Administrator to have servers brought back up using HP OpenView. 
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•	 Go to the procedure for Force-Starti ng a Job (previous section of this lesson) after 
the problem has been corrected. 

7	 If the relevant file was not successfully staged, continue with the procedure for Checking 
the Space Available in the Staging Area. 

Checking t he Space A vailable in t he Staging A rea 

Failure can be caused by a lack of space in the staging area. 

The procedure for checking the space available in the staging area starts with the assumption that 
the operator has logged in to the ECS system. 

Checking the Space Available in the Staging Area 

1	 Log in to the Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host as 
described in Steps 1 through 5 of the procedure for Launching Production Processing 
Applications (previous section of this lesson). 

2	 Type cd  /usr/ecs/MODE/CUSTOM /drp/archivehost/data/staging/user# then press 
Return/Enter. 

3 Type df -k . then press Return/Enter. 
4	 Review the available space listed to determine whether there is adequate space for staging 

the relevant file. 
5	 If there is not adequate space for staging the relevant fi le, notify the Operations 

Controller/System Administrator of the lack of space. 
6	 If there is adequate space for staging the relevant fi le, notify the Archive Manager to have 

the data file reacquired for Data Processing. 
7	 Go to the procedure for Force-Starti ng a Job (previous section of this lesson) after the 

problem has been corrected. 

Handling a Staging Job Problem 
The staging step in processing involves acquiring files from the archive. The ALOG file on the 
Data Processing host can be checked to see whether the files were successfully acquired. If there 
is an acquire failure, the appropriate action is to perform the procedure for Handling an Acquir e 
Failur e (previous section of this lesson). 

The procedure for checking the Staging Job ALOG file starts with the assumption that the 
operator has logged in to the ECS system and the Queuing Server host (e.g., g0sps06). 
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Checking Staging Job ALOG File 

1 Access a terminal window logged in to the Queuing Server host (e.g., g0sps06). 
2 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

• Change directory to the directory containing the data processing log files (e.g., 
ACT#syn1#004130123TS1.ALOG). 

3 Type pg filename then press Return/Enter. 
•	 filename refers to the data processing log file to be reviewed (e.g., 

ACT#syn1#004130123TS1.ALOG). 
• The first page of the log file is displayed. 
• Although this procedure has been written for the pg command, any UNIX editor or 

visualizing command (e.g., vi, view, more, tail) can be used to review the log file. 
4 Review the log file to determine whether the input data files were successfully acquired. 
5 If the input data files were successfully acquired, go to the procedure for Force-Starti ng 

a Job (previous section of this lesson). 
6 If there is an acquire failure, perform the procedure for Handling an Acquir e Failure 

(previous section of this lesson). 

Handling an Preprocessing Job Problem 
Preprocessing rarely fails completely. However, it may not generate the system Process Control 
File (PCF) correctly. The general process for handling a preprocessing job problem is as 
follows: 

• Check the ALOG file to determine whether there is a problem with the PCF. 
•	 If the ALOG file indicates that there is a problem with the PCF, put the execution job 

on hold. 
• Check the system PCF to determine whether it matches expectations. 

The procedure for checking the Preprocessing Job ALOG file starts with the assumption that the 
operator has logged in to the ECS system and the Queuing Server host (e.g., g0sps06). 

Checking the Preprocessing Job AL OG File 

1 Access a terminal window logged in to the Queuing Server host (e.g., g0sps06). 
2 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

• Change directory to the directory containing the data processing log files (e.g., 
ACT#syn1#004130123TS1.ALOG). 

3 Type pg filename then press Return/Enter. 
•	 filename refers to the data processing log file to be reviewed (e.g., 

ACT#syn1#004130123TS1.ALOG). 
• The first page of the log file is displayed. 
•	 Although this procedure has been written for the pg command, any UNIX editor or 

visualizing command (e.g., vi, view, more, tail) can be used to review the log file. 
4	 Review the log file to determine whether there is any indication that there is a problem 

with the PCF. 
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5	 If there is no indication that there is a problem with the PCF, go to the procedure for 
Force-Starti ng a Job (previous section of this lesson). 

6	 If there is some indication that there is a problem with the PCF, continue with the 
procedure for Putting the Execution Job on Hold and Checking the Process Control 
File (subsequent sections of this lesson). 

The procedure for putting the execution job on hold starts with the assumption that the starts with 
the assumption that AutoSys has been launched and either JobScape (Figure 44) or TimeScape 
(Figure 43) is being displayed.. 

Putting the Execution Job on Hold 

1	 Click and hold on the applicable job symbol in the AutoSys JobScape or TimeScape GUI 
with the right  mouse button 
• Descendants pop-up menu appears. 

2	 Select (highlight) On Hold from the Descendants pop-up menu (release the right mouse 
button). 
•	 The job symbol in AutoSys JobScape or TimeScape GUI should turn dark blue (“on 

hold”) within a short period of time. 

The procedure for checking the system PCF starts with the assumption that the operator has 
logged in to the ECS system and the Queuing Server host (e.g., g0sps06). 

Checking the Process Control  File 

1 Access a terminal window logged in to the Queuing Server host (e.g., g0sps06). 
2	 Type cd 

/usr/ecs/mode/CUSTOM /pdps/hostname/data/DpPrRm/hostname_disk/pgeId/dprId_ 
hostname then press Return/Enter. 
• Change directory to the directory containing the PCF (e.g., pgeId.Pcf). 

3 Type pg filename then press Return/Enter. 
• filename refers to the PCF to be reviewed (e.g., pgeId.Pcf). 
• The first page of the file is displayed. 
• Although this procedure has been written for the pg command, any UNIX editor or 

visualizing command (e.g., vi, view, more, tail) can be used to review the file. 
4 Review the PCF to determine whether there are errors in the file. 
5 If there are errors in the PCF, refer the problem to SSI&T personnel. 
6 If there are no errors in the PCF, click and hold on the job symbol for the execution job in 

the AutoSys JobScape or TimeScape GUI with the right  mouse button 
• Descendants pop-up menu appears. 

7	 Select (highlight) Off Hold  from the Descendants pop-up menu (release the right mouse 
button). 
•	 The job symbol in AutoSys JobScape or TimeScape GUI should turn white 

(“activated”) within a short period of time. 
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8 Go to the procedure for Force-Starti ng a Job (previous section of this lesson). 

Handling an Post-Processing Job Problem 
Post-Processing does not often fail, but it may show as a failure in AutoSys if the Execution 
stage has failed. 

The procedure for checking the Post-Processing Job ALOG file starts with the assumption that 
the operator has logged in to the ECS system and the Queuing Server host (e.g., g0sps06). 

Checking the Post-Processing Job AL OG File 

1 Access a terminal window logged in to the Queuing Server host (e.g., g0sps06). 
2	 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

• Change directory to the directory containing the data processing log files (e.g., 
ACT#syn1#004130123TS1.ALOG). 

3 Type pg filename then press Return/Enter. 
•	 filename refers to the data processing log file to be reviewed (e.g., 

ACT#syn1#004130123TS1.ALOG). 
• The first page of the log file is displayed. 
• Although this procedure has been written for the pg command, any UNIX editor or 

visualizing command (e.g., vi, view, more, tail) can be used to review the log file. 
4 Review the log file to determine whether there is any indication that the execution job 

failed. 
5 If there is no indication that the execution job failed, go to the procedure for Force-

Starting a Job (previous section of this lesson). 
6	 If there is an indication that the execution job failed, check the response listed for 

“’Execute’ job fails” in Table 9, Troubleshooting Processing Problems. 

Handl ing an I nser tion Job Pr obl em 
If the insertion (destaging) job fails, the job symbol in AutoSys JobScape, TimeScape, or 
HostScape has turned red (failed). The following activities should help isolate the problem: 

• Check the .err log file. 
• Check the ALOG file. 
• Check for an Insert failure. 

The procedure for checking the Insertion job .err file starts with the assumption that the operator 
has logged in to the ECS system and the Queuing Server host(e.g., g0sps06). 

Checking the Insertion Job .err File 

1	 Access a terminal window logged in to the Queuing Server host (e.g., e0sps04, g0sps06, 
l0sps03, n0sps08). 

2 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 
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• Change directory to the directory containing the DPR .err files (e.g., 
ACT#syn1#004130123TS1.err). 

3 Type /usr/xpg4/bin/tail -f -n 20 filename then press Return/Enter. 
•	 filename refers to the DPR .err file to be reviewed (e.g., 

ACT#syn1#004130123TS1.err). 
• The last 20 lines of the .err file are displayed and additional data (if any) is displayed 

as it is written to the file. 
4 Review the .err file to identify problems that are occurring or have occurred. 
5 If the message Error arch iving metadata into catalog is found and the problem 

occurred for an existing ESDT which has previously worked within the past day or two, 
go to the procedures for Handling an Inser t Failure (subsequent section of this lesson). 
•	 STMGT log files may have indications of problems relating to changes/defects in the 

stored procedures. 
6	 If the message Error arch iving metadata into catalog is found and the ESDT is new or 

has recently been installed, go to the procedures for Handling an Inser t Failure 
(subsequent section of this lesson). 
•	 The values of the mandatory parameters in the .MCF file in the runtime directory may 

not be consistent with “valids” in the SDSRV database. 
• Alternatively, a SDSRV temporary directory may be getting filled up. 

7	 If the message Error modifying file usage is in the file, manually reset to 1 the 
numberOfUsage column in DpPrFile for the particular file. 
•	 The message indicates that the numberOfUsage column in DpPrFile for a particular 

file is at 0 and the software is trying to decrement it. This column is an 
increment/decrement counter and is not normally decremented more times than it is 
incremented when under software control. However, if someone manually changes 
the database, the value may no longer be synchronized. 

•	 Go to the procedure for Force-Starti ng a Job (subsequent section of this lesson) after 
the problem has been corrected. 

8	 Type cd  /usr/ecs/MODE/CUSTOM /pdps/processor/data/DpPrRm/processor_disk 
then press Return/Enter. 
•	 processor refers to the Science Processor host (e.g., e0spg01, g0spg01, l0spg01, 

n0spg03). 
• The processor_disk directory (e.g., g0spg01_disk) is the target directory where the 

data server puts the inputs needed for processing. 
9 Type ls then press Return/Enter. 
10 Review the directory contents to determine whether there are science data fi les in the disk 

partition but no metadata files. 
• If there are science data files in the disk partition but no metadata files, DDIST and 

STMGT are functioning properly but SDSRV is not. 
− Otherwise, STMGT may not be functioning properly. 

11	 Continue with the procedure for Checking the Inser tion Job ALOG File (subsequent 
section of this lesson). 
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The procedure for checking the Insertion Job ALOG file starts with the assumption that the 
operator has logged in to the ECS system and the Queuing Server host (e.g., g0sps06). 

Checking the Inser tion Job ALOG File 

1 Access a terminal window logged in to the Queuing Server host (e.g., g0sps06). 
2	 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

• Change directory to the directory containing the data processing log files (e.g., 
ACT#syn1#004130123TS1.ALOG). 

3 Type pg filename then press Return/Enter. 
•	 filename refers to the data processing log file to be reviewed (e.g., 

ACT#syn1#004130123TS1.ALOG). 
• The first page of the log file is displayed. 
• Although this procedure has been written for the pg command, any UNIX editor or 

visualizing command (e.g., vi, view, more, tail) can be used to review the log file. 
4 Review the log file to determine whether there is any indication that there is a problem 

inserting files in Data Server. 
5 If there is no indication that there is a problem inserting files in Data Server, go to the 

procedure for Force-Starti ng a Job (previous section of this lesson). 
6	 If there are indications that there are problems inserting files in Data Server, continue 

with procedures for Handling an Inser t Failure (subsequent section of this lesson). 

Handling an Insert Failure 

If the Science Data Server returns a message indicating that the insertion of output granules into 
the archive has failed, or if the insertion job fails as indicated in AutoSys, the problem can be 
diagnosed by verifying the following items: 

• Applicable ESDT is in the Science Data Server (SDSRV) database. 
• Applicable ESDT is in the advertising database. 
• SDSRV ALOG file indicates that the insertion occurred. 
• Applicable servers are running. 
• DCE Login is valid. 

Checking f or the Applicable ESD T in t he SDSRV Database 

No granules can be inserted into the archive unless there is a valid ESDT for the type of granule 
to be inserted. There must be a valid ESDT in both the SDSRV database and the advertising 
database. In the SDSRV database the ShortName for the ESDT should be listed in a table called 
DsMdCollections. If the ShortName is not listed in the table, the ESDT must be inserted in the 
Science Data Server before the granule insertion can succeed. 

The procedure for checking for the applicable ESDT in the SDSRV database starts with the 
assumption that the operator has logged in to the ECS system. 
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Checking for the Applicable ESDT in the SDSRV Database 

1	 Log in to the SDSRV Server host (e.g., e0acs05, g0acs03, l0acs03, n0acs04) as described 
in Steps 1 through 5 of the procedure for Launching Production Processing 
Applications (previous section of this lesson). 

2	 Enter isql commands for checking the SDSRV database DsMdCollections table for the 
ShortName for the ESDT. 

3	 If the ShortName for the ESDT is not listed in the SDSRV database DsMdCollections 
table, notify the Science Data Specialist to have the ESDT added. 
•	 After the ESDT has been added go to the procedure for Force-Starti ng a Job 

(previous section of this lesson). 
4	 If the ShortName for the ESDT is listed in the SDSRV database DsMdCollections table, 

continue with the procedure for Checking for the Applicable ESDT in the Advertising 
Database. 

Checking f or the Applicable ESD T in t he Advert ising D atabase 

When an ESDT is installed into the Science Data Server database, the system also makes entries 
in the advertising (IOS) database. The number and types of entries depends on the contents of 
the ESDT descriptor file. File insertion failures may also be caused by missing or incomplete 
IOS database entries for the ESDT. Therefore, it is useful to check IOS to make sure the ESDT 
corresponding to the file type to be inserted has been properly advertised. This is done by 
checking the advertising database, IoAdAdvService_mode, in a table called IoAdAdvMaster, 
for the ShortName in question. For each ESDT ShortName the table should show several 
entries, the number depending on the descriptor file contents. An example of such a listing is 
given in Table 11. 

Table 11. Sample List ing of ESDT Entries in A dvert ising D atabase 
IoAdAdvMast er 

MOD03.001 

MOD03.001:ACQUIRE 

MOD03.001:INSERT 

MOD03.001:UPDATEMETADATA 

MOD03.001:BROWSE 

MOD03.001:GETQUERYABLEPARAMETERS 

MOD03.001:INSPECT 

MOD03.001:INSPECTCL 

MOD03.001:DELETE 

Subscribable Event:ID:##: MOD03.001:DELETE 

Subscribable Event:ID:##: MOD03.001:INSERT 

Subscribable Event:ID:##: MOD03.001:UPDATEMETADATA 
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The procedure for checking for the applicable ESDT in the advertising database starts with the 
assumption that the operator has logged in to the ECS system. 

Checking for the Applicable ESDT in the Advertising Database 

1	 Log in to the Interface Server 01 (e.g., e0ins02, g0ins02, l0ins02, n0ins02) host as 
described in Steps 1 through 5 of the procedure for Launching Production Processing 
Applications (previous section of this lesson). 

2	 Enter isql commands to check the IoAdAdvService_mode database IoAdAdvMaster 
table for the ESDT’s ShortName. 

3 If the ShortName for the ESDT is not listed in the IoAdAdvService_mode database 
IoAdAdvMaster table, notify the Science Data Specialist to have the ESDT added. 
• After the ESDT has been added go to the procedure for Force-Starti ng a Job 

(previous section of this lesson). 
4	 If the ShortName for the ESDT is listed in the IoAdAdvService_mode database 

IoAdAdvMaster table, continue with the procedure for Checking the Science Data 
Server ALOG File. 

Checking t he Science D ata Server A LOG File 

During any operation involving the Science Data Server, useful information reflecting SDSRV 
activities is written to the following two log files: 

• EcDsScienceDataServer.ALOG. 
• EcDsScienceDataServerDebug.log. 

Entries to the ALOG file should include the ShortName of the file data type. Timestamps, which 
appear throughout the logs files, should be checked to make sure any entries found for a 
ShortName correspond to the time of the attempted insertion. If the ShortName does not appear, 
the file insertion request was not communicated to SDSRV. This might be the case if the 
SDSRV subsystem is not running. 

The procedure for checking the EcDsScienceDataServer.ALOG file starts with the assumption 
that the operator has logged in to the ECS system. 

Checking the Science Data Server ALOG File 

1	 Log in to the SDSRV Server host (e.g., e0acs05, g0acs03, l0acs03, n0acs04) as described 
in Steps 1 through 5 of the procedure for Launching Production Processing 
Applications (previous section of this lesson). 

2 Type cd  /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 
3 Type view EcDsScienceDataServer.ALOG then press Return/Enter. 

• Although this procedure has been written for the view command, any UNIX editor or 
visualizing command (e.g., vi, pg, more, tail) can be used to review the log file. 

4 Review the log file to determine whether the relevant file was successfully inserted. 
•	 The EcDsScienceDataServer.ALOG file should contain entries identifying the file to 

be inserted by the ShortName of its ESDT. 
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•	 If the ShortName does not appear in the ALOG file, with a timestamp corresponding 
to the time of the attempted insert, SDSRV may not be running, or may not be 
communicating with other servers. 

•	 If the ShortName does appear in the ALOG file, a message of the following type 
indicating that the metadata for the granule have been validated should be included in 
the ALOG file: 
End Metadata Validation. ( Metadata is valid). 

• If the metadata is not valid, the metadata validation section of the ALOG can be 
scanned to find what metadata errors have been identified by SDSRV. 

5 Type :q!  then press Return/Enter to quit the view application. 
6 If the ShortName does not appear in the ALOG file, with a timestamp corresponding to 

the time of the attempted acquire, ensure (e.g., using ECS Assistant) that the necessary 
hosts and servers (listed in Table 10) are “up.” 
•	 If hosts/servers have gone down, notify the Operations Controller/System 

Administrator to have servers brought back up using HP OpenView. 
• Go to the procedure for Force-Starti ng a Job (previous section of this lesson) after 

the problem has been corrected. 
7 If the ALOG contains the ShortName and the metadata are valid go to the procedure for 

Force-Starti ng a Job (previous section of this lesson). 
8 If the ALOG contains the ShortName but the metadata are not valid, consult with the 

SSI&T personnel to have the metadata problems corrected. 
9 If hosts/servers are up, review the log file to determine whether there are any messages 

indicating DCE problems. 
10 Notify the Operations Controller/System Administrator of suspected DCE problems. 

•	 Go to the procedure for Force-Starti ng a Job (previous section of this lesson) after 
the problems have been corrected. 

Checki ng Log Fi les 
Log files can provide indications of the following types of problems: 

• DCE problems. 
• Database problems. 
• Lack of disk space. 

The procedure for checking log files starts with the assumption that the operator has logged in to 
the ECS system and the Planning Subsystem host. 

Checking Log Files 

1 Access a terminal window logged in to the appropriate host. 
2 Type cd /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

• Change directory to the directory containing the data processing log files (e.g., 
EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG). 

3 Type pg filename then press Return/Enter. 
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•	 filename refers to the data processing log file to be reviewed (e.g., 
EcDpPrJobMgmt.ALOG, EcDpPrDeletion.ALOG, DPR#.ALOG, DPR#.err). 

• The first page of the log file is displayed. 
• Although this procedure has been written for the pg command, any UNIX editor or 

visualizing command (e.g., vi, more) can be used to review the log file. 
4 Review the log file to identify problems that have occurred. 
5 Respond to problems as follows: 

• DCE problems. 
−	 Notify the Operations Controller/System Administrator of suspected DCE 

problems. 
•	 Database problems. 

− Verify that relevant database servers are running. 
− Check for lack of (or corruption of) data in the database using either a 

database browser or isql commands. 
− Notify the Database Administrator of suspected database problems. 

• Lack of disk space. 
− Remove unnecessary files. 
− Notify the Operations Controller/System Administrator of recurring disk 

space problems. 
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Launching the QA Monitor


Launchi ng the QA Moni tor 
Access to the QA Monitor must be gained through the use of UNIX commands. The process 
starts with the assumption that the applicable servers are running and the Production Monitor has 
logged in to the ECS system. 

Launching the QA Monitor 

NOTE: Commands in Steps 1 through 9 are typed at a UNIX system prompt. 
1	 At the UNIX command line prompt type xhost hostname then press the Return/Enter 

key on the keyboard. 
•	 hostname refers to the host on which GUIs are to be launched during the current 

operating session. Multiple hostnames can be specified on the same line. 
• The use of xhost + is discouraged because of a potential security problem. 

2 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 
•	 Use either the X terminal/workstation IP address or the machine-name for the 

clientname. 
•	 When using secure shell, the DISPLAY variable is set just once, before logging in to 

remote hosts. If it were to be reset after logging in to a remote host, the security 
features would be compromised. 

3 Open another UNIX (terminal) window. 
4	 Start the log-in to the Planning/Management Workstation by typing /tools/bin/ssh 

hostname (e.g., e0pls03, g0pls01, l0pls02, or n0pls02) in the new window then press the 
Return/Enter key. 
•	 If you receive the message, Host key not found from the list of known hosts. Are 

you sure you want to continue connecting (yes/no)? type yes (“y”  alone will not 
work). 

•	 If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 5. 

• If you have not previously set up a secure shell passphrase; go to Step 6. 
5	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 

Passphrase then press the Return/Enter key. 
• Go to Step 7. 

6	 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

7 Type setenv ECS_HOME /usr/ecs/  then press the Return/Enter key. 
•	 When logging in as a system user (e.g,, cmshared), the ECS_HOME variable may be 

set automatically so it may not be necessary to perform this step. 
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8 Type cd /usr/ecs/MODE/CUSTOM/utilitie s then press Return/Enter. 
•	 Change directory to the directory containing the QA Monitor start script (e.g., 

EcDpPrQaMonitorGUIStart). 
•	 The MODE will most likely be one of the following operating modes: 

 OPS (for normal operation). 
 TS1 (for SSI&T). 
 TS2 (new version checkout). 

•	 Note that the separate subdirectories under /usr/ecs apply to (describe) different 
operating modes. 

9	 Type EcDpPrQaMonitorGUIStart MODE ApplicationID then press Return/Enter 
to launch the QA Monitor  GUI. 
• The QA Monitor  GUI (Figure 41) is displayed. 
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Figure 41. Q/A Monitor GUI - QRU Data Tab 
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Performing Science Product Quality Assurance


Science Product Quality Assurance 
Science product quality assurance (QA) involves the use of the Q/A Monitor application. 
Science Computing Facility (SCF) personnel have the responsibility for performing QA of their 
products. The Production Monitor’s role in QA is limited to updating the QA metadata. The 
procedure for updating QA metadata is performed in response to a request from SCF personnel 
to set the metadata flags on specified granule(s). 

The procedure for updating QA metadata starts with the assumption that all applicable servers 
are currently running and the Q/A Monitor  GUI QRU data tab (Figure 41) (QRU = Query, 
Retrieve and Update) is being displayed. 

Updating Quality Assurance (QA) Metadata 

1 In the Data Types field, click on the data type to be checked. 
• It may be necessary to scroll through the Data Types list. 
• The selected data type is highlighted. 
• Only one data type can be selected at a time. 
• Alternatively, the Find field and button can be used for specifying a data type. 

 The Find field is case-sensitive. 
2	 Click in the appropriate Data Granule Insert window field(s) and either type or use the 

up/down arrow buttons to enter the Begin date and End date in MM/DD/YYYY format. 
•	 In the Data Granule Insert window it is necessary to specify the range of dates 

(between the Begin date and the End date) to formulate a query for searching for the 
desired granule(s) to be checked. 

•	 Time is based upon day of insert into the data server. If no dates are entered, an error 
message is displayed. 

•	 The up and down arrows next to the duration fields may be used for modifying entries 
in each field. 

• The Tab key may be used to move from field to field. 
3 Click on the Query button. 

• Granules within the specified date range appear in the Data Granules field. 
4 In the Data Granules field, click on the granule for which metadata is to be updated. 

• It may be necessary to scroll through the list of granules. 
• The selected granule is highlighted. 
• Alternatively, the Find field and button may be used for specifying a data granule. 

 The Find field is case-sensitive. 
5 Click on the Update Metadata button. 

• The Granule Parameters window (Figure 61) is displayed. 
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•	 The Granule Parameters window displays one line for each parameter for the 
selected granule. 

6	 In the Granule Parameters window click on a parameter for which the metadata is to be 
updated. 
• The selected parameter is highlighted. 

7 Click on the OK button. 
• The Update Meta Data window (Figure 62) is displayed. 

8	 Click and hold on the Operational QA Flag option button, move the mouse cursor to the 
desired selection (highlighting it), then release the mouse button. 
• The selected metadata flag is displayed on the Operator QA Flag option button. 
•	 The following options are available: 

 Passed. 
 Failed. 
 Being Investigated. 
 Not Being Investigated. 

9 Type an explanation of the QA flag selection in the Explanation field. 
10	 If the SCF has specified that the SCF Quality Flag should be set to a particular value, 

click and hold on the SCF Quality Flag option button, move the mouse cursor to the 
SCF-specified selection (highlighting it), then release the mouse button. 
• The selected metadata flag is displayed on the SCF Quality Flag option button. 
• The same options are available as those on the Operational Quality Flag option 

button. 
11 Type an explanation of the QA flag selection in the Explanation field. 
NOTE: The Auto Quality Flag option button should not be accessible. 
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Figure 61. QA Monitor Granule Parameters Window•
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Figure 62. QA Monitor Update Meta Data Window 

12 When the QA flags have been set with the desired values, click on the OK button. 
• The settings are accepted and the Update Meta Data window is dismissed. 
•	 To cancel the settings and dismiss the Update Meta Data window click on the 

Cancel button. 
• The Granule Parameters window (Figure 61) is displayed. 

13	 Observe the entries in the Granule Parameters window to verify that the QA flag 
settings have actually been applied to the granule. 
•	 The QA flag values and explanations entered using the Update Meta Data window 

are displayed. 
• Repeat Steps 6 through 12 as necessary to revise the QA metadata for the granule 

parameter. 
14 Repeat Steps 6 through 13 to update the QA metadata for any additional granule 

parameters. 
15	 When the QA flags for all relevant parameters have been set with the desired values and 

verified, click on the OK button in the Granule Parameters window. 
• The Granule Parameters window is dismissed. 
•	 The directory for visualizing data retrieved from the archive is as follows: 

/usr/ecs/MODE/CUSTOM/data/DPS 
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Regenerating Granules•

Regenerating Granules in Response to Loss of Files from the Archive 
The reason for regenerating granules is to produce replacements for previously generated 
granules that have been lost or corrupted due to failure in the ECS archive. The overall process 
involves the following general operations: 

•	 Retrieval of the Production History files (PH) for lost granules to determine 
parameters for the generation of replacement granules. 

• Creating Production Requests for the generation of replacement granules. 
•	 Creating and activating a Production Plan that includes the Production Requests for 

the generation of replacement granules. 
•	 Preparing (if applicable) a “PDPS Residual Granules List,” which identifies granules 

that either cannot or should not be regenerated at the DAAC. 
	 Some granules do need not be reproduced; e.g., if there is a more recent version 

of the product available. 

The regeneration process is initiated when the Production Planner receives a list of “Granules for 
PDPS Re-Generation.” The list contains information about the granules to be regenerated and 
Universal References (URs) for the associated Production History tar files. The list is the 
product of a Science Data Server (SDSRV) procedure concerning SDSRV Retrieval of Granule 
Production History Metadata. 

The following considerations apply to the regeneration of granules in response to the loss of files 
from the archive: 

•	 When regenerating lost granules, all outputs of the PGE [not just those equivalent to 
the lost granule(s)] are to be produced and archived. 

•	 There is no guarantee that when a PGE is re-run it will use the same inputs as were 
used during the original execution of the PGE; consequently, the output may be 
different from the original granule(s). 

	 The variability of: Optional/Alternate inputs, Ad Hoc Reprocessing, Metadata 
Checks, Metadata Query and other production rules affects PGE output. 

	 It is possible that at the time of the original run of the PGE, certain 
optional/alternate inputs were not available, which became available later. 
During the re-run of the PGE use of those additional or other optional inputs 
cannot be avoided. However, it can be assumed that an equivalent or better 
product than the original will be produced as a result. 

• PDPS maintains a minimal amount of granule-level versioning. By design, only the 
latest version of the granule is used. 

 If the PGE to be re-run uses inputs that have more than one granule-level 
version, PDPS uses only the latest version of those inputs. 

	 However, if references to those granules have been deleted from the PDPS 
database (a delete script, which runs periodically, cleans up unused database 
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entries), PDPS chooses the first one returned from SDSRV. SDSRV does not 
guarantee any sort of ordering in this case but PDPS selects the latest granule 
from those returned. 

•	 At Production Request time, the default values for metadata checks can be 
overridden. The new values used are stored in the PDPS database but not in the 
Production History. If at the time a PGE is re-run the references to the PGE have 
been deleted from PDPS database, the default metadata checks are used. 

	 It is possible that default metadata check values would cause the DPR not to be 
run; e.g., if the metadata checks are more restrictive than those used in the 
original run. 

	 If changes to metadata checks were required in order to get DPRs to run 
originally, it is assumed that the values were saved as part of the PGE profile. 

•	 For reasons of production timing or updated QA values, during regeneration a PGE 
subject to a metadata query could have input which is different from that used in the 
original processing. 

 The assumption is that regeneration will result in a better product. 
•	 Other production rules (e.g., tiling) could make it impossible to reproduce identical 

granules. 
•	 If a PGE (PGE name, version and profile) has to support lost granule regeneration, the 

PGE should not be deleted from the PDPS database. 
	 In the SSIT Operational Metadata GUI, the delete flag for the PGE should not 

be checked. 

The procedure for regenerating granules in response to loss of files from the archive starts with 
the assumption that all applicable production planning servers and data server servers are 
running. 

Regenerating Granules in Response to Loss of Files from the Archive 

1	 Determine which granules in the Granules for PDPS Re-Generation list should be 
regenerated (and which granules do not need to be reproduced). 

2	 Add granules that either cannot or do not need to be reproduced to the PDPS Residual 
Granules list. 

3	 Retrieve (using the QA Monitor GUI) the Production History tar file from the archive 
for each granule in the Granules for PDPS Re-Generation list that needs to be 
reproduced. 
•	 Use the lost granule’s datatype, and begin date and end date values that encompass its 

RangeBeginningDateTime and RangeEndingDateTime. 
• QA Monitor  interprets dates in UTC format. 
•	 For each granule that meets the query conditions and is displayed on the QA Monitor 

GUI , the granule’s UR, its Production History tar file’s UR, and the name of the 
Production History tar file are shown. For only one of the granules will the URs 
(both the granule UR and the Production History UR) match the URs for this granule 
in the input list. 

•	 The Production History tar file is acquired to a directory that is configurable. 
 The name of the configuration parameter is DpPrQA_DATA_DIR. 
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	 The default value for the parameter is 
$ECS_HOME/<MODE>/CUSTOM/data/DPS. 

•	 If more than one granule in the input list maps to the same Production History tar file, 
the Production History tar file need not be retrieved multiple times. 

4	 Extract information needed to re-run the PGE from the Process Control File (PCF) in the 
PH. 
•	 Information to be extracted from the PCF: 

 PGE Name. 
 PGE Version. 
 PGE Profile ID. 
 DPR Start time. 
 DPR Stop time. 
 PGE runtime parameters and their associated values. 

• Identification of information in the PCF: 
 The PGE Name, PGE Version, and the PGE Profile appear in the System 

Runtime Parameters section of the PCF. They are concatenated (with a # sign 
to separate them) and appear in the place reserved for “Software ID”. 

 DPR Start time appears in the User Defined Parameter Section of the PCF under 
the logical ID 10258. 

 DPR Stop time also appears in the User Defined Parameter Section of the PCF 
under logical ID 10259. 

 All other logical IDs in the User Defined Parameter Section of the PCF form the 
run time parameters and their associated values. Note the logical ID and its 
corresponding values. 

5 If the Query failed or did not return any hit that matched, add the granule to the PDPS 
Residual Granules list. 

6 If the PGE name (including version and profile) that is extracted from the PCF does not 
appear as an Existing/New PGE, add the granule to the PDPS Residual Granules list. 

7 From the SSIT host, launch the SSIT Manager  GUI and invoke the PDPS Operational 
Metadata GUI. 

8 Invoke the PDPS Operational Metadata GUI. 
9 If the PGE is not registered, register the PGE using the PDPS Science Update Metadata 

Update from the SSIT Manager  GUI. 
• The PGE must be registered before a PR can be entered. 

10 If it is decided not to re-register the PGE, add the granule to the PDPS Residual 
Granules list. 

11 Launch the Production Request Editor GUI. 
12 Create a Production Request for the relevant PGE/version/profile ID. 

• Use Ad-Hoc Reprocessing for the Processing Type. 
•	 Use the DPR Start and Stop Time listed in the Production History for the Begin and 

End times. 
•	 Compare the default PGE runtime parameters with the runtime parameters obtained 

from the Production History tar file. 
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	 Modify the runtime parameter values to match exactly what was used in the 
original run. 

•	 If granules to be regenerated are produced by PGEs that are chained, the PRs must be 
entered in the proper order. 

	 For instance, if granules A and B are to regenerated, and PGEs P1 & P2 produce 
them and if P1 & P2 are chained (P2 takes P1’s outputs as its inputs), then the 
production request for P1 must be entered before entering one for P2. 

13 Launch the Planning Workbench. 
14	 Create and activate a production plan that includes the newly created Production 

Request(s). 
15	 Send the PDPS Residual Granules list to the originator of the Granules for PDPS Re-

Generation list. 
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Practical Exercise


In troduction 

This exercise is designed to give the students practice in production planning and processing 
activities. 

Equipment and Mater ials 

One ECS workstation per student. 

Statement of the requirements for the exercise. 

Version 2.0 Operations Tools Manual for the ECS Project, 609-CD-003-002, one copy per 
student. 

Mission Operation Procedures for the ECS Project, 611-CD-004-003, one copy per student. 

Launching the Production Request Editor 
The exercise involves launching the production request editor using UNIX commands. The 
exercise begins with a student acting in the role of Production Planner recognizing the need to 
launch the production request editor. The student launches the production request editor as 
specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 
2. Log-in to the Planning Subsystem host. 
3. Set the necessary environmental variables. 
4. Start the Production Request Editor GUI in the appropriate mode. 

Creating a New Pr oducti on Request 
The exercise involves the preparation of a new production request. The exercise begins with a 
student acting in the role of Production Planner receiving the necessary information/requirements 
for creating a new production request. The student prepares a new production request that is 
consistent with the requirements. 

Perform the following steps: 

1. Access the Production Request Editor. 
2. Prepare a new production request that is consistent with the written or stated requirements. 
3. Save the new production request. 
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Edi ting/Modi fyi ng a Pr oducti on Request 
The exercise requires the editing of a production request. The exercise begins with a student 
acting in the role of Production Planner receiving the necessary information/requirements for 
editing an existing production request. The student modifies the production request consistent 
with the requirements. 

Perform the following steps: 

1. Access the Production Request Editor. 
2. Select the Production Request to be modified. 
3. Make production request modifications consistent with the written or stated requirements. 
4. Save the modified production request. 

Deleting a Pr oducti on Request 
The exercise involves deleting a production request. The exercise begins with a student acting in 
the role of Production Planner receiving the necessary information/requirements for deleting an 
existing production request. The student deletes the production request as specified in the 
requirements. 

Perform the following steps: 

1. Select the DPR List tab on the Production Request Editor GUI. 
2. Select the production request to be deleted from those listed. 
3. Delete the production request. 

Reviewing Data Processing Requests 
The exercise involves reviewing data processing requests. The exercise begins with a student 
acting in the role of Production Planner being directed to review specific data processing requests 
to determine specified characteristics. The student reviews the data processing requests 
consistent with the requirements. 

Perform the following steps: 

1. Select the DPR List tab on the Production Request Editor GUI. 
2. Select a Production Request from the list on the option button. 
3. Select a DPR from the list displayed. 
4. Open the DPR. 
5. Respond to questions concerning the characteristics of the DPR without error. 

Deleting a Data Processing Request 
The exercise involves deleting a data processing request. The exercise begins with a student 
acting in the role of Production Planner being directed to delete a specific data processing 
request. The student deletes the data processing request as specified in the requirements 

Perform the following steps: 

1. Select the DPR List tab on the Production Request Editor GUI. 
2. Select the appropriate Production Request from the list on the option button. 
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3. Select the DPR to be deleted from the list displayed. 
4. Delete the DPR. 

Submi tti ng or  Withdr awing a Subscr iption 
The exercise involves submitting or withdrawing a subscription using the Subscription Editor. 
The exercise begins with a student acting in the role of Production Planner being directed to 
submit or withdraw a subscription using the Subscription Editor. The student submits or 
withdraws the subscription as specified in the requirements. 

Perform the following steps: 

1. Log in to the Planning/Management Workstation. 
2. Launch the Subscription Editor. 
3. Respond to prompts to submit or withdraw the specified subscription. 

Launching Planning Workbench-Related GUIs 
The exercise involves launching planning workbench-related GUIs using UNIX commands. The 
exercise begins with a student acting in the role of Production Planner recognizing the need to 
launch planning workbench-related GUIs. The student launches planning workbench-related 
GUIs as specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 
2. Log-in to the Planning Subsystem host. 
3. Set the necessary environmental variables. 
4. Start the Planning Workbench GUI in the appropriate mode. 
5. Start the Production Strategies GUI in the appropriate mode. 

Defining a Production Strategy 
The exercise involves the preparation of a production strategy. The exercise begins with a 
student acting in the role of Production Planner receiving the necessary information/requirements 
for creating a production strategy. The student prepares a production strategy that is consistent 
with the requirements. 

Perform the following steps: 

1. Select priorities for the values for PR Type, User Type, and PGE Type. 
2. Type weights for the preceding three DPR attributes (as needed). 
3. Type a weight in the User Selected field. 
4. Click on the Normalize button. 
5. Type delta priority for Inter-DAAC Delta (if needed). 
6. Type delta priority for Late Start Delta (if needed). 
7. Save the Production Strategy. 
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Creating a New Pr oducti on Pl an 
The exercise involves the preparation of a new production plan. The exercise begins with a 
student acting in the role of Production Planner receiving the necessary information/requirements 
for creating a new production plan. The student prepares a new production plan that is consistent 
with the requirements. 

Perform the following steps: 

1. Access the Planning Workbench. 
2. Prepare a new production plan that is consistent with the written or stated requirements. 
3. Save the new production plan. 
4. Activate the plan (if specified in the requirements). 

Reviewing a Plan Timeline 
The exercise involves reviewing a production plan timeline. The exercise begins with a student 
acting in the role of Production Planner receiving the necessary information/requirements for 
reviewing a production plan timeline. The student reviews the specified production plan timeline 
and responds to questions concerning timeline characteristics. 

Perform the following steps: 

1. Access the specified production planning timeline. 
2. Review the specified production planning timeline. 
3. Respond to questions concerning the production planning timeline without error. 

Troubl eshooti ng Pr oducti on Pl anni ng Pr obl ems 
The exercise involves troubleshooting production planning problems. The exercise begins with a 
student acting in the role of Production Planner recognizing the need to troubleshoot production 
planning problems. The student troubleshoots production planning problems as specified in the 
requirements. 

Perform the following steps: 

1. Review the trouble symptoms. 
2. Check the status of relevant hosts/servers as necessary. 
3. Check log files as necessary. 
4. Take action to correct the problem(s). 

Launchi ng Pr oducti on Pr ocessi ng Appl icati ons 
The exercise involves launching production processing applications using UNIX commands. 
The exercise begins with a student acting in the role of Production Monitor recognizing the need 
to launch production processing applications. The student launches production processing 
applications as specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 
2. Log-in to the Data Processing Subsystem host. 
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3. Set the necessary environmental variables. 
4. Source the appropriate file. 
5. Start the appropriate instance of AutoSys. 

Confi gur ing AutoSys Runti me Opti ons 
The exercise involves the configuration of AutoSys runtime options. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for configuring AutoSys runtime options. The student configures AutoSys 
consistent with the requirements. 

Perform the following steps: 

1. Launch AutoSys. 
2. Access the AutoSys functions specified in the written or stated requirements. 
3. Select the AutoSys runtime options specified in the written or stated requirements. 
4. Apply the AutoSys runtime options specified in the written or stated requirements. 

Reviewing Hardware Status and Changing Hardware Status Views 
The exercise involves reviewing hardware status (including changing hardware status views) 
using AutoSys. The exercise begins with a student acting in the role of Production Monitor 
receiving the necessary information/requirements for reviewing hardware status using AutoSys. 
The student reviews hardware status using AutoSys as specified in the requirements. 

Perform the following steps: 

1. Access HostScape. 
2. Review hardware status as specified in the written or stated requirements. 
3. Change hardware status views as specified in the written or stated requirements. 
4. Exit from HostScape. 

Reviewing DPR Dependenci es 
The exercise involves reviewing DPR dependencies. The exercise begins with a student acting 
in the role of Production Monitor receiving the necessary information/requirements for reviewing 
DPR dependencies. The student reviews DPR dependencies as specified in the requirements. 

Perform the following steps: 

1. Access JobScape. 
2. Review DPR dependencies as specified in the written or stated requirements. 
3. Exit from JobScape. 
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Reviewing the DPR Production Timeline 
The exercise involves reviewing the DPR production timeline. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for reviewing the DPR production timeline. The student reviews the DPR 
production timeline as specified in the requirements. 

Perform the following steps: 

1. Access TimeScape. 
2. Review the DPR production timeline as specified in the written or stated requirements. 
3. Exit from TimeScape. 

Reviewing Al arms and Confi gur ing Al arm Selecti on 
The exercise involves reviewing and configuring AutoSys alarms. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for reviewing and configuring AutoSys alarms. The student reviews and 
configures AutoSys alarms as specified in the requirements. 

Perform the following steps: 

1. Access the Alarm Manager through the Ops Console. 
2. Review and configure alarms as specified in the written or stated requirements. 
3. Exit from the AutoSys Alarm Manager. 

Specifying Job Selection Criteria and Reviewing Job Activities 
The exercise involves specifying job selection criteria and reviewing job activities using 
AutoSys. The exercise begins with a student acting in the role of Production Monitor receiving 
the necessary information/requirements for specifying job selection criteria and reviewing job 
activities using AutoSys. The student specifies job selection criteria and reviews job activities 
using AutoSys as specified in the requirements. 

Perform the following steps: 

1. Access the AutoSys Job Activity Console. 
2. Specify job selection criteria as specified in the written or stated requirements. 
3. Review job activities as specified in the written or stated requirements. 
4. Exit from the AutoSys Job Activity Console. 
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Modi fyi ng Job Pr iority 
The exercise involves modifying job priority using AutoSys. The exercise begins with a student 
acting in the role of Production Monitor receiving the necessary information/requirements for 
modifying job priority using AutoSys. The student modifies job priority using AutoSys as 
specified in the requirements. 

Perform the following steps: 

1. Access the AutoSys Job Definition Advanced Features GUI. 
2. Modify the job Que Priority as specified in the written or stated requirements. 
3. Exit from the AutoSys Job Definition Advanced Features GUI and the Job Definition GUI. 

Modi fyi ng Job Status 
The exercise involves modifying job status using AutoSys. The exercise begins with a student 
acting in the role of Production Monitor receiving the necessary information/requirements for 
modifying job status using AutoSys. The student modifies job status using AutoSys as specified 
in the requirements. 

Perform the following steps: 

1. Access the AutoSys Send Event GUI through the Ops Console and the Job Activity Console. 
2. Modify the job status as specified in the written or stated requirements. 
3. Exit from the AutoSys Send Event GUI. 

Reviewing Acti vi ty Logs and Job Dependency Logs 
The exercise involves reviewing activity logs and job dependency logs. The exercise begins with 
a student acting in the role of Production Monitor receiving the necessary information/ 
requirements for reviewing activity logs and job dependency logs. The student reviews an 
activity log and a job dependency log as specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 
2. Type the appropriate command for an activity log as specified in the requirements. 
3. Review the activity log. 
4. Type the appropriate command for a job dependency log as specified in the requirements. 
5. Review the job dependency log. 

Defining and Runni ng Moni tor s/Browser s 
The exercise involves defining and running monitors/browsers. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary 
information/requirements for defining and running monitors/browsers. The student defines and 
runs monitors/browsers as specified in the requirements. 

Perform the following steps: 

1. Access the Monitor/Browser GUI. 
2. Define monitors/browsers as specified in the requirements. 
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3. Save the monitors/browsers. 
4. Run the monitors/browsers. 

Reviewing the Database Maintenance Time 
The exercise involves reviewing the database maintenance time. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for reviewing the database maintenance time. The student reviews the database 
maintenance time as specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 
2. Access the AutoSys configuration file. 
3. Review the database maintenance time. 

Troubl eshooti ng Pr ocessi ng Pr obl ems 
The exercise involves troubleshooting production processing problems. The exercise begins with 
a student acting in the role of Production Monitor recognizing the need to troubleshoot 
production processing problems. The student troubleshoots production processing problems as 
specified in the requirements. 

Perform the following steps: 

1. Review the trouble symptoms. 
2. Check the status of relevant hosts/servers as necessary. 
3. Check log files as necessary. 
4. Take action to correct the problem(s). 

Launchi ng the QA Moni tor  GUI 
The exercise involves launching the QA Monitor GUI using UNIX commands. The exercise 
begins with a student acting in the role of Production Monitor recognizing the need to launch the 
QA Monitor. The student launches the QA Monitor as specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 
2. Log-in to the Data Processing Subsystem host. 
3. Set the necessary environmental variables. 
4. Start the QA Monitor GUI in the appropriate mode. 
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Updating Quality Assurance (QA) Metadata 
The exercise involves updating the QA metadata of a science product granule at the request of 
Science Computing Facility (SCF) personnel. The exercise begins with a student acting in the 
role of Production Monitor receiving the necessary information/requirements for performing a 
science product QA metadata update. The student performs science product QA metadata update 
as specified in the requirements. 

Perform the following steps: 

1. Set up and query the database using the QA Monitor GUI. 
2. Select the granule with QA metadata to be updated. 
3. 	 Set the operational and SCF quality flags to the appropriate value (as specified in the 

requirements). 
4. Verify that the flags have actually been set in the database. 

Regenerating Granules in Response to Loss of Files from the Archive 
The exercise involves regenerating granules in response to a loss of files from the archive. The 
exercise begins with a student acting in the role of Production Planner receiving the necessary 
information/requirements for regenerating granules. The student determines which granules to 
regenerate, creates the necessary Production Request(s), and creates and activates a Production 
Plan as specified in the requirements. 

Perform the following steps: 

1. Retrieve the Production History files (PH) for lost granules. 
2. Create Production Requests for the generation of replacement granules. 
3. 	 Create and activate a Production Plan that includes the Production Requests for the 

generation of replacement granules. 
4. Prepare (if applicable) a “PDPS Residual Granules List.” 
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Slide Presentation


Slide Presentation Description 
The following slide presentation represents the slides used by the instructor during the conduct of 
this lesson. 
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